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Setting the Dispenser Calibration Values

Before you use the dispenser with a BioTek reader, you must set the calibration values in Genb.

1 Power on the instrument, and establish communication.

2 InGenb, go to System > Instrument Configuration, select your instrument, and click
View/Modify.

3 Click Setup, and then select the Dispenser 1 tab.

4 On the keyboard, press CTRL+SHIFT+M to enter maintenance mode for the Dispenser 1
window.

5 Enter the syringe calibration values from the label on the rear of the dispenser box.

6 Click Send Volumes, and then click Get Volumes to verify that the entered values were
sent to the instrument.

7 Select the Dispenser 2 tab, and repeat steps 4 through 6 for Dispenser 2.

Dispenser 1 calibration
values

Dispenser 2 calibration
values

-y 3
@

X

Please contact BioTek’s Technical Assistance Center with any questions, tac@biotek.com.
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Notices

BioTek® Instruments, Inc.
Highland Park, P.O. Box 998
Winooski, Vermont 05404-0998 USA

All Rights Reserved

© 2013, BioTek® Instruments, Incorporated. No part of this publication may be reproduced,
transcribed, or transmitted in any form, or by any means electronic or mechanical, including
photocopying and recording, for any purpose other than the purchaser’s use without written
permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark, and Cytation™, Gen5™, BioStack™, Take3™, and
Take3Trio™ are trademarks of BioTek Instruments, Inc. Glowell™ is a trademark of LUX Bio-
technology, Ltd. Harta™ is a trademark of Harta Instruments.

Microsoft™, Windows®, Windows XP, Windows Vista®, Windows 7, Windows 8, and Excel®
are either registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries.

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a commitment by
BioTek Instruments, Inc. Changes made to the information in this document will be incor-
porated in new editions of the publication. No responsibility is assumed by BioTek for the use
or reliability of software or equipment that is not supplied by BioTek or its affiliated dealers.
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Contact Information

Customer Service and Sales

Internet: www.biotek.com

Phone: 888-451-5171 (toll-free in the U.S.)
802-655-4740 (outside the U.S.)

Fax: 802-655-7941

Email: customercare@biotek.com

Global Service and Support

BioTek instrument service and repair is available worldwide at one of BioTek's
International Service Centers and in the field at your location. For technical
assistance, contact the Technical Assistance Center (TAC) at BioTek World
Headquarters US. To arrange for service or repair of your instrument, contact the
office nearest you.

BioTek World Headquarters US BioTek China

Mailing Address:

PO Box 998, Highland Park Room 304, Tower D

Winooski, VT 05404-0998 Ocean International Center

United States 62 Middle 4th East Ring Road
Chaoyang District

Service Shipping Address: Beijing 100024

15 Tigan Street P.R. China

Winooski, VT 05404

Phone: (800) 242-4685
Outside US: (802) 655-4740
Fax: (802) 654-0638

Phone: +86 (10) 85865569
Fax: +86 (10) 85861829

Email: TAC@biotek.com Email: infochina@biotek.com
Website: www.biotek.com Website: www.biotekchina.com.cn

Cytation3 Operator's Manual
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BioTek Germany Service Center
& European Coordination Center

BioTek Instruments SAS
Bureau de liaison France

Kocherwaldstrasse 34 D-74177
Bad Friedrichshall
Germany

50 avenue d'Alsace
68025 Colmar Cedex
France

Phone: +49 (0) 71369680
Fax: +49 (0) 7136968111

Phone: +33 (3) 89206329
Fax: +33 (3) 89204379

Email: info@biotek.de
Website: www.biotek.de

Email: info@biotek.fr
Website: www.biotek.fr

BioTek India

BioTek Singapore

Unit 223, Linkway Estate
New Link Road, Malad West
Mumbai 400064

India

20 Science Park Road #01-08A
Teletech Park
Singapore 117674

Phone: +91 (22) 28789966
Fax: +91 (22) 28759944

Phone: +65 65922100
Fax: +65 67772611

Email: biotek@biotek.in
Website: www.biotek.in

Email: singapore@biotek.com
Website: www.biotek.com

BioTek South Korea

BioTek Switzerland

3F, Gyungnam building, 830-48
Yeoksam-dong, Gangnam-gu
Seoul, South Korea (135-936)

Zentrum Fanhofli 8
6014 Luzern
Switzerland

Phone: +82 (0) 2-562-4740
Fax: +82 (0) 2-562-4750

Phone: +41 (41) 2504060
Fax: +41 (41) 2505064

Email: korea@biotek.com
Website: www.biot-
ekinstruments.co.kr

Email: info@biotek.ch
Website: www.biotek.ch
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BioTek United Kingdom

6 Bull Street
Potton, Bedfordshire SG19 2NR
United Kingdom

Phone: +44 (1767) 262000
Fax: +44 (1767) 262330

Email: info@biotek.uk.com
Website: www.biotek.uk.com
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Document Conventions

f;! '} This icon calls attention to important safety notes.
: A Warning indicates the potential for bodily harm and tells you how to
Warning! .
avoid the problem.
. A Caution indicates potential damage to the instrument and tells you
Caution .
how to avoid the problem.
Note Bold text is primarily used for emphasis.
Topics that apply only to specific Cytation3 models are proceeded by a
italic notice in italic, for example, Applies only to Cytation3 models with injec-
tors.
@ This icon calls attention to important information.

Cytation3 Operator's Manual
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Intended Use Statement

The Cytation3 is a hybrid multi-mode microplate reader. The performance
characteristics of the data reduction software have not been established with any
laboratory diagnostic assay. The user must evaluate this instrument and PC-based
software in conjunction with their specific assay(s). This evaluation must include
the confirmation that performance characteristics for the specific assay(s) are met.

o BioTek Genb software package provides the user with instrument control
and data reduction capabilities.

e The Cytation3 can operate with standard robotic systems, such as the
BioStack 3.

o If the instrument has an "IVD" label, it may be used for clinical and non-
clinical purposes, including research and development. If there is no such
label, the instrument may be used only for research and development or
other non-clinical purposes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for
the test to be conducted. Failure to conduct Quality Control checks could results in
erroneous test data.

Warranty and Product Registration

Please take a moment to review the warranty information that shipped with your
product. Please also register your product with BioTek to ensure that you receive
important information updates about the product(s) you have purchased.

You can register online through the Customer Resource Center (CRC) at
www.biotek.com or by calling 888-451-5171 or 802-655-4740.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, con-
tact BioTek for a Return Materials Authorization (RMA) number,
@ and be sure to use the original packing materials. Other forms of com-

mercially available packaging are not recommended and can void the
warranty. If the original packing materials have been damaged or lost,
contact BioTek for replacement packing.

BioTek Instruments, Inc.
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Warnings

_ Operate the instrument on a level, stable surface away from excessive
/1 humidity.

Bright sunlight or strong incandescent light can reduce the linear per-
formance range of the instrument.

Measurement values may be affected by extraneous particles (such as
dust) in the microplate wells. A clean work area is necessary to ensure
accurate readings.

When operated in a safe environment according to the instructions in this
document, there are no known hazards associated with the instrument.
However, the operator should be aware of certain situations that could
result in serious injury; these may vary depending on the instrument
model. See Hazards and Precautions.

Hazards

The following hazards are provided to help avoid injury:

Warning! Power Rating. The instrument’s power supply or power
o | cord must be connected to a power receptacle that provides voltage
and current within the specified rating for the system. Use of an
incompatible power receptacle may produce electrical shock and fire
hazards.

Warning! Electrical Grounding. Never use a plug adapter to con-
nect primary power to the external power supply. Use of an adapter
disconnects the utility ground, creating a severe shock hazard.
Always connect the power cord directly to an appropriate receptacle
with a functional ground.

Warning! Service. Only qualified technical personnel should per-
form service procedures on internal components.

Warning! Accessories. Only accessories that meet the man-
ufacturer's specifications shall be used with the instrument.

Warning! Lubricants. Do not apply lubricants to the microplate car-
rier or carrier track. Lubricant on the carrier mechanism or com-
ponents in the carrier compartment will attract dust and other
particles, which may obstruct the carrier path and cause the instru-
ment to produce an error.

Warning! The instrument with all available modules weighs up to 80
Ibs. (36.3 kg). Use two people when lifting and carrying the instru-
ment.

Cytation3 Operator's Manual
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Warning! Liquids. Avoid spilling liquids on the instrument; fluid
seepage into internal components creates a potential for shock haz-
ard. If a spill occurs while a program is running, abort the program
and turn off the instrument. Wipe up all spills immediately. Do not
operate the instrument if internal components have been exposed to
fluid. Contact BioTek TAC for assistance.

Warning! Unspecified Use. Failure to operate the equipment
according to the guidelines and safeguards specified in this manual
could result in a hazardous condition.

Warning! Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software param-
eters and establishing reading methods. Failure to conduct quality
control checks could result in erroneous test data.

Warning! Reader Data Reduction Protocol. No limits are applied
to the raw measurement data. All information exported via computer
control must be thoroughly analyzed by the operator.

Warning! Internal Voltage. Always turn off the power switch and
unplug the power supply before cleaning the outer surface of the
instrument or removing its top case.

Warning! Potential Biohazards. Some assays or specimens may
pose a biohazard. This hazard is noted by the symbol shown here.
Adequate safety precautions should be taken as outlined in the
assay’s package insert. Always wear safety glasses and appropriate
protective equipment, such as chemical-resistant rubber gloves and
apron.

Warning! LED Lights. Serious eye injury may occur if you stare
directly at the LED during operation of the light. This hazard is noted
by the symbol shown here.

Warning! Pinch Hazard. Some areas of the dispense module can
present pinch hazards when the instrument is operating. The module
is marked with the symbol shown here. Keep hands/fingers clear of
these areas when the instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek-
authorized service personnel. Only qualified technical personnel should
perform service procedures on internal components.

BioTek Instruments, Inc.
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Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may
result in a loss of warranty and potentially impair instrument per-
formance or cause damage to the instrument.

Caution: Environmental Conditions. Do not expose the system to
temperature extremes. For proper operation, ambient temperatures
should remain within the range listed in Appendix A, Specifications.
Performance may be adversely affected if temperatures fluctuate
above or below this range. Storage temperature limits are broader.

Caution: Sodium Hypochlorite. Do not expose any part of the instru-
ment to the recommended diluted sodium hypochlorite solution
(bleach) for more than 20 minutes. Prolonged contact may damage the
instrument surfaces. Be certain to rinse and thoroughly wipe all sur-
faces.

Caution: Power Supply. Use only the power supply shipped with the
instrument. Operate this power supply within the range of line voltages
listed on it.

Caution: Disposal. This instrument contains printed circuit boards and
wiring with lead solder. Dispose of the instrument according to Direc-
tive 2002/96/EC, “on waste electrical and electronic equipment (WEEE)”
or local ordinances.

Caution: Warranty. Failure to follow preventive maintenance pro-
tocols may void the warranty. See Chapter 5, Preventive Main-
tenance.

Caution: Shipping Hardware. The shipping brackets must be
removed before operating the instrument. They must be reinstalled
before shipping the instrument. See Chapter 2, Installation.

Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the
user’s responsibility to ensure that a compatible electromagnetic envi-
ronment for this instrument is provided and maintained in order that
the device will perform as intended.

Caution: Electromagnetic Compatibility. Do not use this device in
close proximity to sources of strong electromagnetic radiation (e.g.,
unshielded intentional RF sources), because these may interfere with
the proper operation.

Cytation3 Operator's Manual
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CE Mark

|3

Refer to the Declaration of Conformity for specific details.

Based on the testing described below and information |
contained herein, this instrument bears the CE mark

Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing laboratory
and found to meet the requirements of EN 61326-1: Class A for Radiated Emissions
and Line Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011 -
(CISPR 11) Class A. In a domestic environment it may cause radio interference, in
which case you may need to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing laboratory
and found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity.
Verification of compliance was conducted to the limits and methods of the
following;:

EN 61000-4-2, Electrostatic Discharge

EN 61000-4-3, Radiated EM Fields

EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-8, Power Frequency Magnetic Field Immunity Test
EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was
found to meet the requirements of this Directive. Verification of compliance was
conducted to the limits and methods of the following;:

EN 61010-1. "Safety requirement for electrical equipment for measurement, control
and laboratory use. Part 1, General requirements."

EN 61010-2-081. “Particular requirements for automatic and semi-automatic lab-
oratory equipment for analysis and other purposes.”

EN 61010-2-010. “Particular requirements for laboratory equipment for the heating
of materials.”

EN 608250-1, "Safety of laser products. Part 1: Equipment classification and require-
ments."

BioTek Instruments, Inc.
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Directive 2002/96/EC: Waste Electrical and Electronic Equip-
ment

Disposal Notice:This instrument contains printed circuit boards and wiring with
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on
waste electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this
use)

e Product registration with competent authorities

o EN 61010-2-101. “Particular requirements for in vitro diagnostic (IVD)
medical equipment.”

o Traceability to the U.S. National Institute of Standards and Technology
(NIST).

Electromagnetic Interference and Susceptibility

USA FCC CLASS A
RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at their own expense.

In order to maintain compliance with FCC regulations, shielded cables must be
used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and television reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadians
Department of Communications.

Le present appareil numerique n'emet pas du bruits radioelectriques depassant les limites
applicables aux appareils numerique de la Class A prescrites dans le Reglement sur le
brouillage radioelectrique edicte par le ministere des Communications du Canada.

Cytation3 Operator's Manual
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User Safety

This device has been type-tested by an independent laboratory and found to meet
the requirements of the following:

o Underwriters Laboratories UL 61010-1, “Safety requirements for electrical
equipment for measurement, control and laboratory use; Part 1: General
requirements.”

o Canadian Standards Association CAN/CSA C22.2 No. 61010-1, “Safety
requirements for electrical equipment for measurement, control and
laboratory use; Part 1: General requirements.”

o EN 61010 Standards, see CE Mark starting on page xvi

BioTek Instruments, Inc.
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Some of the following symbols may appear on the instrument or accessories:

"  Alternating current
Courant alternatif
Wechselstrom
Corriente alterna

Corrente alternata

Direct current
Courant continu
Gleichstrom
Corriente continua

Corrente continua

Both direct and alter-
nating current

d

Courant continu et cour-

ant alternatif

Gleich - und Wech-
selstrom

Corriente continua y
corriente alterna

Corrente continua e cor-

rente alternata

J_ Earth ground terminal
= Borne de terre
Erde (Betriebserde)
Borne de tierra

Terra (di fun-
zionamento)

Cytation3 Operator's Manual
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Warning, risk of crushing or
pinching

Attention, risque d'écrasement
et pincement

Warnen, Gefahr des Zer-
quetschens und Klemmen

Precaucidn, riesgo del macha-
camiento y sejecion

Attenzione, rischio di schi-
acciare ed intrappolarsi

Warning, hot surface
Attention, surface chaude
Vorsicht, heiBe Oberflache
Precaucion, superficie caliente

Attenzione, superfice calda

Laser radiation: Do not stare
into beam

Rayonnement laser: Ne pas
regarder dans le faisceau

Laserstrahlung: nicht in den
strahl blicken

Radiacion de laser: No mire fija-
mente al rayo

Radiazione di laser: Non stare
nel fascio

Warning, potential biohazards

Attention, risques biologiques
potentiels

Warnung! Moegliche biol-
ogische Giftsoffe

Atencién, riesgos bioldgicos

Attenziones, rischio biologico
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D

Protective conductor
terminal

Borne de terre de pro-
tection

Schultzleiteranschluss

Borne de tierra de pro-
teccion

Terra di protezione

On (Supply)
Marche (alimentation)

Ein (Verbindung mit
dem Netz)

Conectado

Chiuso

Off (Supply)
Arrét (alimentation)

Aus (Trennung vom
Netz)

Desconectado

Aperto (sconnessione
dalla rete di ali-
mentazione)

Warning, risk of elec-
tric shock

Attention, risque de
choc électrique

Gefahrliche elektrische
schlag

Precaucion, riesgo de
sacudida eléctrica

Attenzione, rischio di
scossa elettrica

IVD

Caution (refer to accompanying
documents)

Attention (voir documents d'a-
ccompanement)

Achtung siehe Begleitpapiere

Atencién (vease los doc-
umentos incluidos)

Attenzione, consultare la doc
annessa

Consult instructions for use
Consulter la notice d'emploi
Gebrauchsanweisung beachten

Consultar las instrucciones de
uso

Consultare le istruzioni per uso

In vitro diagnostic medical
device

Dispositif médical de diagnostic
in vitro

Medizinisches In-Vitro Diag-
nostikum

Dispositivo médico de diag-
néstico in vitro

Dispositivo medico diagnostico
in vitro

Separate collection for elec-
trical and electronic equipment

Les équipements électriques et
électroniques font I'objet d'une
collecte sélective

Getrennte Sammlung von Elek-
tro- und Elektronikgeradten

Recogida selectiva de aparatos
eléctricos y electronicos

Raccolta separata delle appa-
recchiature elettriche ed elet-
troniche

BioTek Instruments, Inc.



Chapter 1

Introduction

This chapter introduces the Cytation3 Cell Imaging Multi-Mode
Reader, describes its hardware and software features, and pro-
vides contact information for technical assistance.

Product Description ... .. 2
Package Contents .. ... . .. 3
Optional Accessories

Product Support and Service ... . 6
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Product Description

The Cytation3 is a cell imaging multi-mode reader. Depending on the model,
Cytation3 detection modes include fluorescence intensity (FI), fluorescence
polarization (FP), time-resolved fluorescence (TRF), luminescence, UV-visible
absorbance, and imaging. The instrument is modular, and upgrade options are
available; contact BioTek Customer Care for more information.

The reader is computer-controlled using Genb software for all operations,
including data reduction and analysis. The Cytation3 is robot accessible and
compatible with the BioTek BioStack 3 Microplate Stacker. Gen5 supports OLE
automation to facilitate the Cytation3’s integration into an automated system.

The Cytation3 can perform reads using a filter cube or a monochromator.” The
filter-based system can perform top fluorescence and luminescence reads. Filter
fluorescence uses a xenon flash light source, along with interference filters and
dichroic mirrors for wavelength specificity and a photomultiplier tube (PMT)
detector. To run a fluorescence polarization protocol, the filter cube must contain
polarizing filters. Luminescence is measured through an empty filter position in
the filter cube; filters can be used if light filtering is necessary.

The monochromator-based system, which has both top and bottom probes, is used
for absorbance, top and bottom fluorescence intensity, and luminescence spectral
scans. The xenon lamp allows for both UV and visible light measurements. The
monochromator provides wavelength selection from 230-999 nm in 1-nm
increments. Available read methods are endpoint, area scan, spectral scanning, and
pathlength correction. For luminescence reads, the Cytation3 also has a direct-to-
PMT channel (no filtering, white light only).

The imaging system supports LED filter-based fluorescence reads and a bright field
read. The reader can use up to four LED cubes and four filter cubes and two
objectives.

The Cytation3 has 4-Zone temperature control from 4°C over ambient to 45°C.
Internal plate shaking, with both linear and orbital modes, is supported to ensure
that reagents are properly mixed prior to reading.

The Cytation3 supports the reading of 6-, 12-, 24-, 48-, 96-, and 384-well microplates
with 128 x 86 mm geometry, the Take3 and Take3 Trio Multi-Volume Plates, and
microscope slides and flasks (using the adapters available from BioTek).

Use of microplates other than those listed here can result in positioning
errors during program execution.

Models with injectors support dual-reagent dispensing to 6-, 12-, 24-, 48-, 96, and
384-well microplates. An external dispense module pumps fluid from the supply
bottles to the two injectors located inside the instrument.

BioTek Instruments, Inc.
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Models that support the gas controller can control the CO2 or 02 concentrations in
the reading chamber for CO,- or O -sensitive assays.

See Appendix A for performance and technical specifications.

* This dual light path capability is protected by U.S. patent number 8,218,141.

Package Contents

Package contents and part numbers are subject to change. Please contact BioTek

Customer Care with any questions.

Item Part #
Cytation3 Operator's Manual 1221000
Power cord set (specific to installation envi-
ronment):
Europe (Schuko) 75010
USA/International 75011
United Kingdom 75012
Australia/New Zealand 75013
RS-232 serial cable 75034
USB cable with Virtual COM Driver Software 75108/7090204
#2 Phillips screwdriver 01188
9/64" Hex wrench 01623
Shipping bracket storage bracket 1222208
Models with the imaging module:
FireWire desktop interface 01604
OR
FireWire laptop card and power supply 1220535
Power supply only: 01062
FireWire cable 1220538
Microplate slide holder 1220526
Flask adapter 1222210

Cytation3 Operator's Manual
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Item

Part #

Isolation table

1220521

Models with an external dispense module (packed separately), with the following

accessories:

Injector 8040541
(Ijr;:szzubes (2) from supply bottles to syringe 2082121
250-pL syringes (2) 7083000
Syringe thumbscrews 19511
Priming plate 8042202
Injector tip priming trough 8042068
Dispense module communication cable 75107
Dispense module front cover 8042197
Dispense module box 8040534
Supply bottles (2, 30 mL) 7122609
Supply bottle holders (2) 8042193
;r;j;ctor tip cleaning stylus and plastic storage 2872304
Strap reagent racks (6) 7212035

Models with the gas controller ("G" models)(packed separately):

Gas controller unit, C02/02 control 1210500
Shipping accessories, C02/02 control 1210010
Gas Controller Unit, CO2 only 1210504
Shipping accessories, CO2 only 1210009

Optional Accessories

Accessory availability and part numbers are subject to change. Please
contact BioTek Customer Care if you have any questions or visit
www.biotek.com and use the Accessories search tool.
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Item Part #
7-filter Absorbance Test_ Plate for absorb- 2260522
ance measurement testing
Cytation3 Product Qualification (IQ-0Q- 1220514
PQ) package
Carrier Level and Contrast jig 1222520
Take3 Micro-Volume Plate TAKE3
Take3 Trio Micro-Volume Plate TAKE3TRIO
6002072
PCR Tube Adapter Plates 6002076
BioCell Quartz Vessel 7272051
BioCell Adapter Plate 7270512
Harta Luminometer Reference Micro- 8030015
plate
Harta Plate Adapter for the Cytation3 1222205
Gas-ready upgrade kit Call BioTek Sales
Laptop computer COMPLAPCYT3
Filters, filter cubes, LED cubes, and imaging filter cubes are available at www.bi-
otek.com/products/accessories/; contact BioTek for part numbers and availability.
The Cytation3 is compatible with the BioStack 3 Microplate Stacker. The BioStack 3
rapidly and systematically transfers a “stack” of microplates to and from the instru-
ment’s microplate carrier. Contact BioTek or visit our website to learn more.
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Solutions for Liquid Tests Part #
Absorbance Liquid Test Solutions:

BioTek Wetting Agent Solution (PN 7773002) 7773002
BioTek QC Check Solution No. 1 (25 mL) or 7120779
BioTek QC Check Solution No. 1 (125 mL) 7120782

B-NADH Powder (B-Nicotinamide Adenine Dinu-
cleotide, Reduced Form)

Sigma #N6785-10VL (or BioTek
PN 98233)

Phosphate-Buffered Saline (PBS) Tables (pH
7.2-7.6)

Sigma #P4417

Dispense Module Liquid Test Solution: BioTek
Green Test Dye

7773003

Fluorescence Liquid Test Solutions, if using Sodium Fluorescein:

Fluorescence Liquid Test Kit

7160010 (contains 7160011,
7160012, and 7160013)

Sodium Fluorescein Powder 98155

Sodium Fluorescein Kit 7160013
Fluorescence Polarization Kit 7160014
TRF Europium Kit 7160011

Fluorescence Liquid Test Solutions, if using Methylumbelliferone:

10-mg vial of Methylumbelliferone (MUB) 98156
Carbonate-Bicarbonate Buffer ("CBB") capsules Sigma #3041
Refill for MUB Kit 7160012

Product Support and Service

Technical Assistance Center (TAC)

If your instrument or software fail to function properly, if you have questions
about how to use or maintain our products, or if you need to send an instrument
to BioTek for service or repair, please contact our Technical Assistance Center

(”TAC”) .

TAC is open from 8:30 AM to 5:30 PM (EST), Monday through Friday, excluding

standard U.S. holidays.

BioTek Instruments, Inc.
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= Phone: (800) 242-4685 or (802) 655-4740
» Fax: (802) 654-0638
s E-Mail: tac@biotek.com

= Web: www.biotek.com
Please be prepared to provide the following information:

e Your name and company information, along with a daytime phone or fax
number, and/or an e-mail address

e The product name, model, and serial number (the serial number is located
inside the filter cube access door)

e The onboard software part number and basecode version (available via
Genb for the Cytation3 by selecting System > Instrument
Configuration > Get Basecode Information)

e For troubleshooting assistance or instruments needing repair, the specific
steps that produce your problem and any error codes displayed in Gen5
(see also Appendix B, Error Codes)

o A text file of the diagnostic history of the instrument (available via Gen5 by
selecting System > Diagnostics > History, then selecting the
appropriate file and clicking Export)

If you need to return an instrument to BioTek for service or repair, please contact
the TAC for a Return Materials Authorization (RMA) number and the shipping
address. Repackage the instrument according to the instructions at the end of
Chapter 2, Installation.

Applications Support

BioTek’s fully equipped Application Laboratory provides our on-staff scientists
with the means to assist you with the integration of our instrumentation and
software with your unique scientific applications. If you are having difficulty with
optimizing fluorescence sensitivity or integrating a unique data reduction
transformation, or you are just looking for a recommendation on an appropriate
fluorophore, contact us.

Phone: (888) 451-5171 E-Mail: applications@biotek.com

Cytation3 Operator's Manual
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Installation

This chapter includes instructions for unpacking and setting up
the Cytation3 and, if applicable, the external dispenser.
Instructions are also included for preparing the reader and dis-
penser for shipment.
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Operational/Performance Qualification ... ... ... .............. 33

Repackaging and Shipping Instructions ... ... 34

Product Registration

Please register your product(s) with BioTek to ensure that you receive important
information and updates about the product(s) you have purchased.

Register online through BioTek’s Customer Resource Center (CRC) at

www.biotek.com or by contacting BioTek Customer Care at (888) 451-5171 or (802)
655-4740.

Important Pre-Installation Information

This chapter contains installation and setup tasks for a Cytation3 reader that
has all of the available modules (the "CYT3MFV" model). Your Cytation3 may
be different. Perform the installation and setup tasks in the order presented,
skipping those that do not apply to your reader's configuration.

Materials: You will need a Phillips screwdriver to perform some of the steps
in this section. You will also need a small wrench; this item is supplied with
the instrument.

Remove the shipping hardware before turning on the instrument.

Reinstall the shipping hardware before repackaging the instrument for ship-
ping.

The instrument with all available modules weighs up to 80 Ibs. (36.3 kg).
Use two people when lifting and carrying the instrument.

BioTek Instruments, Inc.
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1: Unpack and Inspect the Reader

The Cytation3 should be removed from the box by two people. The instrument
with all available modules weighs up to 80 pounds (36.6 kg).

Save all packaging materials. If you need to ship the reader to BioTek for
repair or replacement, you must use the original materials. Using other forms
of commercially available packaging, or failing to follow the repackaging

@ instructions, may void your warranty.

During the unpacking process, inspect the packaging, reader, and accessories
for shipping damage. If the reader is damaged, notify the carrier and your
BioTek representative. Keep the shipping boxes and the packaging materials
for the carrier's inspection. BioTek will arrange for repair or replacement
immediately.

1. Open the shipping box, remove the instrument from the box, and place it
on a level, stable surface.

2. Place the packaging materials back into the shipping box for reuse if the
instrument needs to be shipped again.

3. For the instruments with the imaging module: Open the accessories box, and
remove the isolation table.

2: Unpack and Inspect the Dispenser

@ Save all packaging materials. If you need to ship the dispenser to

BioTek for repair or replacement, you must use the original materials.
Using other forms of commercially available packaging, or failing to fol-
low the repackaging instructions, may void your warranty.

During the unpacking process, inspect the packaging, the dispenser, and
accessories for shipping damage. If the dispenser is damaged, notify
the carrier and your BioTek representative. Keep the shipping boxes and
the packaging materials for the carrier's inspection. BioTek will arrange
for repair or replacement of your dispense module immediately.

If applicable, perform these steps to unpack the dispenser. Refer to Repackaging
and Shipping Instructions on page 34.

1. Open the shipping box. Remove the accessories box and foam insert that
contains the injector tubing and bottle holders.

2. Lift out the dispenser and place it on a level surface.
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3. Open the accessories box and remove its contents. The accessories should
include the dispenser-related items listed under Package Contents and
Accessories in Chapter 1.

4. Place all packaging materials into the shipping box for reuse if the
dispenser needs to be shipped.

3: Unpack and Inspect the Gas Controller

@ Save all packaging materials. If you need to ship the gas controller to

BioTek for repair or replacement, you must use the original materials.
Using other forms of commercially available packaging, or failing to fol-
low the repackaging instructions, may void your warranty.

During the unpacking process, inspect the packaging, the gas controller,
and accessories for shipping damage. If the gas controller is damaged,
notify the carrier and your BioTek representative. Keep the shipping
boxes and the packaging materials for the carrier's inspection. BioTek
will arrange for repair or replacement of your gas controller imme-
diately.

If applicable, perform these steps to unpack the gas controller.

1. Open the shipping box.

2. Lift out the accessories (power supply, tubing, and manual), and set them
aside.

3. Lift out the gas controller, and place it on a level surface.

4. Place all packaging materials into the shipping box for reuse if the gas
controller needs to be shipped.

4: Select an Appropriate Location

Install the reader on a level, stable surface in an area where ambient temperatures
between 18°C (64°F) and 30°C (86°F) can be maintained.

Performance measurements, including detection limits, were verified
up to 250C.

Leave at least six inches of space between the instrument’s rear panel and any
other object. This space ensures proper air flow in and out of the instrument.

The reader is sensitive to extreme environmental conditions. Avoid the following:
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o Excessive humidity. Condensation directly on the sensitive electronic
circuits can cause the instrument to fail internal self-checks. The humidity
must be in the range of 10-85%, non-condensing.

o Excessive ambient light. Bright light may affect the reader’s optics and
readings, reducing its linear range.

e Dust. Readings may be affected by extraneous particles (such as dust) in
the microplate wells. A clean work area is necessary to ensure accurate
readings.

e Vibration. The instrument should be installed in a vibration-free
environment. Be sure to position the instrument away from other devices
that could potentially create vibration during the read process.

Installing Instruments with the Imaging Module

Instruments using the BioStack3 cannot be operated with the isolation table.
Store the isolation table in a clean, dry location.

@ If you are installing the BioStack3 for operation with the Cytation3, you may
wish to seat the instruments in their alignment plates now. Refer to the
BioStack3 Operator's Manual for more information.

Cytation3 models with the imaging module can be used with an isolation table,
which helps to eliminate vibration during image reads.

1. Remove the four corner clips from the isolation table.

Isolation —.
Table AN
N,

(4x) Co mer__"
Clips

2. Place the isolation table in the selected installation location.

3. Place the instrument on the table as shown below.

Cytation3 Operator's Manual
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The isolation table contains material that dampens vibration. Over time, this
material becomes compressed and can lose effectiveness. The isolation table has a
color indicator that turns from green to red to show when the table should be
replaced because the dampening material has been compressed.

‘_—.‘# - ' - v R
m— or turns red when

5: Remove the Shipping Hardware

@ Remove all shipping hardware before you turn on the reader.

1. Locate the shipping hardware, shown in the next figure.

BioTek Instruments, Inc.
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The figures below depict a Cytation3 with all modules installed.

'\ —Top Filter
! ship bracket

=- A _——7Carrier ship bracket
-

and hardware

——Bottom Filter
Slide ship bracket

~—— Objective ship
/jf bracket

Side Door—"
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N

Using a #2 screwdriver, remove the carrier shipping bracket.

@

If equipped with the filter module, use the #2 Phillips screwdriver to
remove the filter shipping bracket.

b

If equipped with the imaging module, use a 9/64" hex wrench to remove
the bottom filter slide shipping bracket and objective turret shipping
bracket.

5. Assemble all shipping hardware as shown in the next figure:

6. Install the assembled shipping brackets inside the instrument for safe
keeping.
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Shipping Bracket

6: Install the Power Supply

0

Power Rating. The instrument must be connected to a power receptacle
that provides voltage and current within the specified rating for the sys-
tem. Use of an incompatible power receptacle may produce electrical
shock and fire hazards.

Electrical Grounding. Never use a plug adapter to connect primary
power to the instrument. Use of an adapter disconnects the utility ground,
creating a severe shock hazard. Always connect the system power cord
directly to an appropriate receptacle with a functional ground.

. Locate the power inlet on the back of the reader.

. Examine the power supply's plug. It has a small groove that lines up with a

tab inside the power inlet.

. Insert the plug into the power inlet and plug the power supply's cord into

an appropriate power receptacle.

Do not plug the power supply into a power receptacle until after the
power supply is connected to the instrument.
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7: Install the Gas Controller (if applicable)

The gas controller is an external module that enables the user to control CO_ and
O, concentrations inside the attached instrument’s reading chamber. If you
purchased the module for operation with the Cytation3, refer to the Gas Controller
User Guide for installation instructions.

8: Install the Dispenser

If you are installing the dispense module in additional to the gas con-
troller module, place the dispenser on top of the gas controller unit. If
you are not installing the gas controller module, place the dispenser on
top of the reader.

Do not place the dispenser next to the reader.

1. Open the plastic bag containing the injector tube and tips. Remove the
clear plastic shrouds from the tubes.

2. Remove the two inlet tubes from their plastic canisters.

3. Identify the two syringe valves on the dispense module. Each is labeled
with a left-pointing arrow.

When installing the inlet and outlet tubes, do not use any tools. Finger-
tighten only!

4. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve.
5. Screw one end of one outlet tube into the left side of the Syringe 1 valve.

6. Repeat these steps to attach the inlet and outlet tubing for Syringe 2.

It is critical that the tubing is installed in the correct ports. Otherwise,
injected fluid may miss the intended well.

8. Remove the tubing feed-through cover from the top of the reader (2
screws). Store the cover and screws with the shipping hardware in case the
reader needs to be shipped again.

9. Thread the injector tip holder, with outlet tubing connected to both ports,
through the hole in the top of the reader.
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10. Open the door on the front of the reader, and, holding the injector tip
holder by the tab, insert the injector tips into the appropriate holes inside
the reader.

injector tip holder
%

§ ‘4
Ve l L\
N

The injector tip holder in its socket

A magnet located between the injector tips helps to guide the tips into
place and secures them in the reader.

11. Place the light shield over the hole in the top of the reader and finger-
tighten the thumbscrews to secure it.

Syringe : Inlet tubes

S T 1) |

Outlettubes

Injectortip

Light shield
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12. Remove the two syringes from their protective boxes. They are identical
and interchangeable. Each syringe should already be assembled in one
piece, but if for some reason there are two separate pieces, assemble them
now: Insert the white tip of the syringe plunger into the barrel of the
syringe and gently push it all the way into the barrel.

13. Install both syringes.

» Hold the syringe vertically with the threaded end at the top.

o Screw the top of the syringe into the bottom of the syringe valve.
Finger-tighten only.

o Carefully pull down the bottom of the syringe until it rests inside the
hole in the bracket.

e Pass a thumbscrew up through this hole and thread it into the
bottom of the syringe. Hold the syringe to prevent it from rotating
while tightening the thumbscrew. Finger-tighten only.

~| Syringe brackets

14. Locate the dispenser cable. Plug one end into the port on the left side of
the dispenser. Plug the other end into the “Dispenser Port” on the rear of
the reader.

15. Locate the injector tip-cleaning stylus, packaged in a small cylinder. Attach
the cylinder to the back of the dispenser for storage.
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Perform a visual inspection or a Performance Qualification test after
reconnecting the tubes.

9: Connect the Host Computer

The Cytation3 is equipped with up to three communication ports: Serial (RS-232)
USB, and, for models with imaging capability, FireWire. All three ports are located
on the back of the reader.

e The communication cables are included in the accessories box. Determine
which cable is supported by the host computer.

e For RS-232 and USB connections: Connect one end to the appropriate port
on the reader and the other end to the appropriate port on the host
computer.

o For FireWire connection: See Install the Imager Module on page 21.

10: Install Gen5

The Cytation3 is controlled by Gen5 software running on a host computer.
There is a certain sequence of events that must be followed to ensure
@ that the software is properly installed and configured. Please follow the
instructions provided in Gen5 Getting Started Guide to install the soft-
ware.

11: Install the Imager Module

1. PC/Camera Setup

Install the PCI Express Card/IEEE-1394b in a Desktop Computer

To avoid electrostatic discharge and damage to internal components,
ground yourself by using wrist grounding straps or by touching a metal
surface on the computer's chassis.

The following directions provide general steps for installing a PCI
Express card. Talk to your company's IT representative for assistance
with these steps. For more detailed help, contact BioTek TAC.
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1. Turn off your computer, then remove the outside case.

2. Locate the PCI Express slot. Open the card retainer, and remove any
existing graphics card (if necessary) or blank port located in the
PCI Express slot.

3. Insert the PCI Express card, ensuring that it is aligned with the slot.

4. Press the card firmly into place, and rotate the card retainer back into
place.

5. Replace your computer's outside case, then power on the computer.

Install the PCI Express Card/IEEE-1394b in a Laptop Computer

1. Remove the PCI Express port cover or any existing PCI Express card from
your laptop.

2. Touch a metal object to discharge any static electricity.
3. Remove the PCI Express card from the packaging.
4. Attach the spacer to the FireWire PCI Express card.

The spacer does not fit tightly. Ensure that it does not fall off.
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5. Insert the FireWire Express card, with the label facing up, into the
appropriate slot on your laptop.

6. If necessary, plug the power cord into the card, then plug the cord into a
power outlet.
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Install the FireWire Driver

You must install the PCI Express card before performing this step.

The FireWire driver is included with the Gen5 installation files.

1. Navigate to the Gen5 program files on your computer, for example,
C:\Program Files\ BioTek\ Gen5 2.04.

2. Open the Firewire Drivers folder, and then open the folder appropriate for
your computer: Windows_32 (for Windows 32-bit) or Windows_64 (for
Windows 64-bit).

3. Double-click InstallPGRDriver.bat to run the driver installer. When the
installer is finished, a message, "SUCCESS: Installed package <path to
package>". If you do not see this message, contact BioTek TAC.

4. Insert one end of the FireWire cable in the back of the reader, and insert
the other end in the outlet on your computer (located in the card you
installed).

Establish Communication with the Camera

1. From the Genb main screen, select System > Instrument
Configuration, select Cytation3, and then click View/Modify.

2. Click Camera Info. If communication is successful, Gen5 displays
information about the camera.

For instructions on how to install the LED cubes and filter cubes and the
objectives, see Install the LED Cubes and Filter Cubes on page 25
and Install the Imaging Objectives on page 27.

Troubleshooting
e Have you established communication to the instrument first?
e Did you install the FireWire driver?
e Is the FireWire cable installed?

e Isthere an LED light lit on the camera?

¢ Red: Power to the camera from the FireWire card

o Half Red/Half Green: Ready state
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o Green: Communicating/activity

Successful communication between Genb and the FireWire cable

2. Hardware Setup

Setting the Objective, LED Cube, and Imaging Filter Cube Configuration

When you install an LED cube, an imaging filter cube, or an objective, you must set
the cubes' and objectives' configuration before physically changing or installing
them.

If you physically install an LED cube, an imaging filter cube, or an objec-
tive before setting the new configuration, the instrument will fail its
self-test.

1. From the main Genb screen, click System > Instrument
Configuration.

2. Select the Cytation3, click View/Modify > Setup, and select the
Imaging Configuration tab.

3. In the Objective Configuration area, select the objective for the position or
positions you want to define, or select None if you are removing an
objective from the instrument. Click Move to Access Position.

4. In the LED Filter Cube Configuration area, select the filter cube for the
position you want to define, or select None if you are removing the filter
cube from the instrument. The corresponding LED cube part number is
filled in automatically.
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5. Click Send Values.

6. Power down the instrument.

Install the LED Cubes and Imaging Filter Cubes

Do not open the side access door during operation. Doing so may affect
measurements.

1. With the instrument powered down, turn the knob on the side access door
to release the latch, and open the door.

2. Slide the filter slide out of the instrument.

If you are changing the LED cubes and imaging filter cubes, see Remov-
ing the LED Cubes and Imaging Filter Cubes, below, for instruc-
tions, then continue with this procedure.

3. Place the new LED cube in the appropriate position (Position 1, 2, 3, or 4)
on the filter slide.

4. Insert the screws into the LED cube, and screw them into the filter slide.

5. Place the imaging filter cube on top of the LED cube you installed in the
previous step.

6. Using a hex wrench, attach the filter cube to the LED cube.
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7. Insert the LED cube's wire clip into the socket on the carrier.
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LED cubes and imaging filter cubes installed in positions 1, 2, and 3
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5‘/1"

wire clip | * §

Rear view of LED cubes and filter cubes

8. Slide the filter slide back into the instrument.

Install the Imaging Objectives

Do not open the side access door during operation. Doing so may affect
measurements.

1. Turn the knob on the side access door to release the latch, and open the
door.
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position 2

objective turret

position 1

2. To change an installed objective, grasp the objective you want to change,
unscrew it from the objective turret, and remove it from the instrument.

Some objectives use an adapter to fit the Cytation3 objective turret.
Make sure to remove both the objective and its adapter.

3. Position the objective you want to install in the objective holder, and screw
it in to secure it.

4. Close the side door

Run Auto Calibration

After you have physically installed the LED cubes, imaging filter cubes, and
objectives, you must run Auto Calibration before you can use the imaging module.

1. Turn on your instrument.

2. After the self-test is complete, in Gen5, go to System > Instrument
Configuration, select Cytation3, then click View/Modify > Setup.

3. On the Instrument Configuration tab, click Auto Calibration.

After the calibration procedure is finished, the instrument is ready to use.
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12: Turn on the Reader

1. If Genb is open, close it now.

2. The reader’s power switch is located on the lower-right corner of the front
panel. Turn on the reader. The reader performs a system test. When the
test is completed, the reader extends the microplate carrier.

The carrier eject button, located above to the reader’s power switch,
can be used to extend/retract the microplate carrier.

13: Establish Communications

If using the USB cable, refer to the instructions that shipped with the
USB Driver Software CD to install the necessary drivers. The driver
must be installed on the computer before you connect the instrument.

1. Start Genb and log in if prompted. The default System Administrator
password is admin.

2. From the Genb main screen, select System > Instrument
Configuration and click Add.

3. Set the Reader Type to Cytation3.
4. Perform one of the following steps:

e Set the Com Port to the computer’s COM port to which the reader is
connected.

If using the USB cable, the information can be found via the Win-
dows Control Panel, under Ports in the Hardware/Device Manager
area of System Properties (e.g., Serial Port (COM5)).

e Select Plug & Play.

A Cytation3 must be connected via USB to the computer and
turned on to appear in the Available Plug & Play Readers list.

5. To test that Genb can communicate with the instrument, click Test Comm
and Camera Info. If the communication attempt is successful, Gen5
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displays a success message or information about the camera. Return to
Genb’s main screen.

Communication Errors

If the communication attempt is not successful, try the following:
e Is the reader connected to the power supply and turned on?

e Is the communication cable firmly attached to both the reader and the
computer?

e Did you select the correct Reader Type in Gen5?

USB Cable:

e Try a different COM Port.

e Did you install the USB driver software?

If you remain unable to get Gen5 and the reader to communicate with
each other, contact BioTek’s Technical Assistance Center.

14: Run a System Test

Running a system test will confirm that the reader is set up and running properly,
or will provide an error code if a problem is detected.

1. Turn on the incubator:

e From the Genb main screen, select System > Instrument Control
> Cytation3.

e Click the Pre-Heating tab.
o Enter a Requested temperature of at least 37°C and click On.

e Return to Genb5’s main view.

Wait until the incubator temperature reaches the set point before
continuing.

2. Select System > Diagnostics > Run System Test. If prompted to
select a reader, select Cytation3 and click OK.

3. When the test is completed, a dialog requesting additional information
appears. Enter the information and click OK.
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If a message appears that a pending system test is waiting from the ini-
tial power-up self-test, view the pending system test and repeat steps

2 and 3.

4. The results report appears. Scroll down toward the bottom; the text should
read “SYSTEM TEST PASS.”

e You may wish to print the report and store it with your records.

o The Genb software stores system test information in its database; you
can retrieve it at any time.

If an error code is returned, refer to Appendix B and look up the
code. If the problem is something you can fix, do so now and run
another system test. If the problem is something you cannot fix,
or if the test continues to fail, contact BioTek’s Technical Assis-
tance Center at (800) 242-4685 or (802) 655-4740.

5. Turn off the incubator:

¢ Select System > Instrument Control > Cytation3.
e Click the Pre-Heating tab and click Off.

¢ Return to Gen5’s main view.

15: Test the Injector System

1. If necessary, press the carrier eject button to extend the microplate carrier.
2. Place the tip priming trough in the rear pocket of the carrier.

3. Place the priming plate on the carrier.

Cytation3 Operator's Manual



32 | Chapter 2: Installation

4

‘-\__——'—'
tip priming trough

= priming plate

4. Fill the two reagent bottles with distilled or deionized water. Place the
bottles in their holders, and place the holders directly in front of the
syringes. Insert the inlet tubes into the bottles.

5. From the Genb main screen, select System > Instrument Control >
Cytation3.

6. Click the Dispenser tab.
7. With Dispenser set to 1, set the Volume to 5000 pL and click Prime.

The syringe should move down and up repeatedly, drawing fluid from the
bottle. The fluid should pump through the tubing and dispense into the
priming plate. Examine the fittings; no leaks should be detected. If leaks are
detected, tighten all fittings and repeat the prime. If leaks are still detected,
contact BioTek’s Technical Assistance Center.

8. When the prime finishes, set Volume to 2000 pL and click Purge to clear
the fluid lines.

9. Set Dispenser to 2 and repeat steps 7 and 8.
10. When finished, remove and empty the priming plate.
11. Close the software.

The installation and setup process is complete.
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Operational/Performance Qualification

Your Cytation3 was fully tested at BioTek prior to shipment and should operate
properly following the successful completion of the installation and setup
procedures described in this chapter.

If you suspect that problems occurred during shipment, if you received the reader
back from BioTek following service or repair, or if regulatory requirements dictate
that Operational/Performance Qualification is necessary, turn to Chapter 7,
Instrument Qualification now to learn about BioTek’s recommended OQ/PQ
procedures for Cytation3.

A Product Qualification & Maintenance (IQ/0Q/PQ) package for the
Cytation3 is available for purchase (PN 1220514). Contact your local
BioTek dealer for more information.

Cytation3 Operator's Manual



34 | Chapter 2: Installation

Repackaging and Shipping Instructions

Important! Please read all of the information provided below
before preparing the Cytation3 for shipment.

If the reader and/or dispenser has been exposed to potentially hazardous

material, decontaminate it to minimize the risk to all who come in contact

with the reader during shipping, handling, and servicing. Decontamination

prior to shipping is required by the U.S Department of Transportation reg-

& ulations. See the As-Needed Maintenance chapter for decontamination
instructions.

Remove the microplate and tip prime trough (if equipped) from the carrier
before shipment. Spilled fluids can contaminate the optics and damage the
instrument.

The instrument with all available modules weighs up to 80 Ibs. (36.3 kg).
Use two people when lifting and carrying the instrument.

The instrument's packaging design is subject to change. If the instructions
in this section do not appear to apply to the packaging materials you are
using, please contact BioTek's Technical Assistance Center for guidance.

ol

Replace the shipping hardware before repackaging the reader. Please con-
tact BioTek if you have misplaced any of these items.

o Carrier shipping bracket (PN 1220510)

e Top filter shipping bracket (PN 8042187)

o Bottom Filter Slide shipping bracket (PN 1220516)
e Objective shipping bracket (PN 1220515)

e Shipping bracket storage bracket (PN 1222208)

If you need to ship the Cytation3 and/or the dispense module to BioTek for
service or repair, be sure to use the original packaging materials. Other
forms of commercially available packaging are not recommended and can
void the warranty.

The shipping materials are designed to be used no more than five times. If
the original materials have been damaged, lost, or used more than five
times, contact BioTek to order replacements.

1. Contact BioTek’s Technical Assistance Center for an RMA (Return
Materials Authorization) number and the shipping address before
returning equipment for service.
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2. Decontaminate the reader and, if attached, the dispense module, according
to the instructions provided in the As-Needed Maintenance chapter.

3. If you will also be shipping the dispense module, see Preparing the
Dispenser for Shipment on page 38.

If you are not shipping the dispenser, disconnect it from the reader
now.

4. If applicable, disconnect the gas controller, and lift it off the top of the
instrument.

5. If you have not already done so, retract the microplate carrier and then
turn off and unplug the reader.

6. Remove the shipping bracket storage bracket from the instrument, and
remove each shipping bracket from the storage bracket.

Shipping Bracket
Storage Bracket

Removing the shipping bracket storage bracket

7. Install the carrier shipping bracket and, if applicable, the filter reader
shipping bracket, the bottom filter slide shipping bracket, and the objective
shipping bracket. See "Remove the Shipping Hardware" on page 14 for
descriptions of this hardware.
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8. Place the accessories in the accessories box, then seal the accessories box
with tape.

place objective
holders in the case

objective wrench

—USE
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Ay Supply
v ——Screwdriver
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/ A Interface
Case With 7 (OR)
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Card | Supply set
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Power—/ / ——LED Filter
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—Filter Block(s)
—LED Light
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Isolation Table

Foam

9. Place the instrument in the large plastic bag, then place it in the interior
box, surrounded by foam boards. Then, place the interior shipping box,
surrounded by the foam corners, into the external shipping box. Refer to
the next figure.
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tape door shut

step 1
place tape
around

bottorn of boxes

blocks should fit
snuq to the instrurment

Preparing the Dispenser for Shipment

1. If you have not already done so, contact BioTek’s Technical Assistance
Center for an RMA (Return Materials Authorization) number and the
shipping address before returning equipment for service.

2. Decontaminate the dispenser according to the instructions in the As-
Needed Maintenance chapter. Be sure to purge the dispenser of all fluid

when finished.

3. With the reader on, start Gen5 and select System > Instrument Control

> Cytation3.
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4. Perform this step twice, for both dispensers: Click the Dispenser tab and
set the dispenser number (1 or 2). Click Maintenance. The syringe bracket
lowers. Remove the thumbscrew from underneath the bracket. Carefully
unscrew the top of the syringe from the syringe valve. Lift out the syringe
and store it in its original box.

5. Fully detach the dispenser from the reader. (The screws are stored in the
plastic bag attached to the back of the dispenser.) Set the dispenser aside
for the moment.

6. Remove the tip priming trough and store it in the dispenser accessories
bag.

7. Remove the two inlet tubes from the syringe valves and store them in their
plastic canisters.

8. Remove the two outlet tubes from the syringe valves. Attach the clear
plastic shrouds to the fittings of the outlet tubes. Place the tubes in a plastic
bag.

9. Remove the front cover from the dispenser.
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10. Insert the bottom foam end cap in the dispenser accessories shipping box
and place the accessories in the insert.

Bags With Smaller—
Accessories

;
Accessory —
Box

11. Insert the bottom foam end cap in the shipping box, and place the
dispenser inside the end cap.

12. Insert the foam insert that holds the reagent bottle holders and injector
tubing into the shipping box and place the bottle holders and tubing in it.

13. Slide the dispenser accessories box into the shipping box.
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14. Insert the top foam end cap. Close and seal the outer box with tape.

15. Write the RMA number on the outside of the box. Ship the box to BioTek.

Foam
Cover

Injector

Bottle
Tubing set .

Holders

Box with
Accessories

Foam
Insert

_~——Dispenser

o shawn in bag
Foam
Insert
Shipping
Box
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Chapter 3

Getting Started

This chapter describes some of the Cytation3's external and
internal components, and provides an introduction to using
BioTek Gen5 software to control the instrument.

Modular DeSIgN .. 44
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Internal Components ... ... . 46
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Modular Design

The Cytation3 is a multi-mode reader, with a design that allows you to initially
purchase only the detection capabilities you need and then upgrade later as your
requirements expand. Please contact BioTek Customer Care to learn more about
your upgrade options.

Genb software is used to control the reader. If the reader is connected and turned
on, Genb will present you with only those options that apply to your reader model.
For example, if your model is not equipped with the monochromator system, Gen5
will not provide the option to create this type of read in your assay protocol.

The module letters form the part number for each Cytation3 model; for example, a
reader with all capabilities is an CYT3MFV. This is indicated on a label on the

reader.
Identifier | Module Description
CYT3V Base model: imaging, incubation, shaking, and gas ready
CYT3MV Base model with top and bottom monochromator-based optics
CYT3FV Base model with top filter-based optics
CYT3MEV Base_ model with bo.th top and bottom monochromator-based optics and
top filter-based optics
Non-imager base model with top and bottom monochromator-based
CYT3M .
optics
CYT3F Non-imager base model with top filter-based optics
Non-imager base model with both top and bottom monochromator-
CYT3MF . . :
based optics and top filter-based optics
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External Components

1 [The entry for the dispense outlet tubes and injectors (if
equipped)

Filter cube access door

The microplate carrier eject button

The light-blocking microplate carrier access door

The power switch

LED cubes, imaging filter cubes, and objectives access door

N|[fojfu|h,~|[w]|N

Gas controller hookup (on back of instrument)
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Internal Components

Component Description Page

The filter cube can contain excitation and emission
filters, mirrors, and polarizing filters. Preconfigured
cubes are available from BioTek, or you can change the page

Filter Cube filters and mirrors yourself. 46

Note: These cubes are not to be confused with the imag-
ing LED cubes and filter cubes.

Applies to models with the dispense module. The age
Injector System syringes may require replacement over time. The tub- 279
ing and injectors require cleaning at regular intervals.

Applies to models with the imaging module. The
imaging system, comprising a CCD camera, objectives,

Imaging System LED cubes, and filter cubes, allows you to run exper- Egge
iments with imaging reads as well as view images in
live mode.

Filter Cube

The Cytation3 is equipped with a filter cube that contains excitation and emission
tilters, mirrors, and, if required, polarizing filters. Each filter cube contains two
filter sets, each of which contains one excitation filter, one mirror, and one

emission filter. The filter cube is accessed through a hinged door on the front of
the instrument.

Synergy H1 filter cubes are interchangeable with the filter cubes for the
Cytation3.

Do not open the doors to access the filter cube during instrument oper-
ation. Doing so may result in invalid data.

Define the Filters

Genb keeps track of each cube's contents and communicates this information to the
instrument during operation. If you change the filter cube, you must update
Genb's Filter Cube Table (System > Instrument Configuration > Setup).

o Select Band Pass, Long Pass, or Short Pass, as appropriate for each
filter type.
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¢ Band Pass, a standard interference filter with a defined central
wavelength and bandwidth.

e Long Pass, cutoff filters that transmit longer wavelengths and block
shorter wavelengths.

o Short Pass, cutoff filters that transmit shorter wavelengths and
block longer wavelengths.

e Select PLUG to indicate the presence of a plug.

e Select HOLE to indicate an empty location.

Learn how to change the filter cube in Chapter 4, Filters and
Mirrors.

See page 50 for information on updating the Gen5 Filter Cube Table.

Configuring the System for Luminescence Measurements

If your tests require that light emitted from the samples remain unfiltered, the
Emission filter position in the filter cube should be empty.

1. Click System > Optics Library > Filter Cubes.

2. Select the checkbox in the On Site column for the filter cubes you have
available.

Injector System

The tubing and injectors should be cleaned at least every three
months. See Chapter 5, Preventive Maintenance, for instructions.

Inspect the injector system daily for leaks, preferably immediately
after priming and whenever tubing changes have been made.

If a syringe is leaking, it may need to be replaced. See Chapter 6, As
Needed Maintenance, for instructions.

Dispense Module

@ Each dispense module is calibrated to perform with a specific Cytation3

reader. Make sure the dispense module and the reader have the same serial
number.
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The dispense module sits on top of the reader and pumps fluid from the reagent
bottles to injector located inside the instrument. Fluid is injected into one well at a
time. The injectors support plate types from 6- to 384-well plates.

1 Two 250 pL syringes draw fluid from the supply bot-
tles

2 Inlet tubes transport fluid from the supply bottles to
the syringes. These tubes are short pieces of opaque
PTFE (Teflon) tubing connected to stainless-steel
probes on one end and threaded fittings on the other
end.

3 Solenoid valves allow the fluid drawn from the supply
bottles by the syringe pumps to flow into the outlet
tubes.

4 Outlet tubes transport fluid from the syringes into the
instrument, through the tubing ports on the Cyta-
tion3's top cover. The outlet tubes are opaque PTFE
tubes with threaded fittings on each end.

Dispense Module Components and Materials Composition

Continuous contact with harsh chemicals is not recommended. Always rinse the
fluid path with deionized water after contact with any strong acid, base, or solvent.

Components Material Composition

Tubing, syringe fittings PTFE (polytetrafluoroethylene)
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Components Material Composition
Injector tips 315 stainless steel

Injector body PVC (polyvinyl chloride)
Priming plate and trough Polyproylene

Valve diaphrams Ethylene propylene (EPDM)
Valve body PEEK (polyether ether ketone)
Syringe barrel Borosilicate glass

See the Preventive Maintenance chapter for cleaning instructions.

Priming the Injector System

Before running a dispense assay, prime the system with the reagent or dispensing
fluid. In addition, tip priming can be performed at the start of an assay and,
sometimes, just before each dispense to a well. The tip prime compensates for any
fluid loss at the injector tip due to evaporation since the last dispense. All priming
activities are controlled via Genb.

If the injector system is not primed adequately, air bubbles can get
trapped in the system and affect injection volumes. Air bubbles in the
system can also result in fluid spraying or scattering inside the reader.

Both types of primes require a fluid reservoir to be present on the microplate
carrier.

e The priming plate is placed on the microplate carrier for a Prime operation
(to prime the dispense system with fluid).

e The tip priming trough is placed in the rear pocket of the carrier, and is
used for performing the Tip Prime before dispensing. The trough holds up
to 1.5 mL of liquid and must be periodically emptied and cleaned by the
user.

Do not perform tip priming when using tall plates. Generally,
plates with fewer than 96 wells are too tall for error-free tip priming;
and, tip priming is rarely required for these larger-volume plates.

The priming tray should be empty before priming and contain fluid after
priming.
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Imaging Module

Instruments with the imaging module can perform image reads, view and capture
images in manual mode, and save the images for later analysis. The imaging
module comprises a CCD digital camera, up to four LED cubes and four imaging
tilter cubes, a bright field channel, and two objectives. The imaging module
supports two modes, manual mode and experiment mode.

Camera

Genb controls the CCD camera via FireWire. Using Gen5, you can focus the
camera, determine exposure settings, and capture images.

LED Cubes and Filter Cubes

The LED cubes and imaging filter cubes are located behind a door on the left side
of the instrument and are user-changeable. See LED Cubes and Imaging Filter
Cubes on page 63 for more information.

Objectives

The objectives are also located next to the LED cubes and imaging filter cubes and
are held in an objective turret. Gen5 supports two user-changeable objectives being
installed simultaneously.

Imaging Modes

The Genb imaging module provides two modes of use: manual and experiment.
Manual mode allows you to view, capture, and analyze images outside of a
protocol or experiment. Images are displayed in real time. You can also retrieve
previously captured and saved images to analyze in manual mode.

In experiment mode, you can include an image read step as an endpoint read or in
a kinetic block in your procedures and experiments. A procedure containing an
image read step can also include other steps, such as a different detection mode
read, dispense steps, shake steps, and incubation, if supported by the instrument.

Gen5 Software

BioTek Genb software supports all Cytation3 reader models. Use Gen5 to control
the reader, the imaging module (if equipped), the dispense module (if equipped),
and the stacker (if equipped); perform data reduction and analysis on the
measurement values; print or export results; and more. This section provides brief
instructions for working with Gen5 to create protocols and experiments and read
plates. Refer to the Gen5 Help system for more information.
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Define the Filter Cube

The reader’s onboard software is configured with the filter and mirror values and
their locations in the filter cube. When Gen5 communicates with the reader, it
“asks” for this information and then stores it in a Filter Cube table. If you make any
changes to the filter cube, you must define the changes in Gen5 and send the
information to the reader.

e Select System > Instrument Configuration. Highlight the Cytation3,
and click View/Modify.

e Click Setup and then click the Filter Cube tab. Refer to the Gen5 Help
system for additional instructions.

Protocols and Experiments

In Gen5, a protocol contains instructions for controlling the reader and (optionally)
instructions for analyzing the data retrieved from the reader. At a minimum, a
protocol must specify the procedure for the assay you wish to run. After creating a
protocol, create an experiment that references the protocol. You'll run the
experiment to read plates and analyze the data.

These instructions briefly describe how to create a protocol in Gen5. See the Genb
Help system for complete instructions.

1. Open a new protocol.

2. Open the Procedure dialog. If prompted to select a reader, select the
Cytation3 and click OK.

3. Select a Plate Type.

The assay plate must match the plate type selected in Gen5. Other-
wise, the results of the read may be invalid.

For imaging reads, you must first define the bottom elevation in the
Plate Type Database. See the Gen5 Help for instructions.

4. Add steps to the procedure for shaking or heating the plate, dispensing
fluid, reading the plate, and more. Click Validate to verify that the reader
supports the defined steps, and then click OK.

Optionally, perform the next steps to analyze and report the results:

5. Open the Plate Layout dialog and assign blanks, samples, controls, and/or
standards to the plate.
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6. Open the Data Reduction dialog to add data reduction steps. Categories
include Transformation, Well Analysis, Curve Analysis, Cutoff, and
Validation.

7. Create a report or export template via the Report/Export Builders.

8. Select File > Save and give the file an identifying name.

These instructions briefly describe how to create an experiment and then read a
plate in Genb. See the Gen5 Help system for complete instructions.

1. Open a new experiment.

2. Select the desired protocol and click OK.
3. Select a plate in the menu tree and read it.
4

. When the read is complete, measurement values appear in Genb. Select the
desired data set from the Data list.

5. Select File > Save and give the file an identifying name.

Imaging Module: Manual Mode
Applies only to models with the imaging module.

The following sections briefly describe how to use the Gen5 imaging module in
manual mode. See the Gen5 Help for more complete instructions and descriptions
of these features.

Focusing the Camera

1. From the Task Manager, select Read Now > Run Imager Manual

8

Mode. Alternatively, from the main Gen5 screen, click =L .

2. Click Auto Expose, or manually adjust the Exposure settings until you see
an image.

3. Click Auto Focus, or click the arrow buttons until the image is in focus.

4. Repeat these two steps until the image is exposed and focused to your
liking.

You can also select Find Image to have Gen5 automatically expose and
focus the image.
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Capture and Save an Image
After you have exposed and focused an image, you can capture and save it for later
analysis.

1. When an image in the Capture dialog is exposed and focused to your

liking, click to capture it.

2. To save the image or images you capture, click Review, click to

perform any additional brightness and contrast adjustments, then click
Save.

Any adjustments made using the B&C (brightness and contrast) dialog
are for display purposes only; the changes do not affect the data meas-
urements from the images.

Analyze Captured and Saved Images

1. With your captured or saved images displayed in the left panel of the
Capture dialog, click Review.

2. In the Review dialog, you can further adjust the brightness and contrast of
the image, if necessary.

3. Click Analyze.

4. In the Analyze Tool, select which type of analysis you want to perform and
define the parameters for the analysis, then click Start. The results are
displayed in the right pane.

Imaging Module: Experiment Mode
Applies only to models with the imaging module.

The following sections briefly describe how to use the Gen5 imaging module in
experiment mode. See the Gen5 Help for more complete instructions and
descriptions of these features.

Perform an Image Read

The following steps briefly describe how to set up a protocol with an imaging read
step. See the Gen5 help for more detailed instructions.

1. Create a new protocol.

2. Select Image as the Read Method.
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8.
9.

(Optional) Enter a step label or unique name for this step. Data sets of the
reading results will use the label in online views, reports, and export files.

Select the Objective.
Define whether to read a full plate or specific wells.

Define up to four channels to read, defining the color filter and exposure
settings and selecting which well are to be read for each color channel.

Select whether to create a single image for each well. If this box is cleared,
you are prompted to define a montage read.

Define the horizontal and vertical offset from the center of the well.

Define advanced options, if needed.

After you have defined the protocol, you can create an experiment and read the

plate:

1. Open a new experiment.

2. Select the protocol you created with the imaging read step, and click OK.
3.
4

Select a plate in the menu tree and read it.

. When the read is complete, images and measurement values appear in

Genb. Select the desired data set from the Data list.

Select File > Save and give the file an identifying name.

Using the Slide Holder

Manual Mode

1.

When prompted upon entering manual mode, select Slide Holder as
your plate type.

The slide holder plate map contains two well positions that correspond
with the two slide locations on the slide holder. Select the well position
that contains the slide you want to image.

By default, the carrier moves so that the middle of the selected slide
position is below the objective. However, the sample on your slide may be
in a different location on the slide. To find the sample:

a. Select your lowest-power objective.

b. Select either Small step or Large step, then use the arrow buttons to

move the slide around until you find your sample. The cross in the slide
display to the right of the arrow buttons shows the general position of
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the image in relation to the slide. The back arrow to the left of the slide
display shows the direction that the slide enters the read chamber.

d ]

4. After you find your sample, you can change to a higher-power objective, if
desired, or define a Read step in a protocol using the x- and y-coordinates
of your sample, which are displayed below the Well button.

Experiment Mode

1. In an experiment, select Slide Holder as the plate type, and create an
Image read step.

i
2. Clear the Auto box to turn off Auto Exposure, then click =l to enter
manual mode.

3. Follow steps 2 and 3 in the manual mode procedure (above) to find your
samples, then click Save settings. Gen5 imports your exposure settings
and the values for Horizontal and Vertical offset from the center of the
well to your read step.

4. Select Auto to turn Auto Exposure back on. Gen5 will auto-expose your
image, retaining the well offset imported from manual mode.

You can also enter the values for Horizontal and Vertical offset from
center of well if you had determined them during previous testing.

Dispense Module Control
This section applies only to models with injectors.

Genb is used to perform several dispense functions, such as initialize, dispense,
prime, and purge. The Prime and Purge functions are introduced here. See the
Genb Help system for more information.

Priming and purging routines are used to clean the fluid paths; see also
Flushing/Purging the Fluid Path in the Preventive Maintenance
chapter.

Prime

Before running an experiment with a dispense step, prime the system with the
fluid to be used.
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1. Place the priming plate on the carrier.

2. Fill the supply bottle with a sufficient volume of the fluid to be used for the
prime and the assay. Insert the appropriate inlet tube into the bottle.

3. In Genb, select System > Instrument Control > Cytation3 and click
the Dispenser tab.

4. Select the Dispenser number (1 or 2) associated with the supply bottle.

5. Enter the Volume to be used for the prime. The minimum recommended
prime volume is 2000 pL.

6. Select a prime Rate, in uL/second.
7. Click Prime to start the process.

8. When finished, carefully remove the priming plate from the carrier and
empty it.

If the priming plate is empty, the prime volume was too low.

Purge

To save reagent, Gen5 provides the option to purge fluid from the system back into
the supply bottle.

1. In Genb, select System > Instrument Control > Cytation3 and click
the Dispenser tab.

Select the Dispenser number (1 or 2) associated with the supply bottle.
Enter the desired purge Volume in pL (e.g., 2000).

Select a prime Rate in pL/second.

S

Click Purge to start the process.

Recommendations for Optimum Performance

General

e Microplates should be clean and free from dust or bottom scratches. Use
new microplates from sealed packages. Do not allow dust to settle on the
surface of the solution; use microplate covers or seals when not reading
the plate. Filter solutions to remove particulates that could cause
erroneous readings.

e Although the Cytation3 supports standard flat, U-bottom, and V-bottom
microplates, the reader achieves optimum performance with flat-bottomed
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wells when running in Absorbance mode. See Appendix A, Specifications
for more information on the supported plates.

e Non-uniformity in the optical density of the well bottoms can cause loss of
accuracy, especially with U- and V-bottom polyvinyl microplates. Check
for this by reading an empty microplate. Dual wavelength readings can
eliminate this problem, or bring the variation in density readings to within
acceptable limits for most measurements.

e Inaccuracy in pipetting has a large effect on measurements, especially if
smaller volumes of liquid are used. For best results in most cases, use at
least 100 pL per well in a 96-well plate and 25 pL in a 384-well plate.

 Pipetting solution into 384-well plates often traps air bubbles in the wells,
which may result in inaccurate readings. A dual-wavelength reading
method usually eliminates these inaccuracies. For best results, however,
remove the air bubbles by degassing the plate in a vacuum chamber or
spinning the plate in a centrifuge before reading.

e The inclination of the meniscus can cause loss of accuracy in some
solutions, especially with small volumes. Shake the microplate before
reading to help bring it within acceptable limits. Use Tween 20, if possible
(or some other wetting agent) to normalize the meniscus for absorbance
measurements. Some solutions develop menisci over a period of several
minutes. This effect varies with the brand of microplate and the solution
composition. As the center of the meniscus drops and shortens the light
path, the density readings change. The meniscus shape will stabilize over
time.

o It is the user’s responsibility to understand the volumetric limits of the
plate type in use as it applies to the assay being run.

Read Direction

The Cytation3 performs most reads in a row-wise direction, that is, moving from
well Al, to A2, then A3, and so on.

Luminescence Measurements

For highly sensitive luminescence assays using white plates, add a Delay step to
your procedure to "dark adapt" the plates in the Cytation3's reading chamber
before taking measurements.

Monochromator-Based Fluorescence Systems

Although Time-Resolved Fluorescence can be performed with the monochromator,
the filter-based fluorescence system is more sensitive for TRF and is the better
choice.
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Models with Injectors

o To keep the dispense system in top condition, flush and purge the fluid
lines with deionized (DI) water every day or upon completion of an assay
run, whichever is more frequent. Some reagents may crystallize or harden
after use, clogging the fluid passageways. Flushing the tubing at the end of
each day, letting the DI water soak, and then purging the lines at the
beginning of each day ensures optimal performance of the dispense
system. See the Preventive Maintenance chapter for more information.

o When dispensing volumes less than or equal to 20 pL/well, we
recommend specifying a tip prime volume that is equal to the dispense
volume. For dispense volumes greater than 20 uL/well, we recommend a
tip prime volume of 20 pL.

o To avoid spillage and possible contamination of the instrument, empty the
tip prime trough frequently and do not exceed the total fluid volume of
the plate well when dispensing.

Using 384-Well Microplates

When using a 384-well microplate, you can use the Gen5 Auto Map feature to
ensure you are using an accurate plate map for your reads. See the Gen5 Help for
more information.
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Filters, Filter Cubes,
Mirrors, LED Cubes, and
Objectives

The Getting Started chapter provided an overview of the
filters, mirrors, and objectives installed in some Cytation3

models. This chapter provides more detailed information on
working with these components.

Filter Cubes
LED Cubes and Imaging Filter Cubes ... ... . ... ... 63

About Imaging Objectives
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Filter Cubes

For information about the LED cubes and imaging filter cubes, see page
63.

Overview

Most Cytation3 models are equipped with excitation and emission filters and
mirrors for use when taking fluorescence and luminescence measurements. Each
filter cube contains two filter sets, each of which contains one excitation filter, one
emission filter, and one mirror. The filter cube is accessed through a hinged door

on the front of the instrument. You can mark the label on the front of the filter
cube with the contents of the cube.

You can easily exchange the Cytation3's filter cube to meet your assay
requirements. If you regularly need to change the filters or mirrors on the reader,

consider purchasing additional filter cubes from BioTek to make the process easier
and faster.

Gen5 has a Filter Cube Library in which you must manage the contents

of your filter cubes. See Adding a Filter Cube to the Optics Library
on page 63.

The Synergy H1 filter cubes are interchangeable with the filter cubes
for the Cytation3.

The default filter cube configuration is shown below; any changes are reflected in
the sales order. Verify that your cubes contain the expected/ordered filters and

mirrors. Contact BioTek or your supplier if the reader is not equipped with the
expected filters.
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Position 1 Position 2
Excitation 360/40 485/20
Emission 460/40 528/20
Mirror 400 510

Filters are not specific to either excitation or emission. Filter direction within the
filter cube is important, and the direction differs depending on the filter type. Each
tilter has its central wavelength and band pass values printed on its side, with an
arrow to indicate the proper direction of light through the filter.

FILTER BLOCK TOP

LIGHT
DIRECTION

LIGHT
DIRECTION

The filter cube can hold up to two half-size or one full-size dichroic or 50% mirror.
The mirror positions are labeled “1”and “2” to coordinate with EX1/EM1 and

EX2/EM2.

For Cytation3 models with FP capability, the cube is equipped with up to four
polarizers of the following types:

 Excitation polarizer (visible-range or UV-range)

o Emission polarizer, parallel to excitation polarizer

o Emission polarizer, perpendicular to excitation polarizer

Two types of excitation (EX) polarizers are available: visible-range (400 nm and
above, the default) or UV-range (300 nm and above, available from BioTek). The
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polarizers, if used, are placed below the excitation filters and above the emission
filters.

Mirror direction is important. The mirror label should be in the lower-right corner
of the mirror and readable. If the mirror is not positioned correctly in the filter
cube, your measurement data may be inaccurate.

Filter cube label

Mirror labels

Filter Cubes Library

The Cytation3 Filter Cubes Library lists the filter cubes available for use with the
Cytation3. The cubes are arranged numerically, with short descriptions of their
purposes and filter configurations.

To open the Filter Cubes Library, from the Gen5 main screen, click System >
Optics Library > Filter Cubes. In this dialog, you can

e Indicate which cubes are on site by selecting the checkbox to the left of the
filter cube number

o Import filter cube configurations for new cubes
o Export a filter cube configuration

e Delete unnecessary filter cubes

Cleaning the Filters and Mirrors

Instructions are provided in the Preventive Maintenance chapter.

Installing or Removing a Filter Cube

Do not open the access door on the front of the instrument during oper-
ation. Doing so may affect measurements.
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Lift up the hinged door on the front of the reader.
e To install a filter cube, slide it gently into its chamber.

e To remove a filter cube, slide it out of its chamber.

Adding a Filter Cube to the Optics Library
1. Use Genb to update the reader's internal software with the current filter
cube configuration; see "Define the Filters" in the Getting Started chapter.
2. Click System > Optics Library > Filter Cubes.

3. Click Add, and enter a name for the filter cube. This is then available for
selection on the protocol/experiment procedure.

4. Enter a name for Filter Set 1.

If you select Fluorescence Polarization Cube, only Filter Set 1 is avail-
able for definition; the filters and mirrors of Filter Set 2 must be iden-
tical to those of Filter Set 1 for fluorescence polarization cubes.

5. Define the Excitation and Emission filters:

= Select Band Pass, Long Pass, or Short Pass, and enter the
wavelength and bandwidth.

= Select Plug to indicate the presence of a plug.
» Select Hole to indicate an empty location.
6. Select the mirror type and enter the excitation and emission ranges.

7. Define Filter Set 2, if necessary.

8. Click OK.

Filter Cubes Available from BioTek

Preconfigured filter cubes, LED cubes, and imaging filter cubes are available for
purchase from BioTek. See the list at www.biotek.com/products/accessories.
Please note that part numbers are subject to change, and new cubes may become

available. Custom filters are also available. Contact BioTek Customer Care with any
questions.

LED Cubes and Imaging Filter Cubes

Cytation3 models with imaging capability are equipped with up to four LED cubes
and four imaging filter cubes. The LED cubes hold an LED light source; the filter
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cubes contain excitation and emission filters and a dichroic mirror. The
preconfigured LED cubes and filter cubes are available from BioTek at
www.biotek.com/products/accessories.

The LED cubes and filter cubes are accessed through a door on the left side of the
instrument and are seated on a filter slide that you can pull out of the instrument.
See Install the LED Cubes and Filter Cubes on page 25 for more information.

Do not open the door to access the cubes during instrument operation.
Doing so may result in invalid data.

ssBiolek

LED Cube and Imaging Filter Cube Library

System > Optics Library > LED Filter Cubes

The LED Cube and Imaging Filter Cube Library lists the LED cubes and filter cubes
available for use with the Cytation3. The cubes are listed by color, filter cube part
number, excitation and emission wavelengths, and LED cube part number.

Import and Export LED Cube and Imaging Filter Cube Definitions

The Genb installation package includes an XML file that contains the definitions of
the LED cubes and imaging filter cubes available with your reader. If you purchase
additional LED cubes and filter cubes and do not have their corresponding

XML file, you must import their definitions into Genb.

1. Go to System > Optics Library > LED Filter Cubes.

2. Click Import, and navigate to the folder in which your Gen5 application
tiles are stored (for example, C:\ Program Files\ BioTek\ Gen5 x.x).
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3. Select the InitialLEDFilterCubes.xml file, and click Open. Any new LED
cube and filter cube definitions are imported into Genb.

About Imaging Objectives

Readers with the imaging module support fluorescence and bright field reads
using objectives. Up to two objectives can be installed in the reader simultaneously.

The objectives are defined in the Imaging Configuration tab in the Reader Setup
dialog. Gen5 communicates with the reader to get and set the currently configured
objectives. If you select an objective that is not defined as being installed in the
reader, when validating an imaging read step, Gen5 displays an error message. See
Install the Imaging Objectives on page 27 for more information.

The objectives are shipped in capsules in the objectives case in the accessories box.
Keep the capsules for storing the objectives when not in use.

T?‘. (’[ N T;\L/capsule
|

foam sits at bottom

ohjective mounts to of capsule
the threaded capsule cowver

Import and Export Objective Definitions

The Genb installation package includes an XML file that contains the definitions of
the objectives available with your reader. If you purchase additional objectives and

do not have their corresponding XML files, you must import their definitions into
Genb.

1. Go to System > Optics Library > Objectives.

2. Click Import, and navigate to the folder in which your Gen5 application
tiles are stored (for example, C:\ Program Files\ BioTek\ Gen5 x.x).

3. Select the InitialObjectives.xml file, and click Open. Any new objective
definitions are imported into Genb.
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Preventive Maintenance

This chapter provides instructions for maintaining the Cyta-
tion3 and external dispense module (if used) in top condition,
to ensure that they continue to perform to specification.
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Preventive Maintenance Overview

A general preventive maintenance regimen for all Cytation3 models includes
periodically cleaning all exposed surfaces and inspecting/cleaning the objectives,
emission and excitation filters, and mirrors (if used).

For models with the external dispense module, additional tasks include
flushing/purging the fluid path and cleaning the tip prime trough, priming plate,
supply bottles, dispense tubing, and injectors.

Daily Cleaning for the Dispense Module

To ensure accurate performance and a long life for the dispense module and
injectors, flush and purge the fluid lines with deionized (DI) water every day or
after completing an assay run, whichever is more frequent. Some reagents may
crystallize or harden after use and clog the fluid passageways. Take special care
when using molecules that are active at very low concentrations (e.g., enzymes,
inhibitors). Remove any residual reagent in the dispense lines using a suitable
cleaning solution (review the reagent’s package insert for specific
recommendations).

Flushing the tubing at the end of each day, letting the DI water soak overnight,
and then purging the lines at the beginning of each day ensures optimal
performance of the dispense system. BioTek recommends performing a visual
inspection of the dispense accuracy before running an assay protocol that includes
dispense steps.

BioTek also recommends flushing the module with DI water before conducting the
decontamination procedure described in the As Needed Maintenance chapter.

Models with injectors: Accumulated algae, fungi, or mold may require
decontamination. See the As-Needed Maintenance chapter for com-
plete decontamination instructions.

Recommended Maintenance Schedule

This table recommends preventive maintenance tasks and the frequency with
which each task should be performed.

The risk and performance factors associated with your assays may require
@ that some of all of the preventive maintenance procedures be performed
more frequently than shown here.
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Task Daily Quarterly | As Needed
All models:

Decontamination before shipment or storage

Clean exposed surfaces v
Models with filter-based fluorescence capability:

Inspect/clean excitation and emission filters 4

Inspect/clean mirrors annually
Models with injectors:

Flush/purge the fluid path v

(Optional) Run Dispense protocol v
Empty/clean tip prime trough v

Clean priming plate v
Clean dispense tubes and injectors v v
Models with imaging:

Clean objectives v v

Find Decontamination instructions in the As-Needed Maintenance

chapter.

Warnings and Precautions

Read the following before performing any maintenance procedures:
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Warning! Internal Voltage. Turn off and unplug the instrument for all
maintenance and repair operations.

Important! Do not immerse the instrument, spray it with liquid, or use a
“wet” cloth on it. Do not allow water or other cleaning solution to run into the
interior of the instrument. If this happens, contact BioTek’s Technical Assis-
tance Center.

Important! Do not apply lubricants to the microplate carrier or carrier
track. Lubricant attracts dust and other particles, which may obstruct the car-
rier path and cause errors.

Warning! Wear protective gloves when handling contaminated instruments.
Gloved hands should be considered contaminated at all times; keep gloved
hands away from eyes, mouth, nose, and ears.

Warning! Mucous membranes are considered prime entry routes for infec-
tious agents. Wear eye protection and a surgical mask when there is a pos-
sibility of aerosol contamination. Intact skin is generally considered an
effective barrier against infectious organisms; however, small abrasions and
cuts may not always be visible. Wear protective gloves when handling con-
taminated instruments.

Caution! The buildup of deposits left by the evaporation of spilled fluids
within the read chamber can impact measurements. Be sure to keep System
Test records before and after maintenance so that changes can be noted.

Warning! The instrument with all available modules weighs up to 80 Ibs.
(36.3 kg). Use two people when lifting and carrying the instrument.

Clean Exposed Surfaces

Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened
(not soaked) with water or water and a mild detergent. You'll need:

e Deionized or distilled water

e (Clean, lint-free cotton cloths

o Mild detergent (optional)

o Canned air

. Turn off and unplug the instrument.

. Moisten a clean cotton cloth with water, or with water and mild detergent.

Do not soak the cloth.

Wipe the plate carrier and all exposed surfaces of the instrument.
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4. For instruments with imaging capability: Used canned air to blow any
debris from the aperture on the carrier. Do not wipe with liquid because
liquid can seep inside the glass plates surrounding the aperture and
negatively affect imaging reads.

Wipe all exposed surfaces of the dispense module (if used).
Wipe all exposed surfaces of the gas controller module (if used).

If detergent was used, wipe all surfaces with a cloth moistened with water.

P N o O

Use a clean, dry cloth to dry all wet surfaces.

Models with injectors: If the Tip Priming Trough overflows or other
spills occur inside the instrument, wipe the carrier and the surface
beneath the carrier with a dry cotton cloth. The internal chamber and
probes are not customer-accessible. If overflow is significant, contact
BioTek’s Technical Assistance Center with any questions about your
particular model.

Inspect/Clean Excitation and Emission Filters

Applies only to Cytation3 models with filter-based fluorescence capabilities.

Laboratory air is used to cool the flash bulb, and the filter cubes can become dusty
as a result. Filters should be inspected and cleaned at least every three months.
You'll need:
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Isopropyl, ethyl, or methyl alcohol

100% pure cotton balls or high-quality lens-cleaning tissue
Cloth gloves

Magnifying glass

Do not touch the filters with your bare fingers!

. Turn off and unplug the instrument.

. Open the access door on the front of the instrument. Slide the filter cube

out of its compartment.

. Inspect the glass filters for speckled surfaces or a “halo” effect. This may

indicate deterioration due to moisture exposure over a long period of time.

If you have any concerns about the quality of the filters, contact your
BioTek representative.

. Using cotton balls or lens-cleaning tissue moistened with a small amount of

high-quality alcohol, clean each filter by lightly stroking its surface in one
direction.

. Use a magnifying glass to inspect the surface; remove any loose threads left

from the cotton ball.

. Replace the filter cube and close the door.

Inspect/Clean Mirrors

Applies only to Cytation3 models with filter-based fluorescence capabilities.

We recommend inspecting/cleaning the mirrors and polarizing filters (if
equipped) annually, especially if the filter cube has been opened or changed.

These optical elements are delicate and should be handled as carefully as possible.
The glass and anti-reflective (AR) coated surfaces will be damaged by any contact,
especially by abrasive particles. In most cases, it is best to leave minor debris on
the surface. However, if performance indicators or obvious defects in the mirrors
or filters suggest cleaning them, here are some guidelines:

o Use of oil-free dry air or nitrogen under moderate pressure is the best

method for removing excessive debris from an optical surface. If the
contamination is not dislodged by the flow of gas, please follow the
cleaning instructions below.
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e The purpose of the cleaning solvent is only to dissolve any adhesive
contamination that is holding debris on the surface. The towel needs to
absorb both the excessive solvent and entrap the debris so that it can be
removed from the surface. Surface coatings on dichroics are typically less
hard than the substrate. It is reasonable to expect that any cleaning will
degrade the surface at an atomic level. Consideration should be given as to
whether the contamination in question is more significant to the
application than the damage that may result from cleaning the surface. In
many cases, the AR coatings that are provided to give maximum light
transmission amplify the appearance of contamination on the surface.

Materials
o 7/64" hex key
e Linen or cloth gloves
e Anhydrous reagent-grade ethanol
o Kimwipes
e Magnifying glass

e 100% pure cotton balls (for the polarizing filters)

Procedure

1. Turn off and unplug the reader.

2. Open the access door on the front of the instrument and slide the filter
cube straight out of its compartment.

3. Set the filter cube on the work surface. Using a 7/64" hex key, remove the
screw and washer located between the emission filter positions.

Remove the screw from the filter cube
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4. Carefully lift the filter cube top from the cube.

5. Wearing linen or cloth gloves, grasp the mirror by its edges and lift it out
of the cube.

The mirrors are seated on a shelf in the bottom of the cube and are not
secured in place.

6. Wet absorbent towels such as Kimwipes, not lens paper, with anhydrous
reagent-grade ethanol. Wear gloves or use enough toweling so that
solvents do not dissolve oils from your hands that can seep through the
toweling onto the coated surface.

7. Drag the trailing edge of the ethanol-soaked Kimwipe across the surface of
the mirror, moving in a single direction. A minimal amount of pressure
can be applied while wiping. However, too much pressure will damage the
mirror.

8. Use the magnifying glass to inspect the surface; if debris is still visible,
repeat with a new Kimwipe.

9. To replace the mirror, hold it by its edges, turn it so that its label is face-up
and readable, and place it on the shelf in the filter cube.

Filter cube label

Mirror labels

Mirrors in filter cube

10. Place the filter cube top back onto the cube and replace the screw and
washer.
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11. When finished, reinstall the filter cube in the reader.

Clean the Objectives

Applies only to models with the imaging module.

The objectives used in the Cytation3 should be cleaned when necessary using
optical-grade swabs or lens paper moistened with lens cleaning solution or
deionized water. Do not rub the lens.

Materials
e Air puffer
o Tweezers
o Magnifying glass
e Lens cleaning tissue
e Optical-grade swabs

e (leaning solvent

Non-recommended Cleaning Sol-

Recommended Cleaning Solvents
vents

HyperClean (hexamethyldisoloxan and

ethanol), available from Olympus Methyl ethyl ketone (MEK)

Isopropyl alcohol, 70%/30% with deion-

i-ed water Dimethyl ketone (acetone)

Methyl alcohol, 70%/30% with deionized
water

Ethyl alcohol, 70%/30% with deionized
water

1. From the Genb5 main screen, go to System > Instrument
Configuration, select Cytation3, click View/Modify > Setup.

2. In the Objective Configuration area in the Imaging Configuration tab, click
Move to Access Position. The objective turret rotates to its access
position.

3. Open the side door of the instrument. Grasp one of the objectives, unscrew
it from the objective holder, and remove it from the instrument.
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4. Inspect the lens, using a magnifying glass if necessary, to determine if
there is dirt or dust present. If so, use a blower or a small paintbrush to
remove any dirt and dust.

Any dirt or dust on the surface of the lens can cause extensive damage
if dragged across the surface.

5. Soak either an optical-grade swab or a piece of lens cleaning tissue
wrapped around tweezers in lens cleaning solvent or deionized water.

6. Hold the swab or tissue-wrapped tweezers still and rotate the objective's
lens around it.

7. Dry the lens immediately with a clean lens tissue.
8. Replace the objective in the objective holder, and screw it in to secure it.
9. Repeat these steps to clean the second objective, if necessary.

10. In the Imaging Configuration tab on Reader Setup dialog (which you
opened in step 1), click Auto Calibration to calibrate the objectives.

When the calibration is finished, the instrument is ready to use.

Tips
e Do not allow the lens to air dry.
e Always use an unused portion of the lens tissue when wiping the lens.

o If smears are still present after performing these steps, repeat the
procedure.

Flush/Purge the Fluid Path

Applies only to Cytation3 models with injectors.

At the end of each day that the dispense module is in use, flush the fluid path
using the Genb priming utility. Leave the fluid to soak overnight or over a
weekend, and then purge the fluid before using the instrument again.

This flushing and purging routine is also recommended before dis-
connecting the outlet tubes from the reader, and before decon-
tamination to remove any assay residue prior to applying isopropyl
alcohol or sodium hypochlorite.

To flush the fluid path:
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7.

Fill two supply bottles with deionized or distilled water. Insert the supply
(inlet) tubes into the bottles.

Place the priming plate on the carrier.

From the Genb main screen, select System > Instrument Control >
Cytation3.

Click the Dispenser tab and select Dispenser 1.
Set the Volume to 5000 pL. Keep the default prime rate.

Click Prime to start the process. When the process is complete, carefully
remove the priming plate from the carrier and empty it.

Repeat the process for Dispenser 2.

Leave the water in the system overnight or until the instrument will be used again.
Purge the fluid from the system (see below) and then prime with the dispense
reagent before running an assay.

To purge the fluid from the system:

. Place the inlet tubes in empty supply bottles or a beaker.
. Select System > Instrument Control > Cytation3.
. Click the Dispenser tab and select Dispenser 1.

1
2
3
4.
5
6

Set the Volume to 2000 pL.

. Click Purge to start the process.

. When the purge is complete, repeat the process for Dispenser 2.

After purging the system, you may wish to run a quick Dispense pro-
tocol to visually verify the dispense accuracy (see below) or the more
thorough Dispense Accuracy and Precision Tests (see Chapter 7,
Instrument Qualification).

Run a Dispense Protocol (Optional)

Applies only to Cytation3 models with injectors.

After flushing/purging the system and before running an assay that requires
dispense, visually inspect the dispensing accuracy.

1.

Create a Dispense protocol in Genb:

a. Create a new protocol with the plate type set to match the plate you will

use.
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b. Add a Dispense step with the following parameters:

e Select Dispenser 1.

o Set Tip Priming to Before this dispense step and Volume to 10
HL.

e Set the Dispense Volume to 100 pL (or an amount to match your
assay protocol).

e Adjust the Rate to support the dispensing volume.

e Click OK to close the dialog and add the Dispense step to the
procedure.

c. Add another Dispense step with the same parameters; select Dispenser
2.

d. Add a Read step with the following parameters (Gen5 requires a Read
step in a Dispense protocol):

e Select any Detection Method.

e Set the Read Type to Endpoint.

e Click Full Plate, click Clear All, then select well Al. Click OK.
e Select any wavelength or define one Filter Set.

e Click OK to close the dialog and add the Read step to the
procedure.

e. Click OK to close the procedure.

f. Select File > Save and give the protocol an identifying name, such as
“Dispense Observation.”

2. Fill the reagent bottles with a DI water-Tween solution (e.g., add 1 mL
Tween 20 to 1000 mL of deionized water).

3. Create a new experiment using the "Dispense Observation" protocol.
4. Click Read and follow the prompts.

5. When the procedure is complete, visually assess the fluid level in the wells
for accuracy. If the well volume appears to be unevenly distributed, clean
the internal dispense tubes and injectors.

Empty/Clean the Tip Priming Trough

Applies only to Cytation3 models with injectors.

The tip priming trough is a removable cup located in the rear pocket of the
microplate carrier, used for performing the Tip Prime. The trough holds about 1.5

BioTek Instruments, Inc.



Clean the Priming Plate | 79

mL of liquid and must be periodically emptied and cleaned by the user. Gen5 will
instruct you to do this at the start of an experiment that requires dispensing.

1. Extend the microplate carrier and carefully remove the tip priming trough
from the carrier.

2. Wash the trough in hot, soapy water. Use a small brush to clean in the
corners.

3. Rinse the trough thoroughly and allow it to dry completely.

4. Replace the trough in the microplate carrier.

Clean the Priming Plate

Applies only to Cytation3 models with injectors.

Clean the priming plate regularly to prevent bacteria growth and residue buildup.
Wash the plate in hot, soapy water, using a small brush to clean in the corners.
Rinse thoroughly and allow it to dry completely.

Clean the Dispense Tubes and Injectors

Applies only to Cytation3 models with injectors.

The Cytation3’s dispense tubes and injectors require routine cleaning, at least
quarterly and possibly more frequently depending on the type of fluids dispensed.

Required Materials
e Protective gloves
o Safety glasses
o Mild detergent
e Clean, lint-free cotton cloths
e Deionized or distilled water

e Stylus (stored in a plastic cylinder affixed to the rear of the dispense
module or reader) (PN 2872304)
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Remove the Dispense Tubes and Injector Holders

injector tip holder

1. Open the door on the front of the reader.
2. Grasp the injector tip holder by the tab and pull it up out of its socket.

3. Using your fingers, remove the thumbscrews securing the light shield to
the top of the reader and slide the shield up the outlets tubes.

4. Slide the injector tip holder through the hole in the top of the reader.

5. Turn each tube’s thumbscrew counterclockwise and gently pull each tube
from its injector tip.

6. On the dispense module, turn each outlet tube’s thumbscrew
counterclockwise to disconnect it from the injector.

Clean the Dispense Tubes and Injectors

Some reagents can crystallize and clog the tubing and injectors. Daily flushing and
purging can help to prevent this, but more rigorous cleaning may be necessary if
reagent has dried in the tubing or injectors.

To clean the dispense tubes, soak them in hot, soapy water to soften and dissolve

any hardened particles. Flush each tube by holding it vertically under a stream of
water.

To clean the injectors:

1. Gently insert the stylus into each injector tip to clear any blockages. (The
stylus is stored in a plastic cylinder affixed to the rear of the dispense
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module.)

2. Stream water through the pipe to be sure it is clean. If the water does not
stream out, try soaking in hot, soapy water and then reinserting the stylus.

Be careful not to bend the injector tips. A bent tip might not dispense
accurately.
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Chapter 6

As-Needed Maintenance

This chapter contains maintenance and component-replace-
ment procedures that need to be performed only occasionally.

DecontaminatioN ... o 84
Procedure for Models without a Dispenser ... .. ... ... 85
Procedure for Models with a Dispenser ... ... 86

Dispenser Syringe Replacement ... . ... ... 89
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Decontamination

Any laboratory instrument that has been used for research or clinical analysis is
considered a biohazard and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into contact with the
instrument during shipping, handling, and servicing. Decontamination is required
by the U.S. Department of Transportation regulations.

Persons performing the decontamination process must be familiar with the basic
setup and operation of the instrument.

BioTek Instruments, Inc., recommends the use of the following decon-
tamination solutions and methods based on our knowledge of the instrument
@ and recommendations of the Centers for Disease Control and Prevention
(CDC). Neither BioTek nor the CDC assumes any liability for the adequacy of
these solutions and methods. Each laboratory must ensure that decon-
tamination procedures are adequate for the biohazard(s) they handle.

Wear prophylactic gloves when handling contaminated instruments. Gloved
‘ﬁ hands should be considered contaminated at all times; keep gloved hands

' away from eyes, mouth, and nose. Eating and drinking while decon-
taminating instruments is not advised.

Mucous membranes are considered prime entry routes for infectious agents.
Wear eye protection and a surgical mask when there is a possibility of aero-
‘ﬁ sol contamination. Intact skin is generally considered an effective barrier

' against infectious organisms; however, small abrasions and cuts may not
always be visible. Wear protective gloves when performing the decon-
tamination procedure.

Required Materials
For all Cytation3 models:

e Sodium hypochlorite (NaClO, or bleach)

e 70% isopropyl alcohol (as an alternative to bleach)
e Deionized or distilled water

o Safety glasses

e Surgical mask

e Protective gloves

e Lab coat

o Biohazard trash bags
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e 125-mL beakers
e (lean, lint-free cotton cloths
Additional materials for models with the dispense module:
e Screwdriver
e Small brush for cleaning the tip priming trough and priming plate
e (Optional) Mild detergent

Procedure for Models without a Dispenser

The sodium hypochlorite (bleach) solution is caustic; wear gloves and eye
protection when handling the solution.

/! Do not immerse the instrument, spray it with liquid, or use a “wet” cloth. Do
not allow the cleaning solution to run into the interior of the instrument. If
this happens, contact the BioTek Service Department.

@ Turn off and unplug the instrument for all decontamination and cleaning oper-
ations.

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the
effects of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial
bleach is typically 10.0% NaCIlO; prepare a 1:20 dilution. Household
bleach is typically 5.0% NaClO; prepare a 1:10 dilution.

Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.
Open the plate carrier door and slide out the plate carrier.

Wipe the plate carrier and all exposed surfaces of the instrument.

SR

Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and
wipe all surfaces of the instrument that have been cleaned with the bleach
solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.
8. Reassemble the instrument as necessary.

9. Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.
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Procedure for Models with a Dispenser

Perform the Routine Procedure when the Cytation3 is functioning nor-
mally. If you are unable to perform a prime due to a system failure, per-
form the Alternate Procedure described on page 88.

Routine Procedure

If disinfecting with sodium hypochlorite (bleach), be sure to flush repeatedly
with deionized water to remove the bleach. After disinfecting with sodium
hypochlorite, perform the rinse procedure provided on page 87.

If disinfecting with alcohol, do not immediately prime with deionized water,
because the drying effect of the alcohol is an important aspect of its dis-
infectant properties.

Clean Exposed Surfaces

1.
2.

Turn off and unplug the instrument.

Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the
effects of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial
bleach is typically 10.0% NaClO; prepare a 1:20 dilution. Household
bleach is typically 5.0% NaClO; prepare a 1:10 dilution.

SR

Open the plate carrier door and slide out the plate carrier.
Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.
Wipe the plate carrier and the exposed surfaces of the dispenser.

Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and
wipe all surfaces that have been cleaned with the bleach solution or
alcohol.

Use a clean, dry cloth to dry all wet surfaces.

If the dispenser is installed, purge any fluid (see Flush/Purge the Fluid
Path on page 76) and detach the outlet tubes from the instrument. If it is
not installed, attach only the dispenser’s communication cable to the
instrument. Remove the supply bottles and their holders.

Perform the decontamination procedures described below through page
88.
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Decontaminate the Fluid Lines

1. Place a beaker with 20 mL of 0.5% sodium hypochlorite solution or 70%
isopropyl alcohol near SYRINGE 1 on the dispenser.

2. Place the SYRINGE 1 inlet tube in the beaker.

3. If you have not already done so, detach the dispenser’s outlet tubes from
the instrument. Place the ends of the outlet tubes in an empty beaker and
set the beaker next to the dispenser.

4. Launch Genb and from the main screen select System > Instrument
Control, and click the Dispenser tab.

5. Select Dispenser 1, enter a Volume of 5000 pL, and keep the default
dispense Rate.

6. Place the priming plate on the carrier.
7. Run two prime cycles, for a total of 10,000 pL.
8. Wait at least 20 minutes to allow the solution to disinfect the tubing.
9. Remove the inlet tube from the beaker of disinfectant solution.
10. From the Instrument Control dialog, change the Volume to 1000 pL.
11. Run one prime cycle, to flush the disinfectant out of the fluid lines.

12. Empty the beaker containing the outlet tubes. Put the tubes back in the
empty beaker.

13. If sodium hypochlorite (bleach) was used, perform Rinse the Fluid Lines.

Otherwise (or after performing the Rinse procedure), repeat steps 1-13 for
SYRINGE 2/Dispenser 2.

Rinse the Fluid Lines

Perform this procedure only if decontamination was performed using sodium
hypochlorite.

1. Place a beaker containing at least 30 mL of deionized water on the
dispenser.

2. Place the SYRINGE 1 or 2 inlet tube in the beaker.
3. If you have not already done so, place the outlet tubes in an empty beaker.

4. From the Instrument Control dialog, select Dispenser 1 or 2, set the
Volume to 5000 pL, and keep the default dispense Rate.

5. Run five prime cycles, for a total of 25,000 pL.
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Pause for 10 minutes and then run one prime cycle with 5000 pL. This
delay will allow any residual sodium hypochlorite to diffuse into the
solution and be flushed out with the next prime.

Empty the beaker containing the outlet tubes.
Wipe all surfaces with deionized water.

Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.

Clean the Tubing and Injectors

Perform the procedures under Clean the Dispense Tubes and Injectors in
Chapter 5, Preventive Maintenance.

Decontaminate the Tip Priming Trough and Priming Plate

1.
2.

Remove the tip priming trough from the instrument’s microplate carrier.

Wash the tip priming trough and priming plate in hot, soapy water. Use a
small brush or cloth to clean the corners of the trough and plate.

To decontaminate, soak the trough and plate in a container of 0.5% sodium
hypochlorite or 70% isopropyl alcohol for at least 20 minutes.

e If decontaminating in a bleach solution, thoroughly rinse the trough
and plate with DI water.

e If decontaminating with alcohol, let the trough and plate air dry.

Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.

Alternate Procedure

If you are unable to prime the Cytation3 due to a system failure, decontaminate the
instrument and the dispenser as follows:

1.

Perform the procedures under Clean the Dispense Tubes and Injectors
in Chapter 5, Preventive Maintenance.

Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the
effects of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial
bleach is typically 10.0% NaCIO; prepare a 1:20 dilution. House-
hold bleach is typically 5.0% NaClO; prepare a 1:10 dilution.

3. Slide the microplate carrier out of the instrument.
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4. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.
5. Use the cloth to wipe:

o All exterior surfaces of the instrument

o All surfaces of the plate carrier

o The exposed surfaces of the dispenser, including the syringe valves

6. Remove the tubing and the syringes from the dispenser and soak them in
the bleach or alcohol solution. Wait for 20 minutes.

7. Moisten a cloth with DI or distilled water and wipe all surfaces that have
been cleaned with the bleach solution or alcohol.

8. Rinse all tubing and the syringes with DI water.

9. Use aclean, dry cloth to dry all surfaces on the instrument and the
dispenser.

10. Reassemble the dispenser as necessary.

11. Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.

Dispenser Syringe Replacement

Refer to the Preventive Maintenance chapter for cleaning procedures you must
perform regularly and also in the case of poor performance (for example, when
Dispense Accuracy and Precision tests fail). If cleaning the dispenser does not
eliminate performance problems, or if a syringe is obviously leaking, perform these
instructions to replace a faulty syringe. Contact BioTek TAC to order replacement
syringes.

To change a syringe, first use Gen5 to put the syringe in its maintenance position.

Syringe Maintenance Position

Do not change the syringe position or calibrate the dispensers unless
instructed to do so as part of installation, upgrade, or maintenance.

Genb provides access to syringe setup functions for maintenance and calibration
purposes. When a syringe needs to be installed or replaced, it must first be moved
to its “maintenance position.”

1. From the Genb main screen, select System > Instrument Control >
Cytation3 and click the Dispenser tab.
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2. Select the appropriate Dispenser number (1 or 2) associated with the
syringe.

3. Click Maintenance. The syringe plunger will move to its furthest-from-
home position. The syringe can then be disconnected from the drive
bracket and unscrewed from the valve.

Replace the Syringe
After using Genb to move the syringe into its maintenance position:
1. Using your fingers, unscrew the bottom thumbscrew that secures the

syringe, underneath the bracket. Retain this bottom thumbscrew; it is
needed for the replacement syringe.

2. Unscrew the top thumbscrew to disengage the syringe from the valve.

3. Remove the new syringe from its protective box. (The syringe should
already be assembled in one piece; if it is not, see “Install the Dispenser” in
the Installation chapter.

4. Hold the syringe vertically with the threaded end at the top. Screw the top
of the syringe into the bottom of the syringe valve. Finger-tighten only.

5. Carefully pull down the bottom of the syringe until it rests inside the hole
in the bracket.
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6. Pass the thumbscrew (used to hold the old syringe) up through this hole
and thread it into the bottom of the syringe. Hold the syringe from
rotating while tightening the thumbscrew. Finger-tighten only.

7. From the Genb main screen, select System > Instrument Control >
Cytation3. Click the Dispenser tab and click Initialize.
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Instrument Qualification

This chapter contains procedures for qualifying the initial and
ongoing performance of the Cytation3 and the external dis-
pense module (if equipped).
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Instrument Qualification Overview

This chapter contains BioTek Instruments” recommended Installation Qualification
(IQ), Operational Qualification (OQ), and Performance Qualification (PQ)
procedures for all models of the Cytation3 Microplate Reader.

Every Cytation3 reader and external dispense module is fully tested at BioTek prior
to shipment and should operate properly upon initial setup. If you suspect that a
problem occurred during shipment, if you have received the equipment after
returning it to the factory for service, and/or if regulatory requirements dictate
that you qualify the equipment on a routine basis, perform the procedures outlined
in this chapter.

A Product Qualification Package (PN 1220514) for the Cytation3 is avail-
able for purchase. The package contains complete procedures, Gen5
protocols, checklists, and logbooks for performing Installation Qual-
ification, Operational Qualification, Performance Qualification, and Pre-
ventive Maintenance. Contact your local BioTek dealer for more
information.

IQ/0Q/PQ Description

Installation Qualification confirms that the reader and its components have been
supplied as ordered and ensures that they are assembled and configured properly
for your lab environment.

e The recommended IQ procedure consists of setting up the instrument and
its components as described in Chapter 2, Installation, and performing
the System Test. For models with injectors, a quick “Injector Test” is also
performed, to ensure that the dispense module is properly installed and
there are no leaks.

e The IQ procedure should be performed initially (before the reader is used
for the first time).

e The successful completion of the IQ procedure verifies that the instrument
is installed correctly. The Operational Qualification procedure should be
performed immediately following the successful 1Q.

Operational Qualification confirms that the equipment operates according to
specification initially and over time.

e The recommended OQ procedure consists of performing the system test,
Absorbance Plate Test, luminescence test, a series of liquid tests, and, if the
external dispense module is used, the Dispense Accuracy and Precision
Tests.
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e The OQ procedure should be performed initially (before first use) and
then routinely; the recommended interval is annually. It should also be
performed after any major repair or upgrade to the hardware or software.

o Although out-of-tolerance failures will be detected by the OQ tests, results
should be compared with those from the routine Performance
Qualification tests and previous OQ tests to monitor for trends.

e The successful completion of the OQ procedure, in combination with
results that are comparable to previous PQ and OQ tests, confirms that the
equipment is operating according to specification initially and over time.

Performance Qualification confirms that the reader consistently meets the
requirements of the tests performed at your laboratory.

e The recommended PQ procedure consists of performing the System Test,
Absorbance Plate Test, Luminescence test, a series of Liquid Tests, and, if
the external dispense module is used, the Dispense Accuracy and
Precision Tests.

e Your facility’s operating policies may also require that you routinely
perform an actual assay, to confirm that the reader will consistently give
adequate results for the assays to be run on it.

e These tests should be performed routinely; the recommended interval is
monthly or quarterly, depending on the test. This frequency may be
adjusted depending on the trends observed over time.

e The successful completion of the PQ procedure confirms that the
equipment is performing consistently under normal operating conditions.

Recommended Qualification Schedule

This table defines BioTek-recommended intervals for qualification for an
instrument used two to five days a week. The schedule assumes that the Cytation3
is properly maintained as outlined in the Preventive Maintenance section.

The risk and performance factors associated with your assays may require
@ that the Operational and Performance Qualification procedures be performed
more or less frequently than shown here.
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IQ oQ PQ
Tasks/Tests Initially Z':::':;:Yy/ Monthly | Quarterly
All models:
Unpacking, installation, setup, and v
verification
Software Documentation/Verification v v v
ﬁt;)cf;c\a/ca)l:e Wavelengths Table Ver- v v v
System Test v v v
Plate Shaker Test 4
"Run Assay" Test 4
Absorbance capability*:
Absorbance Plate Test v 4
Absorbance Liquid Test 1 v v
Absorbance Liquid Test 3 (optional)
Fluorescence capability*:
Corners, Sensitivity, Linearity Tests v v
Fluorescence Polarization Test 4
Time-Resolved Fluorescence Test v v
Luminescence capability*:
Luminescence Test v v
Dispenser system¥*:
Injection System Test v
Dispense Accuracy and Precision Test v v
Imaging capability*:
Carrier Level Test 4 v
Contrast Test
Auto Focus Test 4 v

* If applicable to your reader model
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System Test

Each time the Cytation3 is turned on, it automatically performs a series of tests on
the reader’s motors, lamp, the PMT, and various subsystems. The duration of this
system test depends on the reader model, and can take a few minutes to complete.
If all tests pass, the microplate carrier is ejected and the green LED on the carrier
switch remains on.

If any test results do not meet the internally coded Failure Mode Effects Analysis
(FMEA) criteria established by BioTek, the reader beeps repeatedly and the red
LED on the carrier switch flashes. If this occurs, press the carrier eject button to
stop the beeping. If necessary, initiate another system test using Gen5 to try to
retrieve an error code from the reader. Refer to Appendix B, Error Codes for
information on error codes and for troubleshooting tips.

If the power-up system test fails, when you initiate a system test using
Gen5, Gen5 displays a message stating that the reader has a pending
system test report. Click OK in the message box to review the report; it
contains information obtained up to the point of the failure.

1. Turn on the reader and launch Genb.

2. If your assays use incubation, we recommend enabling Temperature
Control and allowing the incubator to reach its set point before running
the system test. To access this feature, from the Gen5 main screen, select
System > Instrument Control and click the Pre-Heating tab.

3. Select System > Diagnostics > Run System Test.

If the test fails during execution, a message box appears in the soft-
ware. Close the box; the test report contains the error code that was
generated by the failure.

4. When the test is complete, a dialog appears, requesting additional
information. Enter your user name and other information (if desired) and
then click OK.

5. The results report appears. Scroll down toward the bottom of the report; it
shows either “SYSTEM TEST PASS” or “SYSTEM TEST FAIL *** ERROR
(error code) DETECTED.”

6. Print the report if desired.

o Genb stores the results in a database, so the results can be retrieved at
any time. We recommend that you print and save the reports to
document that the test was performed.
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7. If the test failed, look up the error code in Appendix B, Error Codes to
determine its cause. If the cause is something you can fix, turn off the
reader, fix the problem, and then turn the reader back on and retry the
test.

If the test continues to fail, or if the cause is not something you can fix, contact
BioTek’s Technical Assistance Center.

Absorbance Plate Test

Applies only to models with absorbance capabilities.

This test uses BioTek's Absorbance Test Plate (PN 7260522) to confirm the

mechanical alignment; optical density accuracy, linearity, and repeatability; and
wavelength accuracy of the Cytation3. The Absorbance Test Plate compares the
reader's optical density and wavelength measurements to NIST-traceable values.

An alternate method for confirming accuracy, linearity, and repeat-
ability is Liquid Test 2, described on page 114.

To run this test, you need the BioTek Absorbance Test Plate (PN 7260522), with its
accompanying data sheet.

e The Absorbance OD Standards section contains NIST-traceable standard
OD values for the filters at several different wavelengths. We recommend
testing at six wavelengths —those at or close to the wavelengths used in
your assays.

e The Wavelength Accuracy Standards section contains Expected Peak
wavelength values for the filter in position C6 on the plate. Each value has
a valid test range associated with it. For example, an Expected Peak value
may be 586 nm with tolerance values of -6/+4 (or a test range of 580 to 590
nm). For the Cytation3, use the values in the 2.4 nm Spectral Bandpass
table.

The instructions provided below are guidelines. Refer to the Gen5 Help
system for more information.

Define Absorbance Test Plate Parameters

1. Obtain the certificates that came with the Test Plate.

2. Start Gen5 and from the main screen select System > Diagnostics >
Test Plates > Add/Modify Plates.

3. Click Add. The Absorbance Test Plate dialog appears.
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4. Select the appropriate Plate Type and enter the plate’s serial number.

5. Enter the Last Certification and Next Certification dates from the
calibration sticker on the Test Plate.

6. If the wavelength values in the top row of the grid in Genb are appropriate
for your tests, enter the OD values from the data sheet into the grid. Make
sure you enter the correct value for each well/ wavelength combination.

If you need to change the wavelength values, click Wavelength List.
Click the Gen5 Help button for assistance.

7. Select the number of Peak Wavelength tests to run (up to 4), based on the
number of expected peak wavelength values provided on the certificate.

8. Enter the Expected Peak value(s) from the certificate and set the Test
Range - and + values.

The glass in each test plate is unique. Therefore, the expected
peaks may differ slightly from plate to plate.

o If the C6 filter is Holmium or Erbium glass, the certificate contains
two Spectral Band Pass tables. The Cytation3 has a band pass wider
than 5 nm for wavelengths greater than 285 nm and less than 4 nm
for 230-285 nm. As a results, we recommend you use the expected
peak values in the 5.0 nm table for your tests.

» For the Erbium glass, any peak can be used.

» For the Holmium glass, use the expected peak values closest
to 242, 279, 362, 417, and 538 nm. For example, if your
certificate looks like the one below, you might choose to run
the test at four of the five highlighted Expected Peak/Test
Range combinations:
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2.4 nm Spectral Band Pass 5.0 nm Spectral Band Pass
Expected Peak | Test Range Expected Peak |Test Range
241 =5+5 242 -5+5

278 -6+4 279 -6+4

287 -4+6 288 -4+6

334 -5+5 334 -5+5

360 =5+5 362 -5+5

417 -5+5 417 -5+5

484 -5+5 485 -5+5

537 -5+5 538 -5+5

642 -5+5 643 -5+5

o If your Cob filter is Didymium glass, a single peak wavelength value
is provided. Enter this value and set the Test Range - and + values
so the range displayed in parentheses is 580 to 590, as shown here:

Peak wavelenagth kests: I 1 - I

Expected Peak - Tesk Range  +

caE s =l [+ =l {580 to 590)

9. Review all the values you entered. Click OK to save the data.

The information you just entered is available on Gen5 each time the Absorbance
Plate Test is performed. It may need to be modified after the annual recertification
of your test plate.

Run the Absorbance Plate Test

1. From the Genb main screen, select System > Diagnostics > Test
Plates > Run. If prompted, select the desired Test Plate and click OK.

2. When the Absorbance Test Plate Options dialog appears, select Perform
Peak Wavelength Test if it is not already selected.

3. Highlight the wavelength(s) to be included in this test.

Select only those wavelengths most appropriate for your use of the
reader.
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4. (Optional) Enter any Comments.
5. Click Start Test.

6. Place the Test Plate in the microplate carrier so that well Al is in the right-
rear corner of the carrier.

7. Click OK to run the test.

8. When the test is completed, the results report appears. Scroll through the
report; every result should show “PASS”. See Results and
Troubleshooting Tips for information on results and troubleshooting tips
in the event of failures.

Genb stores the results in a database; they can be retrieved any time. We rec-
ommend you print and save the report to document that the test was performed.

Results and Troubleshooting Tips

The Absorbance Test Plate Report contains results for the following:

o Peak Absorbance: When the test is performed, the C6 filter is scanned at
the test range(s) defined by the user in the Absorbance Test Plate dialog.
To verify wavelength accuracy, the wavelength of the maximum
absorbance is compared with the peak wavelength value entered in the
software, which comes from the Peak Wavelength Certificate supplied
with the Test Plate. The accuracy of the wavelength should be + 3 nm (+ 2
nm instrument, + 1 nm filter allowance). If the reader fails this test:

= Make sure the information entered into Gen5 matches the Test
Plate’s Peak Wavelength Certificate.

= Verify that the Test Plate has a filter in location C6. (Test Plates with
the part number 9000547 do not have this filter.)

» Check the C6 filter to make sure it is clean. If needed, clean it with
lens paper. Do not remove the filter from the Test Plate, and do not
use alcohol or other cleaning agents.

= Verify that the Test Plate is within its calibration certification period.
If it is out of date, contact BioTek to schedule a recertification.

= Check the microplate carrier to ensure it is clear of debris.

o Alignment: This test measures the alignment of the microplate carrier
with the optical path. A reading greater than 0.015 OD represents an out-
of-alignment condition. Wells A1, A12, H1, and H12 are the only valid
alignment holes for the reader on the PN 7260522 Test Plate.

If the reader fails this test:

= Ensure that the Test Plate is correctly seated in the microplate
carrier.
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= Check the four alignment holes (A1, A12, H1, H12) to ensure they
are clear of debris.

= Check the microplate carrier to ensure it is clear of debris.

e Accuracy: Accuracy is a measure of the optical density of Test Plate wells
C1, D4, E2, F5, G3, and H6 as compared with known standard values
contained in the Standards Certificate that accompanies each Test Plate.

If the reader fails this test:
» Verify that the filter calibration values entered in Genb are the same
as those on the Test Plate’s Standards Certificate.

= Check the filters on the Test Plate to ensure they are clean. If
necessary, clean them with lens paper. Do not remove the filters
from the test plate, and do not use alcohol or other cleaning agents.

= Verify that the Test Plate is within its calibration certification period.
If it is out of date, contact BioTek to schedule a recertification.

o Repeatability: Repeatability is a measure of the instrument’s ability to read
the same well with minimum variation between two reads with the well in
the same location. If the reader fails this test:

= Check the filters on the Test Plate to ensure there is no debris that
may have shifted between readings and caused changes.

= Check the microplate carrier to ensure it is clear of debris.

Linearity of the optical density readings is confirmed by default if the optical
density readings are accurate. To further verify this, you can perform a
regression analysis on the Test Plate OD values in a spreadsheet program
such as Microsoft Excel. An R Squared value of at least 0.990 is expected.

Imaging Test Procedures

Genb provides qualification procedures for testing the level position of the carrier
and the reliability of the Auto Focus feature.

Importing the Plate Maps for Imaging Test Procedures

The qualification protocols require the use of the Tilt/Contrast jig, available from
BioTek (PN 1222520). To use the jig, you must import the following plate maps that
are installed with Gen5: 1222520.ptf and 1222520_AF.ptf.

1. In Genb, click System > Plate Types, then click Import.

2. Navigate to the location where your Gen5 installation files are store, such
as C:\ Program Files\ BioTek\Genb v2.x.
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3. Select the file 1222520.ptf, then click Open. The plate map is added to
your Plate Type database.

4. Repeat steps 1 through 3 to import the 1222520 _AF.ptf plate map.

Required Materials
o Tilt/Contrast jig, PN 1222520
o Plate map files, 1222520.ptf and 1222520_AF.ptf
o Genb protocols described on page 105

e <x>X_CarrierLevel.prt

o AF_Reliability_<x>X.prt

« DAPI 377/447 cube (PN 1225100)

Carrier Level Test

This test determines how level the carrier is in relation to the imaging system. You
will run this test using the lowest-power objective you have available (10X or lower
is preferred).

Procedure

1. Place the Tilt/ Contrast jig on the carrier with well Al facing up in the
right-rear corner of the carrier.

2. If you have not already done so, create the protocol described on page 105

3. Create a new experiment in Gen5 using the <x>X_CarrierLevel.prt

protocol, with <x> representing the lowest-power objective you have
available.

4. Click Plate > Read Plate, then click OK.
5. When prompted by Genb, rotate the jig 180 degrees in the carrier.

6. When the read is finished, save the experiment, and analyze the results as
described below.

Analyze the Results

1. Calculate the Mean focus height for each set of ten reads in the "Normal"
position in wells A1, A12, H1, and H12.

2. Calculate the Mean focus height for each set of ten reads in the
"Turnaround" position in wells A1, A12, H1, and H12.
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3. Compare the Mean values for each well in its Normal and Turnaround
positions by performing these calculations:

a. -1* (A1 Normal Mean - H12 Turnaround Mean)

b. -1*(H12 Normal Mean - A1 Turnaround Mean)

C. -1*(A12 Normal Mean - H1 Turnaround Mean)

d. -1*(H1Normal Mean - A12 Turnaround Mean)
4. For A1/H12:

e Calculate the Mean Delta (um): (step a results + step b result) / 2
e Calculate the Carrier Tilt: Mean Delta / 25400 pm
e The Carrier Tilt must be less than 0.004" to Pass.

5. For A12/H1:

e Calculate the Mean Delta (um): (step c results + stepd result)/ 2
e Calculate the Carrier Tilt: Mean Delta/ 25400 pm

e The Carrier Tilt must be less than 0.004" to Pass.

AutoFocus Test

The AutoFocus test confirms the imaging system's ability to repeatedly focus on a
known target.

You must run this test for each objective you have onsite.

1. Place the Tilt/Contrast jig on the carrier with well Al facing up in the
right-rear corner of the carrier.

2. If you have not already done so, create the protocol described on page 1.

3. Create a new experiment in Gen5 using the AF_Reliability_<x>.prt
protocol, with <x> representing the objective you are using. for each test.

4. Click Plate > Read Plate, then click OK.

5. When the read is finished, save the experiment, and analyze the results as
described below.
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Analyze the Results

1. For the set of 100 data points in well F7, calculate the Mean, Slope,

and Intercept. (If using Microsoft Excel, use the SLOPE and INTERCEPT
functions.)

2. For each data point, calculate the Residual:

[value]-((Slope*[data point sequence #])+Intercept)

Example: 325-((0*1)_325.9)=-0.9 Residual for data point #1

3. For each data point, compare the absolute value of the Residual with the
objective's Limit (um) value in the chart below (e.g., 95.4 for 2.5X). If the
absolute value of the Residual is greater than the Limit, note "1" for that
data point; otherwise, note "0".

I?ieel:l’ctzlhool:jective NA |e(um) |A(nm) |DOF (um) | Limit (um)
20 0.45 |6.45 377 2.6 5.2

10 0.3 |6.45 377 6.3 12.7

4 0.13 |6.45 377 34.7 69.4

2.5 0.12 |6.45 377 47.7 95.4

2 0.05 |6.45 377 215.3 430.6

. After conducting this comparison for all 100 data points, add up the

notations and divide the sum by 100; this is the Measured Autofocus
Failure Rate. The Measured Autofocus Failure Rate must be < 1.0% to Pass.

. In the Genb5 plate matrix, select the FM Ratio [0:DAPI 377,447] data set.

Refer to the chart below for passing criteria for the value displayed in well
F7.

Objective FM Ratio must be
2X > 2

2.5X > 1.4

4X > 25

10X > 50

20X > 75

Cytation3 Operator's Manual



106 | Chapter 7: Instrument Qualification

Troubleshooting
If any of the imaging tests fail:

o Ensure the Tilt/Contrast jig is clean. You can use canned air to blow any
debris from the surface of the jig.

o Ensure your objectives are clean. See Clean the Objectives on page 75.

 If your imaging tests still fail after cleaning the jig and the objectives,
contact BioTek TAC.

Imaging Protocols

The information in the following tables represents the recommended reading
parameters. It is possible that your tests will require modifications to some of these
parameters, such as the Plate Type.

The Plate Type setting in each Gen5 protocol should match the plate
you are actually using.

Carrier Level Tests

2X_CarrierLevel.prt, 2.5X_CarrierLevel.prt, 4X_CarrierLevel.prt, 10X_Car-
rierLevel.prt

Parameter Default Setting
Detection Method: Imaging

Read Type: Endpoint

Plate Type: 1222520 (Tilt/Contrast jig)

Read Steps 1-4

Run Time: 1:12

Kinetic Step: Interval: 8 seconds
Reads: 10
Objective: 2X/2.5X/4X/10X

Read Step 1: Al
Read Step 2: A12

Read Wells: Read Step 3: H1
Read Step 4: H12
Color Channel: Bright Field
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Parameter Default Setting
LED: 5

Exposure: Integration time: 50
Gain: 0

Focus method: Auto focus without optional
scan

Minimum focus metric ratio: 3

Scan distance: 600

Scan increment: 30

Minimum focus delta: 8

% of capture exposure for focus: 100
Offset from bottom of well: 0

Auto Focus Options:

CV Threshold: 0.01

Vibration Detection Options:
Images to average: 1

Horizontal offset from center of

well: 0

Vertical offset from center of well: |0

Single image per well: Selected

Delay after plate movement: 0 msec

After Read Step 4

Plate Out, In "Turn jig around"

Read Steps 5-8

Run Time: 1:12

Kinetic Step: Interval: 8 seconds
Reads: 10
Objective: 2X/2.5X/4X/10X

Read Step 5: Al
Read Step 6: A12

Read Wells: Read Step 7: H1
Read Step 8: H12

Color Channel: Bright Field
LED: 5

Exposure: Integration time: 50
Gain: 0
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Parameter Default Setting

Focus method: Auto focus without optional
scan

Minimum focus metric ratio: 3

Scan distance: 600

Scan increment: 30

Minimum focus delta: 8

% of capture exposure for focus: 100
Offset from bottom of well: 0

Auto Focus Options:

CV Threshold: 0.01

Vibration Detection Options:
Images to average: 1

Horizontal offset from center of

well: 0
Vertical offset from center of well: |0

Single image per well: Selected
Delay after plate movement: 0 msec

AutoFocus Reliability Tests

AF_Reliability_2X.prt, AF_Reliability_2.5X.prt

Parameter Default Setting

Detection Method: Imaging

Read Type: Endpoint

Plate Type: 1222520_AF

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads:
100

Objective: 2X/2.5X

Read Wells: F7

Color Channel: DAPI 377, 447

Exposure: Auto
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Parameter

Default Setting

Auto-Focus Options:

Focus method: Auto focus with optional scan
Minimum focus metric ratio: 3

Scan distance: 600

Scan increment: 30

Minimum focus delta: 8

% of capture exposure for focus: 75

Offset from bottom of well: -50

Auto-Exposure Options:

Target exposure %: 75
Skip %: 0.1
Integration threshold: 100

Vibration Detection Options:

CV Threshold: 0.01
Images to average: 5

Horizontal offset from center of

well: 0
Vertical offset from center of well: | 0
Single image per well Enabled
Delay after plate movement: 0 msec

AF_Reliability_4X.prt

Parameter Default Setting

Detection Method: Imaging

Read Type: Endpoint

Plate Type: 1222520_AF

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads:
100

Objective: 4X

Read Wells: F7

Color Channel:

DAPI 377, 447

Exposure:

Auto
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Parameter

Default Setting

Auto-Focus Options:

Focus method: Auto focus with optional scan
Minimum focus metric ratio: 25

Scan distance: 600

Scan increment: 30

Minimum focus delta: 8

% of capture exposure for focus: 75

Offset from bottom of well: -50

Auto-Exposure Options:

Target exposure %: 75
Skip %: 0.1
Integration threshold: 100

Vibration Detection Options:

CV Threshold: 0.01
Images to average: 5

Horizontal offset from center of

well: 0
Vertical offset from center of well: | 0
Single image per well Enabled
Delay after plate movement: 0 msec

AF_Reliability_10X.prt

Parameter Default Setting

Detection Method: Imaging

Read Type: Endpoint

Plate Type: 1222520_AF

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads:
100

Objective: 10X

Read Wells: F7

Color Channel:

DAPI 377, 447

Exposure:

Auto
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Parameter

Default Setting

Auto-Focus Options:

Focus method: Auto focus with optional scan
Minimum focus metric ratio: 50

Scan distance: 600

Scan increment: 30

Minimum focus delta: 8

% of capture exposure for focus: 75

Offset from bottom of well: -50

Auto-Exposure Options:

Target exposure %: 75
Skip %: 0.1
Integration threshold: 100

Vibration Detection Options:

CV Threshold: 0.01
Images to average: 5

Horizontal offset from center of

well: 0
Vertical offset from center of well: | 0
Single image per well Enabled
Delay after plate movement: 0 msec

AF_Reliability_20X.prt

Parameter Default Setting

Detection Method: Imaging

Read Type: Endpoint

Plate Type: 1222520_AF

Kinetic Step: Run Time: 19:59, Interval: 12 seconds, Reads:
100

Objective: 20X

Read Wells: F7

Color Channel:

DAPI 377, 447

Exposure:

Auto
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Parameter

Default Setting

Auto-Focus Options:

Focus method: Auto focus with optional scan
Minimum focus metric ratio: 75

Scan distance: 600

Scan increment: 30

Minimum focus delta: 8

% of capture exposure for focus: 75

Offset from bottom of well: -50

Auto-Exposure Options:

Target exposure %: 75
Skip %: 0.1
Integration threshold: 100

Vibration Detection Options:

CV Threshold: 0.01
Images to average: 5

Horizontal offset from center of

well: 0
Vertical offset from center of well: | 0
Single image per well Enabled
Delay after plate movement: 0 msec

Absorbance Liquid Tests

Conducting liquid tests confirms the reader’s ability to perform to specification
with liquid samples. Liquid testing differs from testing with the Absorbance Test
Plate in that liquid in the wells has a meniscus, whereas the Test Plate’s neutral
density glass filters do not. The optics characteristics may differ in these two cases,
thus alerting the operator to different types of problems.

Absorbance Liquid Test 1

Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when
a solution is used in the microplate. If these tests pass, then the lens placement and
optical system cleanliness are proven.

Materials

Manufacturer part numbers are subject to change over time.

o New 96-well, clear, flat-bottom microplate (Corning Costar #3590

recommended)
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e Stock Solution A or B, which may be formulated by diluting a dye solution
available from BioTek (A) or from the ingredients listed below (B).

Solution A
e BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL)
e Deionized water
e 5-mL Class A volumetric pipette
e 100-mL volumetric flask

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a 100-mL
volumetric flask.

2. Add 95 mL of DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 pL in a flat-bottom microwell.

Solution B

e Deionized water
e FD&C Yellow No. 5 dye powder (typically 90% pure)

o Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting
agent (PN 7773002) (a 10% Tween solution)

e Precision balance with capacity of 100 g minimum and readability of 0.001
&
o Weigh boat

o 1-liter volumetric flask

Weigh out 0.092 g of FD&C Yellow No. 5 dye powder into a weigh boat.
Rinse the contents into a 1-liter volumetric flask.

Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent.

L A

Fill to 1 liter with DI water; cap and shake well. The solution should
measure approximately 2.000 OD when using 200 uL in a flat-bottom
microwell.

Prepare the Plate

Be sure to use a new microplate, because fingerprints or scratches may
cause variations in readings.
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1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2
dilution using deionized water (one part stock, one part deionized water;
the resulting solution is a 1:2 dilution).

2. Pipette 200 puL of the concentrated solution (A or B) into the first column of
wells in the microplate.

3. Pipette 200 pL of the diluted solution into the second column of wells.

After pipetting the diluted test solution into the microplate and before
reading the plate, we strongly recommend shaking the plate for four
minutes. This will allow any air bubbles in the solution to settle and the
meniscus to stabilize. Alternatively, wait 20 minutes after pipetting the
test solution before reading the plate.

Read the Plate

1. Using Gen5, read the microplate five times at 405 nm using the Normal
read mode, single wavelength, no blanking. Save the data after each read
(“Normal” plate position).

2. Without delay, rotate the microplate 180 degrees so that well Al is in the
“H12” position. Read the plate five more times, saving the data after each
read (“Turnaround” plate position).

3. Print out the ten sets of raw data, or export them to an Excel spreadsheet.

The spreadsheet reports pass or fail for the tests performed. See the cal-
culation descriptions below and Section 6, System Description for trou-
bleshooting tips.

Analyze the Results

1. The plate is read five times in the “Normal” position at 405 nm. Calculate
the Mean OD and Standard Deviation of those five reads for each well in
columns 1 and 2.

2. For each well in columns 1 and 2, calculate the Allowed Deviation using
the repeatability specification for a 96-well plate: + 1% + 0.005 OD from
0.000 to 2.000 OD (Mean * 0.010 + 0.005). For each well, its standard
deviation should be less than its allowed deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a mean of 0.8004 and a standard deviation of 0.0018. The mean multiplied
by 1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013;
this is the allowed deviation for well Al. Since the standard deviation for
well Al is less than 0.013, the well meets the test criteria.

BioTek Instruments, Inc.



Absorbance Liquid Tests | 115

3. The plate is read five times in the “Turnaround” position at 405 nm.
Calculate the Mean OD of those reads for each well in columns 11 and 12.

4. Perform a mathematical comparison of the Mean values for each microwell
in its Normal and Turnaround positions (that is, compare Al to H12, A2 to
H11, Bl to G12,... H2 to Al11). To pass the test, the differences in the
compared mean values must be within the accuracy specification for a 96-
well microplate: + 1.0% + 0.010 OD from 0.000 to 2.000 OD.

Example: If the mean value for well Al in the Normal position is 1.902 with a
specified accuracy of +2.0% * 0.010 OD, then the expected range for the
mean of the well in its Turnaround (H12) position is 1.873 to 1.931 OD. 1.902
x 0.010 + 0.010 = 0.029; 1.902 - 0.029 = 1.873; 1.902 + 0.029 = 1.931.

Repeatability Specification:

+1.0% £ 0.005 OD from 0.000 to 2.000 OD

£ 3.0% £ 0.005 OD from 2.000 OD to 2.500 OD
Accuracy Specification:

1£1.0% + 0.010 OD from 0.000 to 2.000 OD
1 3.0% £ 0.010 OD from 2.000 OD to 2.500 OD

Absorbance Liquid Test 2

The recommended method for testing the instrument’s alignment, repeatability,
and accuracy is to use the Absorbance Test Plate (see page 63). If the Test Plate is
not available, however, Liquid Test 2 can be used for these tests.

Materials

o Anew 96-well, clear, flat-bottom microplate (Corning Costar #3590 is
recommended)

o Ten test tubes, numbered consecutively, set up in a rack
o Calibrated hand pipette (Class A volumetric pipette recommended)
e Solution A or B (see the instructions for Liquid Test 1)

e A 0.05% solution of deionized water and Tween 20

Prepare the Dilutions

Create a percentage dilution series, beginning with 100% of the original
concentrated stock solution (A or B) in the first tube, 90% of the original solution in
the second tube, 80% in the third tube, all the way to 10% in the tenth tube. Dilute
using the 0.05% solution of deionized water and Tween 20. This solution can also
be made by diluting the BioTek wetting agent 200:1.
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Test Tube Dilutions for Liquid Test 2

Tube Number i1 2 3 4 |5 |6 (7 8 |9 |10

VqumeofOrlglnaIConcentrated 20 |18 |16 114 |12 |10 |8 6 |a >
Solution (mL)

o :
E/nciltj)meofo.OS/oTweenSolutlon 0 5 4 6 8 10 112 114 |16 |18

Absorbance expected if original

solution is 2.0 at 200 L 20(1.8(1.6(1.4|1.2|1.0(/0.8(0.6|0.4|0.2

The choice of dilutions and the absorbance of the original solution can
be varied. Use this table as a model for calculating the expected absorb-

ances of a series of dilutions, given a different absorbance of the orig-
inal solution.

Prepare the Plate

o Pipette 200 uL of the concentrated solution from Tube 1 into each well of
the first column, Al to H1, of a new flat-bottom microplate.

o Pipette 200 uL from each of the remaining tubes into the wells of the
corresponding column of the microplate (Tube 2 into wells A2 to H2, Tube
3 into wells A3 to H3, and so on).

Linearity and Repeatability Tests

1. Using Gen5, read the microplate prepared above five times using Normal
mode, dual wavelength at 450/630 nm. Save the data after each read.

Do not discard the plate; you will use it for the Alignment test.

2. Print out the five sets of Delta OD data, or export them to an Excel
spreadsheet.

3. Calculate the results for Linearity:

o Calculate the mean absorbance for each well, and average the means
for each concentration.

o Perform a regression analysis on the data to determine if there is
adequate linearity.

Since it is somewhat difficult to achieve high pipetting accuracy when con-

ducting linear dilutions, an R Square value of at least 0.99 is considered
adequate.
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4. Calculate the results for Repeatability:

o Calculate the mean and standard deviation for the five readings taken
in Step 1 at each concentration. Only one row of data needs to be
analyzed.

o For each mean below 2.000 OD, calculate the allowed deviation using
the repeatability specification for a 96-well plate of +1.0% + 0.005 OD.
If above 2.000 OD, apply the + 3.0% * 0.005 specification.

o The standard deviation for each set of readings should be less than
the allowed deviation.

Example: Absorbance readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will
result in a mean of 1.951, and a standard deviation of 0.0026. The mean
(1.951) multiplied by 1.0% (1.951 x 0.010) = 0.0195, which, when added to the
0.005 (0.0195 + 0.005) = 0.0245 OD, which is the allowed deviation. Since the
standard deviation is less than this value, the reader meets the test criteria.

Repeatability Specification:

+1.0% £ 0.005 OD from 0.000 to 2.000 OD
£ 3.0% £ 0.005 OD from 2.000 to 2.500 OD

Alignment Test

1. Using the plate prepared for the Linearity Test on the previous page,
conduct a Turnaround test by reading the plate five times with the Al well
in the H12 position. Save the data after each read.

This test results in values for the four corner wells that can be used to deter-
mine alighment.

2. Calculate the means of the wells Al and H1 in the Normal plate position
(data from Linearity Test) and in the Turnaround position (from Step 1).

3. Compare the mean reading for well Al to its mean reading when in the
H12 position. Next, compare the mean values for the H1 well to the same
well in the A12 position. The difference in the values for any two
corresponding wells should be within the accuracy specification for the
instrument.

Example: If the mean of well Al in the normal position is 1.902, where the
specified accuracy is + 1.0% + 0.010 OD, then the expected range for the
mean of the same well in the H12 position is 1.873 to 1.931 OD. (1.902 x 1.0%
= (.019 + 0.010 = 0.029, which is added to and subtracted from 1.902 for the
range.)

If the four corner wells are within the accuracy range, the reader is in align-
ment.

Accuracy Specification:
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+1.0% £ 0.010 OD from 0.000 to 2.000 OD
1 3.0% £ 0.010 OD from 2.000 to 2.500 OD

Absorbance Liquid Test 3

This test verifies operation of the reader at 340 nm and is provided for sites
requiring proof of linearity at wavelengths lower than those attainable with the
Absorbance Test Plate. This test is optional because the reader has good “front
end” linearity throughout its wavelength range.

Materials

Manufacturer part numbers are subject to change.

o New 96-well, clear, flat-bottom microplate (Corning Costar #3590
recommended)

o Calibrated hand pipette(s)
e Beakers and graduated cylinder
e Precision balance with readability to 0.01 g

o Buffer solution described below

Buffer Solution
e Deionized water

e Phosphate-Buffered Saline (PBS), pH 7.2-7.6, Sigma tablets, #P4417 (or
equivalent)

e -NADH Powder (pB-Nicotinamide Adenine Dinucleotide, Reduced Form)
Sigma bulk catalog number N 8129, or preweighed 10-mg vials, Sigma
number N6785-10VL (or BioTek PN 98233). Store the powder according to
the guidelines on its packaging.

1. Prepare a PBS solution from the Sigma tablets.

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the p-NADH
powder and mix thoroughly. This is the 100% Test Solution.

3. (Optional) Read a 150-pL sample of the solution at 340 nm; it should be
within 0.700 to 1.000 OD. If low, adjust up by adding more powder. Do not
adjust if slightly high.
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Prepare the Plate

1.

Prepare the 75% Test Solution by mixing 15 mL of the 100% Test Solution
with 5 mL of the PBS Solution.

Prepare the 50% Test Solution by mixing 10 mL of the 100% Test Solution
with 10 mL of the PBS Solution.

Carefully pipette the three solutions into a new 96-well microplate:

e 150 pL of the 100% Test Solution into all wells of columns 1 and 2
e 150 uL of the 75% Test Solution into all wells of columns 3 and 4

e 150 uL of the 50% Test Solution into all wells of column 5 and 6

Read the Plate

1.

Using Gen5, read the microplate five times using Normal mode, single
wavelength at 340 nm, no blanking. Save the data after each read.

Print out the five sets of raw data, or export them to an Excel spreadsheet.

The spreadsheet reports pass or fail for the tests performed. See the cal-
culation descriptions below and Section 6, System Description for trou-
bleshooting tips.

Analyze the Results

The plate is read five times at 340 nm.

1.

For each well, calculate the Mean OD and Standard Deviation of the five
readings.

For each mean calculated in step 1, calculate the allowed deviation using
the repeatability specification for a 96-well plate: £ 1% + 0.005 OD from
0.000 to 2.000 OD (Mean x 0.010 + 0.005). For each well, its standard
deviation should be less than its allowed deviation.

Example: Five readings in well Al of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a mean of 0.8004 and a standard deviation of 0.0018. The mean multiplied
by 1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013;
this is the allowed deviation for well Al. Since the standard deviation for
well Al is less than 0.013, the well meets the test criteria.

Calculate the results for Linearity:

o For each of the three Test Solutions, calculate the average Mean OD
for the wells containing that solution (mean of wells Al to H2, A3 to
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H4, and A5 to Hb6).

o Perform aregression analysis on the data to determine if there is
adequate linearity. The three average Mean OD values are the “Y”

values. The solution concentrations are the “X” values (1.00, 0.75,
0.50).

Since it is somewhat difficult to achieve high pipetting accuracy when con-
ducting linear dilutions, an R Square value of at least 0.99 is considered
adequate.

Repeatability Specification:

1 1.0% £ 0.005 OD from 0.000 to 2.000 OD
1 3.0% £ 0.005 OD from 2.000 OD to 2.500 OD

Fluorescence Liquid Tests

Required Materials

Microplates should be perfectly clean and free from dust or bottom
scratches. Use new microplates from sealed packages.

Manufacturer part numbers are subject to change.

All Tests:
e Deionized or distilled water
e Various beakers, graduated cylinders, and pipettes
e 95% ethanol (for cleaning clear-bottom plates)
e Aluminum foil
e (Optional, but recommended) 0.45-micron filter
e (Optional) Black polyethylene bag(s) to temporarily store plate(s)

e Genb protocols listed in the next table and described starting on page 122
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For the Filter-Based Fluorescence System

CYT3_FI_T_SF.prt

Corners, Sensitivity, and Linearity tests, using the top
optics

CYT3_FI_T_MUB.prt

Alternative top optics test, using methylumbelliferone

CYT3_FP.prt

Fluorescence Polarization test

CYT3_FIFP_T.prt

Combination of Corners, Sensitivity, and Linearity tests
and the Fluorescence Polarization test, using the top
optics

CYT3_TRF.prt

Time-Resolved Fluorescence test

For the Monochromator-Based Fluorescence System

CYT3_M_FI_T_SF.prt

Corners, Sensitivity, and Linearity tests, using the Top
optics

CYT3_M_FI_B_SF.prt

Corners, Sensitivity, and Linearity tests, using the Bot-
tom optics

CYT3_M_FI_T_MUB.prt

Alternative top optics test, using methylumbelliferone

Filter Set Setup

Before using the filter-based fluorescence test protocols, create the applicable filter
sets shown below in Genb ("Green" is used for sodium fluorescein tests, "Blue" for

Filter Set 1 Filter Set 1
Filter SetName | Green ] Filter SetMame | Blue fi
Wavelength [ Bandwidth Wavelength [ Bandwidth
Excitation [BandPass v || 485 | [ 20 | Excitation BandPass w|[ 30 | [ 40 |
Mirror Dichroic \.f.l Top 510 nm Mirrar éDidvDic W | Top 400 nm
Ex (Min/Max) Em {MinMax) Ex {Min/ Mz} Em {Min/Max}
(440 [ 505 | [515 [ 6% | [320][ 330 ] [410][s00]
Wavelength [ Bandwidth Wavelength / Bandwidth
Emission |Band Pass \_f! | 528 ! I 20 ! Emission éBand Pass Ml | 460 _I i_ 40 _I
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Filter Set 1

Fiter Setfame | TRF

Wavelength / Bandwidth
Excitation BandPass v || 30 | | 40 |
Mirror ElDidnroic v Top 400 nm
Ex (MinMan) Em (Min/Max)
[320 ][ 30| [410][s00]
Wavelength | Bandwidth
Emission leand Pass | 620 | ' a0 |

Corners/Sensitivity/Linearity Tests

Flugrescence Polarization Cube

Filter Set Mame

Excitation

MMirror

Emission

|Band Pass |» 528 20

Filter Set 1

Wavelength [ Bandwidth

[BandPass »|| 485 | [ 20 |

|Dichroic % |  Top 510nm
Ex (Min/Manc) Em (Min/Manc)

505 515 || 640
Wavelength f Bandwidth

BioTek offers a liquid test kit (PN 7160010) containing the microplates
and solutions used in all (SF/MUB/Eu) fluorescence liquid test pro-
cedures. Kits for each individual procedure are also available; see the
Optional Accessories section in the Introduction chapter. Sodium
Fluorescein Test Kit PN 7160013 contains the buffer and the SF already

pre-diluted.

Manufacturer part numbers are subject to change.

Methylumbelliferone can be used as an alternative or supplemental

method for performing these tests. See page 139.

Buffer:

» NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g.,
Fisher-Scientific 1 L Sodium Borate Mfr. #159532, or equivalent), or

» Phosphate-Buffered Saline (PBS), pH 7.2-7.6 (e.g., Sigma tablets,
Mfr. #P4417, or equivalent) and pH meter or pH indicator strips

with pH range 4 to 10

e Sodium Fluorescein Powder (1-mg vial, BioTek PN 98155)

 If testing both Top and Bottom optics (mono-based fluorescence only):
A new, clean 96-well glass-bottom Greiner SensoPlate (Mfr. #655892); or a
clean Hellma Quartz 96-well titration plate (Mfr. #730.009.QG); or

equivalent

o If testing the Top optics only: A new, clean 96-well solid black
microplate, such as Corning Costar #3915, or equivalent
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o Excitation filter 485/20 nm installed
e Emission filter 528 /20 nm installed

e 510-nm dichroic mirror installed

Fluorescence Polarization (FP) Test

e A new, clean, 96-well solid black microplate, such as Corning Costar #3915.
A Greiner SensoPlate can also be used.

The FP Test can be performed in conjunction with the top Corn-
ers/Sensitivity/Linearity Tests, in the same microplate.

e The recommended test solutions are available from Invitrogen Corporation
in their “FP One-Step Reference Kit” (PN P3088) or from BioTek (PN
7160014). This kit includes:

s (Green) Polarization Reference Buffer, 15 mL
» Green Low Polarization Reference, 4 mL

» Green High Polarization Reference, 4 mL

The kit also includes two red polarization solutions; these are not used.

e Excitation filter 485/20 nm installed
e Emission filter 528 /20 nm installed

e 510-nm dichroic mirror and polarizers installed

Time-Resolved Fluorescence (TRF) Test

BioTek offers a pre-configured qualification TRF filter cube for purchase.
Contact BioTek Customer Care and ask about part number 8040555.

e 15-mL conical-bottom, polypropylene sample tube

Excitation filter 360/40 nm installed

Emission filter 620/40 nm installed

400-nm dichroic mirror installed
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e A new, clean 96-well solid white microplate, such as Corning Costar #3912

e The recommended test solution (FluoSpheres carboxylate-modified
microspheres, 0.2 pm europium luminescent, 2 pL) is available from
Invitrogen Corporation (PN F20881) or from BioTek (PN 7160011)

Fluorescence Test Solutions

Corners/Sensitivity/Linearity Tests

If using BioTek’s sodium fluorescein powder (PN 98155), be sure to hold the
vial upright and open it carefully; the material may be concentrated at the
top. If a centrifuge is available, spin down the tube before opening.

When diluting the sodium fluorescein powder in buffer, it takes time for the
@ powder to completely dissolve. Allow the solution to dissolve for five minutes,
with intermittent vortexing, before preparing the titration dyes.

Wrap the vial containing the stock solution in foil to prevent exposure to light.
Discard unused solution after seven days. Discard any open, unused buffer
solution after seven days.

1. The Sodium Borate solution does not require further preparation; proceed
to step 2. If you are using PBS, prepare the solution:

e (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL
of deionized or distilled water.

o Follow the manufacturer’s instructions on the PBS packaging to
create 200 mL, dissolving the necessary amount of PBS into the
filtered water.

e Stir the solution (preferably using a stir table) until the PBS is
completely dissolved.

e Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the sodium fluorescein stock solution:

e Add 2.0 mL of the buffer solution to the 1 mg Sodium Fluorescein
(SF) vial. This yields a 1.3288 mM stock solution.

e Ensure that the dye has completely dissolved and is well mixed.

3. Carefully prepare the dilutions. Label each with “SF” and the
concentration:
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Mix This SF Solution: (With Buffer: To Make:

0.53 mLof_1.3288 mM 13.47 mL 50.2 uM

stock solution

110 yLof 50.2 uM SF [13.89 mL 400 nM

110 pL of 50.2 uM SF 10.5 mL 100 nM

0.46 mL of 100 nM SF 13.54 mL 3.3 nM Corners Test
4.24mLof 3.3nMSF  |9.76 mL 1nM i:;’tss’“‘”ty/“”ea”ty

Fluorescence Polarization (FP) Test

As described in Fluorescence Polarization (FP) Tests, the recommended test
solutions are available from Invitrogen Corporation or from BioTek. They do not
require additional preparation.

Time-Resolved Fluorescence (TRF) Test

As described in Time-Resolved Fluorescence (TRF) Tests, the recommended test
solutions are available from Invitrogen Corporation or from BioTek.

Shake the FluoSpheres container vigorously for 30 seconds prior to
pipetting. Alternatively, sonicate or vortex the container.

Mix 10 pL of FluoSpheres with 10 mL of deionized water, in a 15 mL

conical-bottom, polypropylene sample tube. This yields a 20 nM equivalent
suspension.

Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively,
sonicate or vortex the container.

Mix 10 pL of 20 nM suspension with 10 mL of deionized water, in a 15 mL
conical-bottom, polypropylene sample tube. This yields a 20 pM equivalent
suspension.

Refrigerate any unused portions of the FluoSpheres. The temperature
must be between +2°C to +6°C.

The prepared TRF plate can be kept for a maximum of seven days, if
covered and stored in the dark between +2°C to +6°C.

Allow the plate to sit at room temperature for approximately 15 min-
utes prior to use.
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Fluorescence Test Procedure
1. If you have not already done so, create the Genb protocols as described
starting on page 134.

2. If you have not already done so, prepare the solutions for the tests you
plan to perform. See Fluorescence Test Solutions on page 124.

Refer to the pipette maps starting on page 127 for the remaining
steps.

3. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the
tilter-based fluorescence system:

o Pipette 200 uL/well for each of the solutions for the Corners Test into
a clean 96-well microplate.

o Pipette 150 uL/well of the solutions for the Sensitivity and Linearity
Tests.

o Create an experiment based on the CYT3_FI_T_SF.prt protocol. Read
the plate, and then save the experiment.

4. To test Fluorescence Polarization capability:

o Pipette the solutions for the “FP” test into the same plate as used in
step 3.

e Create an experiment based on the CYT3_FP.prt protocol. Read the
plate, and then save the experiment.

You can use the single "combination" CYT3_FIFP_T.prt protocol
instead of separately running CYT3_FI_T_SF.prt and CYT3_FP.prt.

5. Perform the Corners/Sensitivity/Linearity tests for the monochromator-
based fluorescence system:

o Using the same plate as was used in step 4, pipette 50 pL/well of
buffer into wells C1-F5 and C10-F12.

o Create experiments based on the CYT3_M_FI_T_SF.prt (for the top
optics) and CYT3_M_FI_B_SF.prt (for the bottom optics) protocols.
Read the plate and then save the experiment.

6. To test the Time-Resolved Fluorescence capability:

o Pipette the solutions for the “TRF” test into a new 96-well solid white
plate.

BioTek Instruments, Inc.



Fluorescence Liquid Tests | 127

o Create an experiment based on the CYT3_TRF.prt protocol. Read the
plate and then save the experiment.

7. Calculate and evaluate results as described under Results Analysis,
starting on page 130.

Pipette Maps

Seal the plates with foil or store them in black polyethylene bags until
use. When using a clear-bottom plate, if the base of the plate is
touched, clean the entire base with alcohol (95% ethanol) and then
wipe with a lint-free cloth. Before placing the plate in the instrument,
blow the bottom of the plate with an aerosol duster.

The Corners, Sensitivity, Linearity, and “FP” pipette maps are designed so that
multiple tests can be run using the same microplate. Some examples:

o Corners, Sensitivity, and Linearity tests for the top and bottom optics for
the monochromator-based fluorescence systems can be performed using
the same quartz or glass-bottom plate.

o Corners/Sensitivity / Linearity (top optics) and the FP test can be
performed using the same solid black plate.

o Corners/Sensitivity / Linearity (top optics) for the filter- and
monochromator-based fluorescence systems can be performed using the
same solid black plate.

Corners Test

You can omit the buffer when using a solid black plate or the Greiner
SensoPlate.

o Pipette 200 uL of the 3.3 nM SF solution into the “corner” wells.

o Pipette 200 puL of the buffer in the wells surrounding the SF.

Sensitivity and Linearity Tests

Use an eight-channel pipette with just four tips installed. Perform these
instructions carefully, and refer to the plate map.

o Pipette 150 uL of the buffer into columns 2-5 and 10-12. Discard the tips.

o Pipette 150 uL of the 1 nM SF solution into column 1.
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o Pipette 150 uL of the 1 nm SF solution into column 2. Mix the wells using
the pipette. Do not discard the tips.

e Aspirate 150 pL from column 2 and dispense into column 3. Mix the wells
using the pipette. Do not discard the tips.

o Aspirate 150 pL from column 3 and dispense into column 4. Mix the wells
using the pipette. Do not discard the tips.

o Aspirate 150 uL from column 4 and dispense into column 5. Mix the wells
using the pipette. Do not discard the tips.

e Aspirate 150 pL from column 5. Discard the solution and the tips.

1 2 3 4 5 6|7 (8|9 10 11 12
Al33 3333 3.3 [ 3.3 |33
nM nM nM nM nM nM
Corners
B
1.0 | 0.5 | 0.25 | 0.125 | 0.0625
Cl v | ol oy e o BUF | BUF | BUF
b 1.3 o.l\s/I 0'i45 o.1l\245 0.21?425 sur | BuE | BUF
Sensitivity/ n n n n
Linearity 1.0 | 0.5 | 0.25 | 0.125 | 0.0625
E | u | om | oo . " BUF | BUF | BUF
1.0 | 0.5 | 0.25 | 0.125 | 0.0625
Flow !l om | oom . o BUF | BUF | BUF
G
Corners b33 (3333 3.3 | 3.3 |33
nM nM nM nM nM nM

If your model is equipped with the monochromator-based fluorescence system,
after testing the top optics of the filter-based system, you will pipette 50 pL of
buffer on top of the existing SF solutions and buffer. This will dilute the wells as
shown in the following map:

0.75 | 0.375 | 0.1875 | 0.0938 | 0.0469
c| N e e e - BUF | BUF | BUF
b 0.7\45 0.355 0.1?\475 o.o?VI38 0.04;469 sur | UE | BUF
Sensitivity/ n n n n n
Linearity 0.75 | 0.375 | 0.1875 | 0.0938 | 0.0469
E| - e e - BUF | BUF | BUF
0.75 | 0.375 | 0.1875 | 0.0938 | 0.0469
Fl e e e . BUF | BUF | BUF
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Fluorescence Polarization (FP) Test
o Pipette 200 uL of the (green) polarization buffer (BUF) into wells A6-He.

o Pipette 200 uL of the green high polarization reference (HPR) into wells

A7-B7.
o Pipette 200 uL of the green low polarization reference (LPR) into wells A8-
HS.
1 2 3 4 5 6 7 8 9 10 11 12
A BUF HPR LPR
B BUF HPR LPR
C BUF LPR
D BUF LPR
E BUF LPR
F BUF LPR
G BUF LPR
H BUF LPR

Time-Resolved Fluorescence (TRF) Test
o Pipette 200 uL of deionized water into wells A6-H6.

o If you have not already done so, shake the vial of 20 pM europium
suspension vigorously for 30 seconds prior to pipetting. Alternatively,
sonicate or vortex the vial.

o Pipette 200 uL of the 20 pM europium suspension (Eu) into wells A8-B8.

1 2 3 4 5 6 7 8 9 10 |11 12

DI Eu

DI Eu

DI

DI

DI

DI

DI

I o M m O O W P

DI
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Results Analysis

Corners Test

1. Calculate the Mean of the wells containing the 3.3 nM SF test solution (Al-
A3, A10-A12, H1-H3, and H10-H12).

2. Calculate the Standard Deviation for the same 12 wells.

3. Calculate the %CV: (Standard Deviation / Mean) * 100
The %CV must be < 3.0 to pass.
Sensitivity Test
Filter-Based Fluorescence System

1. Calculate the Mean and Standard Deviation for the buffer wells (C10-F12).
2. Calculate the Mean for the 1000 pM (1 nM) SF solution wells (C1-F1).
3. Calculate the Detection Limit, in pM:

1000/ ((Mean SF - Mean Buffer)/(3 * Standard Deviation Buffer))

To pass, the Detection Limit must be less than or

Optic Probe e e

Top, with 510 nm

dichroic mirror 10 pM (3 pM typical))

Monochromator-Based Fluorescence System

1. Calculate the Mean and Standard Deviation for the buffer wells (C10-F12).
2. Calculate the Mean for the 750 pM (0.75 nM) SF solution wells (C1-F1).
3. Calculate the Detection Limit, in pM:

750/ ((Mean SF - Mean Buffer)/(3 * Standard Deviation Buffer))

To pass, the Detection Limit must be less than or

Optic Probe equal to:

EX 485 nm, EM 528

am Top/Bottom: 20 pM (5 pM typical)
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Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1-
5.

2. Perform linear regression using these values as inputs:

Filter-Based Fluorescence Sys- Monochromator-Based Flu-
tem orescence System
X Y X Y
1000 Mean of the 1000 250 Mean of the 750
pM wells pM wells
500 Mean of the 500 375 Mean of the 375
pM wells pM wells
250 Mean of the 250 187.5 Mean of the 187.5
pM wells pM wells
125 Mean of the 125 93.75 Mean of the 93.75
pM wells pM wells
Mean of the 62.5 Mean of the
62.5 pM wells 46.875 46.875 pM wells

3. Calculate the R-Square value; it must be >= 0.950 to pass.

Fluorescence Polarization (FP) Test

1. Using the raw data from the Parallel read:
e Calculate the Mean Blank (wells A6-H6).

o Calculate the Signal for each HPR well: Subtract the Mean Blank from
its measurement value.

o Calculate the Signal for each LPR well: Subtract the Mean Blank from
its measurement value.

2. Using the raw data from the Perpendicular red:
o Calculate the Mean Blank (wells A6-H6)

o Calculate the Signal for each HPR well: Subtract the Mean Blank from
its measurement value.

o Calculate the Signal for each LPR well: Subtract the Mean Blank from
its measurement value.

3. Calculate the G-Factor for each LPR well:
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(Parallel LPR Sign * (1-0.02)) / (Perpendicular LPR Signal * (1+0.02))
4. Calculate the Mean G-Factor.

5. Calculate the Polarization value in mP for each HPR well (“PHPR"):

Parallel HPR Signal - Mean G-Factor * Perpendicular HPR Signal * 1000
Parallel HPR Signal + Mean G-Factor * Perpendicular HPR Signal

6. Calculate the Mean PHPR, in mP.

To pass, the Mean PHPR

Optic Probe must be greater than:

Top, with 510 nm dichroic

, 340 mP
mirror

7. Calculate the Polarization value in mP for each LPR well (“PLPR”"):

Parallel LPR Signal - Mean G-Factor * Perpendicular LPR Signal * 1000
Parallel LPR Signal + Mean G-Factor * Perpendicular LPR Signal

8. Calculate the Standard Deviation of the “PLPR,” in mP.

To pass, the Standard
Optic Probe Deviation of the PHPR
must be less than:

Top, with 510 nm dichroic mirror 5mP

Time-Resolved Fluorescence (TRF) Test
1. Calculate the Mean and Standard Deviation of the wells containing the
deionized water (wells A6-H6).

2. Calculate the Mean and Standard Deviation of the wells containing the
europium solution (wells A8-BS).

3. Calculate the Detection Limit, in fM:
20000/ ((Mean Eu - Mean DI water) / (3 * Standard Deviation DI water)

To pass, the Detection
Optic Probe Limit must be less than
or equal to:
Top, with 400 nm dichroic mirror 250 fM

Troubleshooting Fluorescence Liquid Tests

If any tests fail, please try the following suggestions. If the test(s) continue to fail,
print the results and contact BioTek’s Technical Assistance Center.
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e Are the solutions fresh? Discard the plate after seven days.

o Are the excitation/emission filters clean? Are they in the proper locations
and in the proper orientation in the filter cube?

o If the Corners Test continues to fail, the hardware may be misaligned.
Contact BioTek TAC.

e Are you using new/clean plates? If the base of a clear-bottom plate is
touched, clean the entire base with alcohol (95% ethanol) and then wipe
with a lint-free cloth. Before placing the plate in the instrument, blow the
bottom of the plate with an aerosol duster. If the test fails again, the optical
probe(s) may need to be cleaned. Contact BioTek’s Technical Assistance
Center for instructions.

e Review the pipetting instructions to verify the plate was correctly
prepared.

e Does the Plate Type setting in the Gen5 protocol match the plate you
used?

 For injector models, spilled fluid inside the reader may be fluorescing,
which can corrupt your test results. If you suspect this is a problem,
contact BioTek TAC.

e When testing Fluorescence Polarization capability using a solid black
plastic microplate, if the standard deviation for the buffer wells is too high,
try either moving the buffer wells to another column. With some black
plastic plates, the wells in the center of the plate may be slightly distorted
due to the plate molding process, and this can affect the standard
deviation.

e The Read steps in the protocols use the Gen5 Automatic Gain Adjustment
feature to determine optimum sensitivity values for the plate. If an Auto
Gain Result value is outside the range of 50-200, this may indicate a
problem.

If the value is less than 50:

= The stock solution/dilution concentrations may be too high. Try
creating fresh solutions/dilutions, and rerun the test using a new,
clean plate.

= If all of the tests are passing but the Gain value is low, a PMT in
your reader may just be very sensitive. Contact BioTek’s Technical
Assistance Center to confirm that this may be the case.

If the value is greater than 200:

= The stock solution/dilution concentrations may be too low. Try
creating fresh solutions/dilutions, and rerun the test using a new,
clean plate.
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» For injector models, spilled fluid inside the reader may be
fluorescing, which can corrupt your test results. If you suspect this
is a problem, contact BioTek TAC.

» The PMTs or optical path(s) may be deteriorating, or the optics or
other hardware may be misaligned. Contact BioTek’s Technical

Assistance Center.

Gen5 Protocol Reading Parameters

The information in the following tables represents the recommended reading

parameters. It is possible that your tests will require modifications to some of these

parameters, such as the Plate Type (see Troubleshooting Tips on page 132).

The Plate Type setting in each Gen5 protocol should match the plate

you are actually using.

CYT3_FI_T_SF.prt

This procedure contains two Read steps using filters to test the top
optics: one for the Corners Test and one for the Sensitivity/Linearity

Test.

Parameter

Default Setting

Detection Method:

Fluorescence

Read Type: Endpoint
Plate Type: Costar 96 black opaque (#3915)
Shake Step: Linear for 15 seconds
Delay Step: 5 seconds after shake
Corners Read step: Full plate
Read Wells:
Sensitivity/Linearity Read Step: Wells C1-F12
Corners Read: "Corners Read"
Step Label:
Sensitivity/Linearity: "Sensitivity Read"
Filter Set: 1 (filter cube)
Filters: EX 485/20 nm, EM 528/20 nm

Optics Position:

Top 510 nm
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Parameter Default Setting

Corners Read: Auto, Scale to High Wells, A1, 50000

Gain: Sensitivity/Linearity Read: Auto, Scale to High Wells,
C1, 50000
Normal

Read Speed: Delay after plate movement: 0 msec

Measurements per data point: 50

Delay After
Plate Movement: 350 msec
Measurements per Data

i 40
Point:
Lamp Energy: Low (faster)
Read Height: 7.00 mm
CYT3_FP.prt

This procedure contains one Read step using filters with Fluorescence
Polarization enabled, inside a Plate Mode block.

Parameter Default Setting

Detection Method: Fluorescence polarization

Read Type: Endpoint

Plate Type: Costar 96 black opaque (#3915)
Shake Step: Linear for 15 seconds

Delay Step: 5 seconds after shake
Synchronized Mode: Plate Mode with Timing Control
Read Wells: A6-HS8

Filter Sets: 1 (filter cube)

Filters: EX 485/20 nm, EM 528/20 nm
Optics Position: Top 510 nm

Gain: Auto, Scale to high Wells, A8, 10000
Read Speed: Normal

Delay After Plate Movement: 350 msec
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Parameter

Default Setting

Measurements Per Data Point: 60

Lamp energy:

Low (faster)

Read Height:

7.0 mm

CYT3_FIFP_T.prt

Parameter Default Setting

Plate Type: Costar 96-well black opaque
Shake Step: Linear for 15 seconds

Delay Step: 5 seconds

Read Step 1:

Detection Method:

Fluorescence intensity

Read Type: Endpoint

Step Label: Corners Read

Read Wells: Full Plate

Filter Sets: 1 (filter cube)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position:

Top 510 nm

Point:

Gain: Auto, Scale to high Wells, A1, 50000
Read Speed: Normal

Delay After Plate Move- 350 msec

ment:

Measurements per Data 50

Lamp energy:

Low (faster)

Read Height:

7.00 mm

Read Step 2:

Detection Method:

Fluorescence intensity

Read Type:

Endpoint

Step Label:

Sensitivity Read
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Parameter Default Setting

Read Wells: Cl..F12

Filter Sets: 1 (filter cube)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position:

Top 510 nm

Point:

Gain: Auto, Scale to high Wells, C1, 50000
Read Speed: Normal

Delay After Plate Move- 350 msec

ment:

Measurements per Data 40

Lamp energy:

Low (faster)

Read Height:

7.00 mm

Read Step 3

Stop/Resume Step:

Prepare to install the FP filter cubes and then resume the
experiment

Shake Step:

Linear for 15 seconds

Delay Step:

5 seconds

Synchronized Mode:

Plate Mode with Timing Control

Detection Method:

Fluorescence polarization

Read Type: Endpoint

Read Wells: A6-H8

Filter Sets: 1 (filter cube)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position:

Top 510 nm

ment

Gain: Auto, Scale to High Wells, A8, 10000
Read Speed: Normal
Delay After Plate Move- 350 msec
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Parameter

Default Setting

Measurements Per Data
Point:

Lamp energy:

Low (faster)

Read Height:

7.00 mm

CYT3_TRF.prt

Parameter

Default Setting

Plate Type:

Costar 96-well white opaque

Detection Method:

Time-resolved fluorescence

Read Type: Endpoint

Delay Step: 3 minutes

Shake Step: Linear for 30 seconds
Read Wells: A5-H9

Filter Sets: 1 (filter cube)

Filters: EX 360/40 nm, 620/40 nm

Optics Position:

Top 400 nm

point:

Gain: Auto, Scale to High Wells, A8, 50000
Read Speed: Normal

Delay after plate move- 350 msec

ment:

Measurements per data 20

Lamp energy:

Low (faster)

Read Height:

7.00 mm

CYT3_M_FI_T_SF.prt and CYT3_M_FI_B_SF.prt

Parameter

Default Setting

Detection Method:

Fluorescence

Read Type:

Endpoint

Plate Type:

96-well Greiner SensoPlate
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Parameter Default Setting
Shake Step: Linear for 15 seconds at 567 cpm
Delay Step: 5 seconds after shake
Corners 1: A1..A3
Corners 2: A10..A12
Read Wells: Corners 3: H1..H3
Corners 4: H10..H12
Gain: C1..F12
Wavelength: 1, EX 485 nm, EM 528 nm

Optics Position:

Top/Bottom

Corners 1: Auto, Scale to High Wells, A1, 50000

Corners 2-4: Auto, Use first filter set gain from

Gain FIRST Read Step
Gain: Auto, Scale to High Wells, C1, 50000
Read Speed: Normal
Delay after plate move- 350 msec
ment:
Measurements per data 100

point:

Lamp Energy:

Low (faster)

Read Height (for top
optics):

7.00 mm

Fluorescence Test Procedure (Methylumbelliferone)

As an alternative to using Sodium Fluorescein, Methylumbelliferone (“MUB”) can

be used to test the top optics.

Required Materials

Microplates should be perfectly clean and free from dust or bottom
scratches. Use new microplates from sealed packages.

Manufacturer part numbers are subject to change over time.
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BioTek offers a liquid test kit (PN 7160012) containing the microplates
and solutions used in the MUB fluorescence liquid test.

Methylumbelliferone (“MUB”) (10-mg vial, BioTek PN 98156)
Carbonate-Bicarbonate buffer (“CBB”) capsules (BioTek PN 98158)
100% methanol (BioTek PN 98161)

A new, clean 96-well solid black plate microplate, such as Corning Costar
#3915 or equivalent. The same plate is used to test both filter- and
monochromator-based systems.

Excitation filter 360/40 nm installed
Emission filter 460/40 nm installed
400 nm dichroic mirror installed
Deionized or distilled water
Various beakers, graduated cylinders, and pipettes
Aluminum foil
(Optional, but recommended) 0.45-micron filter
(Optional) Black polyethylene bag(s) to temporarily store plate(s)
Genb protocols described on page 145:
= CYT_FI_T_MUB.prt tests the top filter-based fluorescence system

» CYT_M_FI_T_MUB.prt tests the top optics of the monochromator-
based fluorescence system

Test Solutions

0

Filter solutions to remove particulates that could cause erroneous readings.
Do not allow dust to settle on the surface of the solution; use microplate cov-
ers or seals when not reading the plate.

Wrap the vial containing the MUB stock solution in foil to prevent exposure
to light.

Discard any open, unused solutions after seven days.

1. Prepare the buffer (CBB) solution:

e (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL
of deionized or distilled water.
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e Open and dissolve the contents of two CBB capsules (do not dissolve
the outer gelatin capsule) into 200 mL of the water.

o Stir the solution (preferably using a stir table) until the CBB is
completely dissolved.

2. Prepare the MUB stock solution:
e Add 1 mL of 100% methanol to the 10-mg vial of MUB.

o Make sure all of the dye has completely dissolved and is well mixed.
This yields a 10 mg/mL stock solution.

e Wrap the solution in aluminum foil to prevent exposure to light.

3. Prepare the dilutions. Label each with “MUB” and the concentration.

Mix This MUB Solution: With: To Make:
0.5 mL of 10 mg/mL stock solution 4.5 mL of 100% methanol 1 mg/mL
0.88 mL of 1 mg/mL solution 4.12 mL of CBB 176 pg/mL
0.1 mL of 176 pg /mL solution 9.9 mL of CBB 1.76 ug /mL
0.5 mL of 1.76 pg /mL solution 4.5 mL of CBB 176 ng/mL

. 17.6 ng/mL
1 mL of 176 ng/mL solution 9 mL of CBB (100 nM)
Procedure

1. If you have not already done so, create the Gen5 protocols as described on
page 145.

2. If you have not already done so, prepare the test solutions. See page 140.

3. Perform the Sensitivity / Linearity tests using the Top optics of the filter-
based fluorescence system:

o Refer to the pipette map in the next section and pipette the solutions
into a clean, 96-well plate.

o Create an experiment based on the CYT3_FI_T_MUB.prt protocol.
Read the plate and then save the experiment.

4. Perform the Sensitivity / Linearity tests for the monochromator-based
fluorescence system:

o Using the same plate as was used in step 3, pipette 50 uL/well of
buffer into wells C1-F5 and C10-F12.
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o Create an experiment based on the CYT3_M_FI_T_MUB.prt
protocol. Read the plate and then save the experiment.

5. Calculate and evaluate the results as described under Results Analysis,
starting on page 143.

Pipette Map

Using a multi-channel pipette with just four tips installed to process rows C-F:

Pipette 150 uL of buffer into columns 10-12.
Pipette 150 uL of buffer into columns 2-5 (not column 1). Discard the tips.

Pipette 150 uL of the 17.6 ng/mL (100 nM) solution into column 1. Discard
the tips.

Pipette 150 pL of the 17.6 ng/mL (100 nM) solution into column 2. Do not
discard the tips.

Aspirate 150 pL from column 2 and dispense it into column 3. Mix the
wells using the pipette. Do not discard the tips.

Aspirate 150 pL from column 3 and dispense it into column 4. Mix the
wells using the pipette. Do not discard the tips.

Aspirate 150 pL from column 4 and dispense it into column 5. Mix the
wells using the pipette. Do not discard the tips.

Aspirate 150 pL from column 5. Discard the tips.

1 2 3 4 5 6 7 8 9 10 11 12
B
100 50 25 12.5 6.25
C M M M M M BUF BUF BUF
100 50 25 12.5 6.25
D M oM M M M BUF BUF BUF
100 50 25 12.5 6.25
E M oM oM M nM BUF BUF BUF
100 50 25 12.5 6.25
F M oM M M M BUF BUF BUF
H

For the monochromator-based fluorescence system, after testing the top optics of
the filter-based system, you will pipette 50 uL of buffer on top of the existing MUB
solutions and buffer. This will dilute the wells as shown next.
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1 2 3 4 5 6 7 8 9 10 11 12

A

B
75 37.5 18.75 9.375 4.687

C nM nM nM nM nM BUF BUF BUF
75 37.5 18.75 9.375 4.687

D nM nM nM nM nM BUF BUF BUF
75 37.5 18.75 9.375 4.687

E nM nM nM nM nM BUF BUF BUF
75 37.5 18.75 9.375 4.687

F nM nM nM nM nM BUF BUF BUF

Results Analysis

If you are using the Gen5 protocols that are supplied on the Product
Qualification CD, the calculations and pass/fail determinations are per-
formed automatically.

Sensitivity Test

Filter-Based Fluorescence System:

1. Calculate the Mean and Standard Deviation for the buffer wells (C10-F12).
2. Calculate the Mean for the 17.6 ng/mL MUB solution wells (C1-F1).

3. Calculate the Detection Limit, in ng/mL.:

17.6/ (Mean MUB - Mean Buffer)/(3 * Standard Deviation Buffer))

Optic Probe

To pass, the Detection Limit must be less than or
equal to:

Top, with 400 nm
dichroic mirror

0.16 ng/mL (0.91 nM)

Monochromator-Based Fluorescence System:

1. Calculate the Mean and Standard Deviation for the buffer wells (C10-F12).
2. Calculate the Mean for the 13.2 ng/mL (75 nM) MUB solution wells (C1-
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F1).

3. Calculate the Detection Limit, in ng/mL:

13.2/ (Mean MUB - Mean Buffer)/(3 * Standard Deviation Buffer))

Optic Probe To pass, the Detection Limit must be less than or
equal to:
Top 0.16 ng/mL (0.91 nM)
Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1-

5.

2. Perform linear regression using these values as inputs:

Filter-based Fluorescence System

100

Yy
Mean of the 100 nM wells

50

Mean of the 50 nM wells

25

Mean of the 25 nM wells

12.5

Mean of the 12.5 nM wells

6.25

Mean of the 6.25 nM wells

Monochromator-based
Fluorescence System

X

75

Y
Mean of the 75 nM wells

37.5

Mean of the 37.5 nM wells

18.75

Mean of the 18.75 nM wells

9.375

Mean of the 9.375 nM wells

4.6875

Mean of the 4.6875 nM wells

3. Calculate the R-Square value; it must be >= 0.950 to pass.
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Gen5 Protocol Reading Parameters

The information in the following table represents the recommended reading
parameters. It is possible that your test will require modifications to some of these
parameters, such as the Plate Type or Sensitivity value (see Troubleshooting on
page 132).

The Plate Type setting in the Gen5 protocol should match the plate you
are actually using.

CYT3_FI_T_MUB.prt

Parameter Default Setting

Detection Method: Fluorescence

Read Type: Endpoint

Plate Type: Costar 96-well black opaque
Shake Step: Linear for 15 seconds

Delay Step: 5 seconds after shake

Read Wells: Wells C1-F12

Filter Sets: 1

Filters: EX 360/40 nm, EM 460/40 nm

Optics Position:

Top 400 nm

Gain: Auto, Scale to High Wells, C1, 50000
Read Speed: Normal

Delay After Plate Movement: 350 msec

Measurements Per Data Point: 40

Lamp Energy:

Low (faster)

Read Height:

7.00 mm

CYT3_M_FI_T_MUB.prt

Parameter

Default Setting

Detection Method:

Fluorescence

Read Type:

Endpoint

Plate Type:

Costar 96-well black opaque
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Parameter Default Setting
Shake Step: Linear for 15 seconds
Delay Step: 5 seconds

Read Wells: Wells C1-F12

Wavelengths:

1, EX 360 nm, EM 460 nm

Optics: Top

Gain: Auto, Scale to High Wells, C1, 50000
Read Speed: Normal

Delay after plate movement: 350 msec

Measurements per data point: 100

Lamp Energy:

Low (faster)

Read Height:

7.00 mm

Luminescence Test

BioTek provides two methods for verifying the performance of luminescence
reads. One method measures a Harta Luminometer Reference Microplate, which is
an LED-based test plate. Contact BioTek to purchase a plate, or go to
www.hartainstruments.com for more information. The other method measures a
LUX Biotechnology, Ltd., Glowell unit, which is a small, sealed cylinder with a

gaseous tritium light source.

Before using the F-LumTest_Harta.prt or F-LumTest_Glowell.prt protocols
described in this section, create the filter set shown below.

Filter Set Mame

Excitation

Mirrar

Emissian

Filter Set 1

| <none ll <nane:

Ex (MinMax)

| I

Em {Min/Max)
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Harta Plate Test

Materials
o Harta Luminometer Reference Microplate, PN 8030015
o Harta Plate Adapter, PN 1222205

e Genb protocol (see page 150)

Procedure

1. Turn on the Harta reference plate using the I/O switch on the back of the
plate.

2. Check the plate’s battery by pressing simultaneously on the two test
buttons on the back of the plate and ensuring that the test light turns on.

3. Place the Harta plate adapter on the reader’s carrier, then place the test
plate on top of the adapter.

4. Create an experiment based on the F-LumTest_Harta.prt or
M-LumTest_Harta.prt protocol and read the plate.

5. Calculate and evaluate results as described under Results Analysis below.

Plate Layout

1 2 3 4 5 6 7 8 9 10|11 (12

A o patiery | beteery

B

C

D

E BUF | BUF | BUF | BUF

F BUF | BUF BUF | BUF

G |BUF |BUF |BUF | BUF

H | BUF | BUF BUF | BUF
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Harta Plate Results Analysis

A manual ATP correlation process determined that 11,000 RLU from the
Harta plate is equivalent to approximately 1800 attomoles of ATP.

1. On the Harta plate’s Calibration Certificate, locate the NIST measurement
for the A2 position and convert it to attomoles:
(A2 NIST measurement/11,000)*1800

2. Determine if the plate’s battery is still functioning properly:
» If A8 > A7, the battery is good.

» If A8 < A7, the battery requires replacement.

3. Calculate the signal-to-noise ratio:
(A2-Mean of the buffer cells)/(3 * Standard deviation of buffer cells)

4. Calculate the detection limit:
A2 NIST measurement in attomoles/signal-to-noise ratio

» If the reader is equipped with the low-noise PMT, the detection limit
must be <= 75 amol to pass.

» If the reader is equipped with the red-shifted PMT, the detection
limit must be <= 500 amol to pass.

To determine which PMT is installed, check the label on the back
of the reader. #49984 = low-noise PMT; #49721 = red-shifted
PMT.

Glowell Test

Materials

o Glowell, PN GLO-466, formerly available from LUX BioTechology, Ltd.
(www.luxbiotech.com)

o Glowell Adapter Plate, available from BioTek, PN 7160006

e Genb protocol (see page 150)

Procedure

1. If you have not already done so, insert the Glowell (“window” side up)
into well D8 of the Adapter Plate.
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2. If you have not already done so, create the Gen5 protocol as described on
pages Glowell Test and Glowell Test.

3. Create an experiment based on the F-LumTest_Glowell.prt or
M-LumTest_Glowell.prt protocol. Read the plate and then save the
experiment.

4. Calculate and evaluate results as described under Results Analysis below.

Plate Layout

1 2 |3 (4 |5 |6 |7 |8 9 10 11 12

BUF BUF BUF

BUF BUF BUF

BUF BUF BUF

Glowell | BUF BUF BUF

BUF BUF BUF

BUF BUF BUF

BUF BUF BUF

I o M m O O W P

BUF BUF BUF

Glowell Results Analysis

A manual ATP correlation process determined that 0.021pW Radiant
Flux is equivalent to approximately 1800 attomoles of ATP.

1. Locate these items on the Glowell’s Calibration Certificate: Calibration
Date, Radiant Flux (pW), Measurement Uncertainty of the Radiant Flux.

2. Calculate the number of days between the Calibration Date and the date
the test was performed.

3. Correct the Glowell’s Radiant Flux value for deterioration over time:
Radiant Flux * e*(-0.0001536*number of days since calibration)

4. Convert the Corrected Radiant Flux value to attomoles (see Note above):
(Corrected Radiant Flux / 0.021) * 1800

5. Calculate an error factor for the Corrected Radiant Flux (amol):
(Corrected Radiant Flux in amol * Measurement Uncertainty) / 100
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6. Calculate the min/max criteria for the Corrected Radiant Flux (amol):
MIN: Corrected Radiant Flux in amol - Error Factor
MAX: Corrected Radiant Flux in amol + Error Factor

7. Calculate the Signal-to-Noise Ratio:
Measurement value of the Glowell - Mean of Column 9

3 x Standard Deviation of Column 9

8. Calculate the Detection Limit:

Corrected Radiant Flux in amol/Signal-to-Noise Ratio

9. Calculate the min/max criteria for the Detection Limit:
MIN: MIN for Corrected Radiant Flux in amol/Signal-to-Noise Ratio
MAX: MAX for Corrected Radiant Flux in amol/Signal-to-Noise Ratio

» If the reader is equipped with the low-noise PMT, the detection limit

must be <= 75 amol to pass.

» If the reader is equipped with the red-shifted PMT, the detection
limit must be <= 500 amol to pass.

To determine which PMT is installed, check the label on the back of the
reader. #49984 = low-noise PMT; #49721 = red-shifted PMT.

Gen5 Protocol Reading Parameters

The information in the following tables represents the recommended reading

parameters.

F-LumTest_Harta.prt

Parameter Default Setting

Plate Type: Costar 96 black opaque (#3915)
Delay Step: 3 minutes

Read Step 1:

Read Wells: A2

Step Label: Reference well A2

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:10.00 MM:SS.ss

Delay After Plate Movement:

350 msec

Dynamic Range:

Standard
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Parameter Default Setting
Filter Sets: 1 (filter cube)
Excitation: Plug

Emission: Hole

Optics Position: None

Gain: 150

Read Height: 7.00 mm

Read Step 2:

Read Wells: El..H4

Step Label: Background

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:10.00 MM:SS.ss

Delay After Plate Movement:

350 msec

Dynamic Range:

Standard

Filter Sets: 1 (filter cube)
Excitation: Plug
Emission: Hole

Optics Position: None

Gain: 150

Read Height: 4.00 mm
Read Step 3:

Read Wells: A7-A8

Step Label: Battery Check

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:01.00 MM:SS.ss

Delay After Plate Movement:

350 msec

Dynamic Range:

Standard
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Parameter Default Setting
Filter Sets: 1 (filter cube)
Excitation: Plug

Emission: Hole

Optics Position: None

Gain: 50

Read Height: 4.00 mm

M-LumTest_Harta.prt

Parameter Default Setting

Plate Type: Costar 96 black opaque (#3915)
Delay Step: 3 minutes

Read Step 1:

Read Wells: A2

Step Label: Reference well A2

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:10.00 MM:SS.ss

Delay After Plate Movement: 350 msec
Dynamic Range: Standard
Gain: 150

Read Height: 1.00 mm
Read Step 2:

Read Wells: El..H4
Step Label: Background

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:10.00 MM:SS.ss

Delay After Plate Movement:

350 msec

Dynamic Range:

Standard

BioTek Instruments, Inc.




Luminescence Test | 153

Parameter Default Setting
Gain: 150

Read Height: 1.00 mm

Read Step 3:

Read Wells: A7-A8

Step Label: Battery Check

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:01.00 MM:SS.ss

Delay After Plate Movement: 350 msec
Dynamic Range: Standard
Gain: 150

Read Height: 1.00 mm

F-LumTest_Glowell.prt

Parameter Default Setting

Plate Type: Costar 96-well black opaque (#3915)
Delay Step: 3 minutes

Read Wells: A8..H11

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:10.00 MM:SS.ss

Delay After Plate Movement:

350 msec

Dynamic Range:

Standard

Filter Sets: 1 (filter cube)
Excitation: Plug
Emission: Hole

Optics Position: None

Gain: 150

Read Height: 1.00 mm
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M-LumTest_Glowell.prt

Parameter Default Setting

Plate Type: Costar 96-well black opaque (#3915)
Delay Step: 3 minutes

Read Wells: A8..H11

Detection Method:

Luminescence

Read Type:

Endpoint

Integration Time:

0:10.00 MM:SS.ss

Delay After Plate Movement: 350 msec
Dynamic Range: Standard
Gain: 150

Read Height: 1.00 mm

Luminscence Troubleshooting

If either test fails, try the following suggestions. If the test(s) continues to fail, print
the results and contact BioTek’s Technical Assistance Center.

e Ensure that the reading is performed through a hole in the filter cube, not

through a glass filter.

o Verify that the filter cube settings in Gen5 match the physical cube.

o If the test continues to fail, the optical probe(s) may need to be cleaned.
Contact BioTek’s Technical Assistance Center for instructions.

Glowell only:

o Is the plate properly inserted into the adapter? The “window”side should
be facing up. If necessary, clean the Glowell according to the

manufacturer’s instructions.

o Is the adapter plate clean? If dust has collected in the wells, try cleaning
the plate using compressed air or an aerosol duster.

o Is the test failing because the standard deviation of the empty background
(“buffer”) wells is 0 (resulting in a division-by-zero error in the
spreadsheet)? If yes, try pipetting 100 uL of deionized water into all wells
of Columns 9, 10, and 11 (the background wells).
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Dispense Module Tests

This section applies only to models with the dispenser.

BioTek has developed a set of tests that you can perform to ensure that the
dispense module performs to specification initially and over time. We recommend
performing these tests before first use (e.g., during the Initial OQ), and then every
three months.

e The Accuracy Test is a measure of the mean volume per well for multiple
dispenses. The actual weight of the dispensed fluid is compared to the
expected weight and must be within a certain percentage to pass.
Pass/Falil criteria depends on the per-well volume dispensed: 2.0% for 80
uL, 5.0% for 20 puL, and 20.0% for 5 pL. It is assumed that one gram is equal
to one milliliter.

The test uses a single green dye test solution and a 96-well microplate (per
injector) to test the three different volumes. The balance is tared with the
empty plate, and then the 80 pL dispense is performed for columns 1-4. The
fluid is weighed and the balance is tared again (with the plate on the bal-
ance). This process is repeated for the 20 uLL. and 5 uL dispenses. It is
assumed that the solutions used are at room temperature. A precision bal-
ance (three-place) is used to weigh the plate.

o The Precision Test is a measure of the variation among volumes dispensed
to multiple wells. For each volume dispensed (80 pL, 20 pL, and 5 pL) to
four columns, the %CV (coefficient of variation) of 32 absorbance readings
is calculated. Pass/Fail criteria depends on the per-well volume dispensed:
2.0% for 80 uL, 7.0% for 20 puL, and 10.0% for 5 pL. The plate is read in an
absorbance reader at 405/750 nm for columns 1-4 and at 630/750 nm for
columns 5-12.

The two tests are performed simultaneously and use the same plate.

Failures
If any tests fail, prime the fluid lines and rerun the test(s).

If the test(s) fail again, the injector may require cleaning. See Preventive
Maintenance .

If tests continue to fail, contact BioTek’s Technical Assistance Center.

Required Materials

Manufacturer part numbers are subject to change over time.

e Absorbance reader with capability of reading at 405, 630, and 750 nm. The
reader must have an accuracy specification of +1.0% * 0.010 OD or better
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and a repeatability specification of £ 1.0% % 0.005 OD or better.

The Cytation3 may be used if it is equipped with Absorbance
capabilities and has passed the Absorbance Plate Test or Absorb-
ance Liquid Test 1.

e Microplate shaker (if the absorbance reader does not support shaking)

o Precision balance with capacity of 100 g minimum and readability of
0.001 g

e 50-200 uL hand pipette and disposable tips
e Deionized water

e Supply bottles

e 250-mL beaker

o New 96-well, clear, flat-bottom microplates

e BioTek’s Green Test Dye Solution (PN 7773003) undiluted, or one of the
alternate test solutions listed in the next section

e 100-mL graduated cylinder and 10-mL pipettes (if not using BioTek’s
Green Test Dye Solution)

¢ Genb software installed on the host PC

e Genb protocols as defined by the procedure on page 162 Genb Test
Protocols for Models with Absorbance Capabilities

Alternate Test Solutions

80 L of test solution with 150 uL of deionized water should read
between 1.300 and 1.700 OD at 405/750 nm. The solutions should be at
room temperature.

If you do not have BioTek’s Green Test Dye Solution (PN 7773003), prepare a dye
solution using one of the following methods:
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Using BioTek'’s Blue and Yellow Concentrate Dye Solutions:

Ingredient Quantity
Concentrate Blue Dye Solution 4.0 mL
(PN 7773001, 125 mL)
QC (Yellow) Solution (PN
7120782, 125 mL) >0mtL
Deionized water 90.0 mL
Using FD&C Blue and Yellow Dye Powder:
Ingredient Quantity
FD&C Blue No. 1 0.200 grams
FD&C Yellow No. 5 0.092 grams
Tween 20 1.0 mL
Sodium Azide N3Na 0.100 gram
Deionized water Make to 1 liter

Procedure for Models with Absorbance Capabilities

If you have not already done so, create Gen5 protocols Disp 1
Test.prt and Disp 2 Test.prt. Instructions begin on page 162.

1. Prime both dispensers with 4000 pL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers
with the Volume set to 2000 pL. This prevents the water from diluting the
dye.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both
dispensers with 2000 pL of the solution. When finished, remove the
priming plate from the carrier.

4. In Gen), create an experiment based on Disp 1 Test.prt.
5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.

@ Running a dispense procedure without placing a plate in the reader will
result in contamination of the reader from spilled liquid.
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When each dispense step is finished, you will weigh the plate, rec-
ord the weight, tare the balance with the plate on it, and then
place the plate back on the carrier for the next step.

7. Select Plate > Read and click READ. Genb5 prompts you to empty the tip
priming trough.

8. When ready, click OK at the Load Plate dialog to begin the experiment.
The sequence is as follows:

a. Dispense 80 pL/well to columns 1-4.

b. Remove the plate and weigh it. Record the weight and tare the balance.
c. Place the plate on the carrier and dispense 20 pL/well to columns 5-8.
d. Remove the plate and weigh it. Record the weight and tare the balance.
e. Place the plate on the carrier and dispense 5 uL/well to columns 9-12.
f. Remove the plate and weigh it. Record the weight.

g. Manually pipette 200 pL of deionized or distilled water into all 12
columns, on top of the green test dye solution.

h. Place the plate on the carrier for a 15-second shake, the “80 uL” read at
405/750 nm, and the “20 and 5 pL” read at 630/750 nm.

9. When processing is complete, select File > Save As. Enter an identifying
file name and click Save.

10. Remove the plate from the carrier and set it aside.
11. Repeat steps 4-9 using Disp 2 Test.prt.

12. See page Results Analysis for instructions on analyzing the results.

When all tests are complete, prime both dispensers with at least 5000
ML of deionized water to flush out the green dye solution.

Results Analysis

For your convenience, worksheets are included at the end of this chap-
ter for recording the dispense weights, Delta OD values, calculations,
and pass/fail.

The pass/fail criteria for each set of 32 wells with the same dispense volume is
based on the calculated coefficient of variation (% CV) and Accuracy % Error.

For each volume dispensed (80 uL, 20 uL, 5 uL), for each dispenser (1, 2):
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Calculate the Standard Deviation of the 32 wells

Calculate the Mean of the 32 wells

Calculate the %CV: (Standard Deviation / Mean) x 100

Calculate the Accuracy % Error:
((Actual Weight - Expected Weight)/Expected Weight)* 100

Expected Weights for 32 wells: 80 pL (2.560 g), 20 pL (0.640 g), 5 uL
(0.160 g). It is assumed that one gram is equal to one milliliter.

To pass, Accuracy %

i (o)
Dispense Volume |To pass, %CV must be Error must be:

80 pL < 2.0% < 2.0%
20 pL < 7.0% < 5.0%
5L < 10.0% < 20.0%

Procedure for Models without Absorbance Capabilities

The Product Qualification CD contains Genb protocols for use with this test. When
running this procedure, you'll create experiments based on these protocols.

Disp 1 Test No Read.prt and Disp 2 Test No Read.prt

Each protocol contains three Dispense steps for dispensing three different volumes
of the green dye test solution into a microplate.

Despite the "No Read" text in the protocol names, the last step in both
protocols is actually a brief Read step. This step is necessary because
Genb5 requires a Read step with any Dispense procedure; however, the
resulting measurement value is not used.

To avoid errors when running the experiments, examine the following default
protocol parameters. If your Cytation3 model does not support some of the
parameters, change the Read step in both protocols so that it will work with
your model. The Read step is defined as follows:

e Read well Al only

Detection Method: Luminescence (filter-based)

Filter Set: Open

Read Height: 7.00 mm
Gain: 135
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Disp 1 Test Other Reader.prt and Disp 2 Test Other Reader.prt

These protocols contain the absorbance Read steps necessary for testing the
dispense module, and they also contain Microsoft Excel spreadsheets for
performing the results analysis.

These two protocols can be used only if your absorbance reader is a BioTek
reader and is supported by Gen5. If you cannot use these protocols, prepare your
reader to perform two reads with the following characteristics:

80 pL Read 20 & 5 pL Read
Primary Wavelength 405 nm 630 nm
Reference Wavelength 750 nm 750 nm
Plate Columns 1-4 5-12

1. If you have not already done so, create the necessary Gen5 protocols as
described on page 162.

2. Prime both dispensers with 4000 pL of deionized or distilled water.

3. Remove the inlet tubes from the supply bottles. Prime both dispensers
with the Volume set to 2000 uL. This prevents the water from diluting the
dye.

4. Fill a beaker with at least 20 mL of the green dye solution. Prime both
dispensers with 2000 pL of the solution. When finished, remove the
priming plate from the carrier.

5. In Gen), create an experiment based on Disp 1 Test No Read.prt.
6. Place a new 96-well microplate on the balance and tare the balance.

7. Place the plate on the microplate carrier.

@ Running a dispense procedure without placing a plate in the reader will
result in contamination of the reader from spilled liquid.

Gen5 provides instructions for processing the plates; follow the
steps carefully. When each dispense step is finished, you will
weigh the plate, record the weight, tare the balance with the plate
on it, and then place the plate back on the carrier for the next
step.

8. Select Plate > Read and click READ. Gen5 prompts you to empty the tip
priming trough.

9. When ready, click OK at the Load Plate dialog to begin the experiment.
The sequence is as follows:
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10.

a. Dispense 80 uL/well to columns 1-4.

b. Remove the plate and weigh it. Record the weight and tare the balance.
c. Place the plate on the carrier and dispense 20 pL/well to columns 5-8.
d. Remove the plate and weigh it. Record the weight and tare the balance.
e. Place the plate on the carrier and dispense 5 uL/well to columns 9-12.
f. Remove the plate and weigh it. Record the weight.

g. Manually pipette 200 uL of deionized or distilled water into all 12

columns, on top of the green test dye solution.

Close the experiment without saving it.

If you are not using a BioTek reader for taking absorbance meas-
urements, read the plate using the wavelengths shown in the table ear-
lier, and then perform the Results Analysis as described on page 158.

Also, be sure to shake the plate after each dispense step to ensure the
dye and water is mixed adequately.

11.

12.

13.

14.

15.

16.

17.
18.

If you are using a BioTek absorbance reader, configure Gen5 to
communicate with the reader.

Create a Gen5 experiment based on the Disp 1 Test Other Reader
protocol.

Initiate a plate read. Place the plate on the carrier, and click OK at the Load
Plate dialog. The protocol instructs the absorbance reader to:

a. Perform the "80 uL" read at 405/750 nm.
b. Perform the "20 and 5 pL" read at 630/750 nm.

When processing is complete, click Plate > Export to export the data to
the embedded PowerExport spreadsheet.

Enter the 80 puL, 20 pL, and 5 pL dispense weights recorded during step 8.
Results are calculated based on the dispense weights; each dispense
volume should show "PASS" for Accuracy % Error and for %CV. See the
calculation descriptions below and Section 6, System Description for
troubleshooting tips.

Save the changes, and then print the spreadsheet. Sign the sheet and store
it with your test records.

Close Excel, and then close the experiment.

Remove the plate from the carrier, and set it aside.

Cytation3 Operator's Manual



162 | Chapter 7: Instrument Qualification

19. Repeat steps 5-14 using Disp 2 Test No Read.prt and Disp 2 Test Other
Reader.

20. See page Results Analysis for instructions on analyzing the results.

When all tests are complete, prime both dispensers with at least 5000
ML of deionized water to flush out the green dye solution.

Genb5 Test Protocols for Models with Absorbance Capabilities

1. Select System > Instrument Configuration, and add/configure the
Cytation3 (if it is not already there).

2. Create a new protocol.

3. Perform the steps in the following three sections to define the Procedure,
customize the Plate Layout, and add Data Reduction steps, to test
Dispenser #1.

4. When finished, select File > Save As and save the file as Disp 1 Test.prt.
5. Repeat steps 2-4 above to create Disp 2 Test.prt to test Dispenser 2.

Define the Procedure

In brief, the protocol’s procedure follows the sequence below. After each Dispense
step, the plate is ejected to allow the operator to weigh it and then tare the balance.

e Dispense 80 uL dye to columns 1-4

e Dispense 20 pL dye to columns 5-8

e Dispense 5 pL dye to columns 9-12

o Shake the plate for 15 seconds

e Read columns 1-4 at 405/750 nm and calculate the Delta OD
e Read columns 5-12 at 630/750 nm and calculate the Delta OD

The detailed procedure is described on the next page. To add a step to the
procedure, click the appropriate button on the left side of the Procedure dialog
and define the required parameters.

The comments suggested for use with the Plate Out/In steps are
optional, but they may be useful for the person running the test. When
the Plate Out/In step is executed, Gen5 displays its comment in a mes-
sage box.

BioTek Instruments, Inc.



Dispense Module Tests | 163

Gen5 Procedure Steps

Step

# Type

Details

Dispenser <select 1 or 2, depending on the protocol>
Dispense to wells A1..H4

1 Dispense
Tip prime before this dispense step, 20 pL

Dispense 80 JL at rate 275 ulL/sec

Plate Suggested comment: Weigh the plate (80 uL test). RECORD
2 the weight, TARE the balance. Place the plate back on the
Out,In ) ) .
carrier. Click OK to continue.

Dispenser <select 1 or 2, depending on the protocol>
Dispense to wells A5..H8

3 Dispense
Tip prime before this dispense step, 20 pL

Dispense 20 JL at rate 250 ulL/sec

Plate Suggested comment: Weigh the plate (20 uL test). RECORD
4 out.In the weight and TARE the balance. Place the plate back on
! the carrier. Click OK to continue.

Dispenser <select 1 or 2, depending on the protocol>
Dispense to wells A9..H12

5 Dispense
Tip prime before this dispense step, 5 pL

Dispense 5 L at rate 225 ulL/sec

Suggested comment: Weigh the plate (5 uL test). RECORD
Plate the weight. PIPETTE 200 ulL/well of DI water into all 12 col-
Out,In umns. Place the plate back on the carrier. Click OK to per-
form the Read steps.
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Gen5 Procedure Steps

Step
Type

7 Shake Linear at 567 cpm (3 mm) for 15 seconds

# Details

Step label: “80 ul Read_Disp 1" (or _Disp 2)
Wells: Al..H4

Detection Method: Absorbance

8 Read
Read Type: Endpoint
Read Speed: Normal

Two Wavelengths: 405 and 750 nm

Step label: *20 and 5 ul Read_Disp 1” (or _Disp 2)
Wells: A5..H12

Detection Method: Absorbance

9 Read
Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 630 and 750 nm

Customize the Plate Layout (Optional)

The results analysis worksheet at the end of this chapter requires the calculation of
the Standard Deviation, Mean, and % CV of the ODs read for each dispense
volume in each plate (six sets of calculations). By identifying the wells by their
dispense volumes in the Plate Layout, Gen5 will calculate these values for you.

1. In the protocol, open the Plate Layout dialog.

2. Set the Type set to Assay Control, and define three control types: Disp_
80, Disp_20, and Disp_5.

In the Plate Layout, select Disp_80 and highlight wells A1 to H4.
Select Disp_20 and highlight wells A5 to HS8.
Select Disp_5 and highlight wells A9 to H12.

SRS L

Click OK to save the changes and close the dialog.

After running the experiment, view the Statistics for each Delta OD
Data Set to view the calculations
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Add Data Reduction Steps

Each Read step is performed using two wavelengths, so you will create two data
reduction steps to calculate the Delta OD values.

In the protocol, open the Data Reduction dialog and click Custom.
Click Select multiple data sets and then select DS2.

Set the Data In for DS1 to the 80 pL Read step at 405 nm.

Set the Data In for DS2 to the 80 pL Read step at 750 nm.

Click OK to return to the Transformation dialog.

AL

In the New Data Set Name field, type an identifying name such as Delta
OD 80 ul_Disp 1.

N

Clear Use single formula for all wells.

8. In the Current Formula field, type DS1-DS2 and then highlight wells A1
to H4 to assign the formula.

9. (lick OK to add the transformation to the Data Reduction list.

10. Create another Transformation similar to the above, with these
characteristics:

= DSI1 set to the 20 and 5 pL. Read step at 630 nm

s DS2 set to the 20 and 5 pL Read step at 750 nm

= New Data Set Name resembling Delta OD 20 and 5 uL_Disp 1
= Remember to clear Use single formula for all wells

= Formula DS1-DS2 applied to wells A5 to H12

11. When you are finished, the Data Reduction Steps list shows two Delta OD
transformations:

12. Click OK to close the Data Reduction dialog.

Gen5 Test Protocols for Models without Absorbance Capabil-
ities

The test procedure on page 130 dispenses three volumes of fluid to a microplate
and then reads the plate on an absorbance reader. The procedure is performed
twice, once for each dispenser. You will create two Gen5 protocols to perform the

dispense steps. If you will use a BioTek absorbance reader that is supposed by
Gen), you will create one additional protocol to perform the Read step.
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Create the Dispense Protocols

Perform these steps to create a protocol to test Dispense 1. Then, open
a copy of the protocol and change the relevant Procedure parameters
to Dispenser 2.

1. In Genb, create a new protocol.

2. Define the Procedure with the steps and settings as described in the
following table:

# Step Type |Details
Dispenser <select 1 or 2, depending on the
protocol>

Tip prime before this dispense step, 20 pL
Dispense 80 pL at rate 275 pl/sec

Suggested comment: Weigh the plate (80 uL
test). RECORD the weight, TARE the bal-

2 Plate Out,In ance. Place the plate back on the carrier.
Click OK to continue.
Dispenser <select 1 or 2, depending on the
protocol>

3 Dispense Dispense to wells A5..H8
Tip prime before this dispense step, 20 pL
Dispense 20 L at rate 250 pL/sec
Suggested comment: Weigh the plate (20
ML test). RECORD the weight and TARE the

4 Plate Out,In balance. Place the plate back on the carrier.
Click OK to continue.
Dispenser <select 1 or 2, depending on the
protocol>

5 Dispense Dispense to wells A9..H12

Tip prime before this dispense step, 5 uL

Dispense 5 L at rate 225 plL/sec
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# Step Type Details

Suggested comment: Weigh the plate (5 uL
6 Plate Out,In | test). RECORD the weight. Set the plate
aside and click OK.

Wells: Al
Detection Method: <select any valid
method>

7 Read Read Type: Endpoint

Read Speed: Normal

Wavelength: <select any valid wavelength

(s)>

The Read step is necessary because Gen5 requires a Read step within any
Dispense procedure. When the test is run, the measurement value is not
used.

3. Save the protocols as Disp 1 Test.prt and Disp 2 Test.prt.

Create the Read Protocol (if needed)

1. In Genb, create a new protocol for the BioTek reader.

2. Define the Procedure with the steps and settings as described in the
following table:

# |Step Type |Details

Step Label: "80 ul Read"

Wells: Al..H4

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 405 nm and 750 nm

1 Read

Step Label: "20 and 5 ul Read"

Wells: A5..H12

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 630 nm and 750 nm

2 Read
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3. Create Data Reduction steps to calculate Delta OD values:

e Select Protocol > Data Reduction and select Custom.

o Within this dialog, click Select Multiple Data Sets and then click
DS2.

e Set the Data In for DSI1 to the 80 ul Read step at 405 nm.
e Set the Data In for DS2 to the 80 ul Read step at 750 nm.
e Click OK to return to the dialog.

¢ In the New Data Set Name field, type an identifying name such as
"Delta OD 80 ul_Disp 1."

e (Clear Use single formula for all wells.

e In the Current Formula field, type DS1-DS2 and then assign the
formula to wells A1 to H4.

e (lick OK to add the transformation to the Data Reduction list.

o Create another Transforming similar to above, with these
characteristics:

e DS1 set to the 20 and 5 ul Read step at 630 nm
e DS2 set to the 20 and 5 ul Read step at 750 nm

e New Data Set Name resembling "Delta OD 20 and 5 ul_
Dispense (#)"

e Formula DS1-DS2 applied to wells A5 to H12

4. The results analysis worksheet at the end of this chapter requires the
calculation of the Standard Deviation, Mean, and % CV of the ODs read for
each dispense volume in each plate (six sets of calculations). By identifying
the wells by their dispense volumes in the Plate Layout, Gen5 will calculate
these values for you.

e Open the Plate Layout dialog.

o Set the Type set to Assay Control, and define three control types:
Disp_80, Disp_20, and Disp_5.

e In the Plate Layout, select Disp_80 and highlight wells A1 to H4.
e Select Disp_20 and highlight wells A5 to H8.
e Select Disp_5 and highlight wells A9 to H12.

e Save the protocol as Disp Test Other Reader.prt.
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After running the experiment, view the Statistics for each Delta OD
Data Set to view the calculations
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Cytation3 Dispense Accuracy & Precision Tests - Dispenser #2

80 pL Dispense
Delta ODs @405/750 nm

1 2

3 4

I QOQ(m|m|[OCO|T|>

80 uL weight:
Expected weight:

Accuracy %o Error:

Must be <= 2.0%

Standard Deviation:

Mean:

%CV:

Must be <= 2.0%

g
2.5600 g

%

Oop 0OF

%

op OF

20 pL Dispense
Delta ODs @630/750 nm

5 6

7 8

20 pL weight:
Expected weight:

Accuracy %o Error:

Must be <= 5.0%

Standard Deviation:

Mean:

%CV:

Must be <= 7.0%

g

0.6400 g

%

Oop 0OF

%

Oop 0OF

5 pL Dispense
Delta ODs @630/750 nm
9 10 11 12
A
B
C
D
E
F
G
H
5 uL weight: g
Expected weight: 0.1600 g
Accuracy %o Error: %
Must be <=20.0% 0OP OF
Standard Deviation:
Mean:
20CV: %
Must be <=10.0% OP OF

Reader Model:

Reader S/N:

Reading Date:

Comments:

Tested By:

Signature:

Reviewed/
Approved By:

Signature:
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Specifications
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General Specifications

Microplates

The Cytation3 accommodates standard 6-, 12-, 24-, 48-, 96-, and 384-well micro-
plates with 128 x 86 mm geometry, Take3 and Take3 Trio Micro-Volume Plates,
microplate slides, and T25 cell culture flasks. Maximum Plate Height: 1.0"

Hardware and Environmental

Light Source

Absorbance, Fluorescence
(FI), monochromator-
based:

Xenon flash light source, 20W maximum average
power (not user-changeable)

Fluorescence (FI/FP), filter-
based:

Xenon flash light source, 5W maximum average
power (not user-changeable)

TRF (filter-based):

Xenon flash light source, 5W maximum average
power (not user-changeable)

20.25" D x 15.50" W x 17.5" H
51.4cmDx39.4cm W x44.5cmH

Dimensions:
If installing a stacker with the Cytation3, see “Select
an Appropriate Location” in Chapter 2, Installation.
Weight: With all modules installed, without power supply or

dispense module attached, < 80 Ibs. (36.3 kg)

Environment:

Power-up temperature 18° to 30°C
Note: Performance measurements, including detec-
tion limits, were verified up to 25°C.

Humidity:

10% to 85% relative humidity (non-condensing)

Power Supply:

24-volt external power supply compatible with 100-
240 V~; +/-10% @50-60 Hz

Power Consumption:

130W maximum

Incubation:

Temperature control ranges from 4°C over ambient to
450C,

Temperature variation £ 0.5°C across the plate @
379°C, tested with Innovation Instruments, Inc. tem-
perature test plate

Top and bottom incubation controlled via software-
adjustable gradient.
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Linear:
Amplitude: 1 mm to 6 mm in 1-mm steps

Frequency*: ~18 Hz to ~6 Hz

Orbital Slow:
Amplitude: 1 mm to 6 mm in 1-mm steps

Frequency*: ~10 Hz to ~3 Hz

Orbital Fast:
Plate Shaking Amplitude: 1 mm to 6 mm in 1-mm steps

Frequency*: ~14 Hz to ~5 Hz

Double Orbital Slow:
Amplitude: 1 mm to 6 mm in 1-mm steps

Frequency*: ~10 Hz to ~3 Hz

Double Orbital Fast:

Amplitude: 1 mm to 6 mm in 1-mm steps

Frequency*: ~14 Hz to ~5 Hz

* Frequency is based on the amplitude selected.

Dispense/Read Specifications

Maximum Delay between End of Dispense and Beginning of Read
96/384-well plates, default probe heights
Bottom Mono Fluorescence T < 0.5 second
Luminescence T < 0.5 second
Top Filter Fluorescence T = 1.0 second
Top Mono Fluorescence T = 1.0 second
Absorbance T = 1.0 second
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Dispense/Read, for models with the dual-reagent dispense module

Both injectors dispense to standard height 6-, 12-,

Plate Type 24-, 48-, 96-, and 384-well microplates.

Absorbance, Fluorescence (FI, FP, TRF), Lumi-

Detection Method .
nescence, Imaging (well mode only)

Volume Range 5-1000 pL with a 5-20 pL tip prime

< 1100 pL, with dead volume recovery function

Reagent Dead Volume (back flush)

Injection Speeds 225, 250, 275, 300 uL/second

Accuracy + 1pL or 2.0%, whichever is greater

< 2.0% for volumes of 50-200 pL

< 4.0% for volumes of 25-49 L
Precision
< 7.0% for volumes of 10-24 uL

< 10.0% for volumes of 5-9 pL

Absorbance Specifications

Optics

Wavelength Range 230 to 999 nm

Wavelength Bandpass < 4 nm (230-285 nm), < 8 nm (> 285 nm)
Measurement Range 0.000 to 4.000 OD

Resolution 0.001 OD

Increment 1 nm

Wavelength Accuracy £ 2nm

Wavelength Precision + 0.2 nm

244'26”:;1”; Kinetic interval < 20 seconds, sweep mode, 96-well microplate
Plate In/Plate Out Speed

< 35 seconds, 450 nm, sweep mode, 96-well microplate
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Accuracy, Linearity, Repeatability

Specifications apply from 250-999 nm, 200 pL (96-well microplates)

Accuracy (tested with certified neutral density glass)

96-well plate, normal read speed
0-2 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms
2-2.50D: +/-3% +/-0.010 OD, delay after plate movement = 100 ms

384-well plate, normal read speed
0-20OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms
2-2.50D: +/-5% +/-0.010 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed

0-10D: +/-1% +/-0.010 OD

Linearity (by liquid dilution)

96-well plate, normal read speed
0-20D: +/-1% +/-0.010 OD, delay after plate movement = 100 ms
2-2.50D: +/-3% +/-0.010 OD, delay after plate movement = 100 ms

384-well plate, normal read speed
0-2 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms
2-2.50D: +/-5% +/-0.010 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed

0-10D: +/-1% +/-0.010 OD

Repeatability (tested with certified neutral density glass/measured by
one standard deviation: 8 measurements per data point)

96-well and 384-well plate, normal read speed
0-2 OD: +/-1% +/-0.005 OD, delay after plate movement = 100 ms
2-2.50D: +/-3% +/-0.005 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed

0-10D: +/-2% +/-0.010 OD

Take3 Plate
Detection Limit, 260 nm dsDNA < 5ng/uL
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Fluorescence Specifications (Mono-Based)

The Cytation3 measures fluorescence with monochromators from the top and
bottom of 6- to 384-well plates. All detection limit (DL) requirements are measured
by the “two-point” method, which gives the limit of detection at a signal-to-noise
ratio of one where noise is defined as three times the standard deviation of the
background wells.

Monochromator-Based Fluorescence

250-700 with low-noise PMT
Excitation range
250-900 nm with red-shifted PMT

250-700 with low-noise PMT

300-700 nm for emission scans with low-noise PMT
Emission range
250-900 nm with red-shifted PMT

300-900 nm for emission scans with red-shifted PMT

Selectable increment 1 nm

Bandpass <=18 nm (excitation and emission)

Minimum kinetic interval | < 20 seconds, sweep mode, 96-well microplate

Plate In/Plate Out Speed

< 35 seconds for filter set, sweep mode, 96-well microplate

Sensitivity

Sodium Fluorescein in phosphate buffered saline (PBS)

DL <= 20 pM top or bottom read, 5 pM typical

Excitation 485 nm, Emission 528 nm

Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB)
DL <= 0.16 ng/mL (0.91 nM) top read

Excitation 360 nm, Emission 460 nm

Propidium Iodide (PI) in PBS

DL <= 62.5 ng/mL bottom read

Excitation 485 nm, Emission 645 nm

Fluorescence Specifications (Filter-Based)

The Cytation3 measures fluorescence with filters from the top of 6- to 384-well
plates.
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Plate In/Plate Out Speed

< 35 seconds for filter set, sweep mode, 96-well microplate

Fluorescence Intensity

DL < 10 pM (3 pM typical) solution of Sodium Fluorescein in PBS Excitation 485/20,
Emission 528/20, 510 nm mirror

DL < 0.16 ng/mL (0.91 nM typical) solution of Methylumbelliferone in CBB, Exci-
tation 360/40, Emission 460/40, 400 nm mirror

Time-Resolved Fluorescence

DL Europium < 250 fM (100 fM typical)
Excitation 360/40 nm, Emission 620/40 nm, 400 nm mirror

Integration time 20 to 2000 ps
Delay 0 to 2000 ps
Granularity 1-us step

Fluorescence Polarization

5 mP standard deviation at 1 nM Sodium Fluorescein
Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror
Excitation range: 400 to 700 nm

Emission range: 400 to 700 nm

Luminescence Specifications

The Cytation3 measures luminescence from the top of 6- to 384-well plates. The
following requirements apply to 96-well plates with 200 uL/well, at room
temperature.

Production testing is done using a Lux BioTechnology Glowell, which is a Gaseous
Tritium Light Source. Approximately 0.021 pW of photons from the Glowell for a
10-second integration time give an equivalent, background-subtracted signal as
1800 amoles of ATP in a Promega ENLITEN ATP assay in a Synergy 2 instrument.
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Luminescence

DL < 75 amol/well, 30 amol typical with low-noise PMT
< 500 amol/well with red-shifted PMT

Integration Time 10 seconds

Gain 150

Blank Wells 16

Imaging Specifications

The Cytation3 imaging specifications are based on using an NIH 3T3 plate: 10,000
wells per cell, GFP stain, Costar 3603 black-sided, plastic-bottom plate.

Read Speed

At 20x, Autofocus on, 96-well plate, 1 image per well < 10 minutes

BioTek Instruments, Inc.
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Error Codes

This appendix lists and describes Cytation3 error codes that
may appearin Gen5.
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Error Codes Overview

When a problem occurs during operation with the Cytation3, an error code
appears in Genb. Error codes typically contain four characters, such as “4168,” and
in most cases are accompanied by descriptive text, such as “PMT overload error.”
With many errors, the instrument will beep repeatedly; press the carrier eject
button to stop this alarm.

Some problems can be solved easily, such as “2BOA: Priming plate not detected”
(place a priming plate on the carrier). Some problems can be solved only by trained
BioTek service personnel. This appendix lists the most common and easily resolved
error codes that you may encounter.

Error codes beginning with "A” (e.g., A100) indicate conditions that
require immediate attention. If this type of code appears, turn the
instrument off and on. If the System Test does not conclude suc-
cessfully, record the error code and contact BioTek’s Technical Assis-
tance Center.

If an error code appears in Gen5, you may want to run a System Test for diagnostic
purposes. In Gen5, select System > Diagnostics > Run System Test.

If an error message appears while an experiment is in process
@ and after having received measurement data, it is your respon-
sibility to determine if the data is valid.

Contact Info: BioTek Service/TAC

Use this appendix to diagnose problems and solve them if possible. If you need
further assistance, contact BioTek’s Technical Assistance Center.

Phone: 800-242-4685 (toll free in the U.S.)
802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

For errors that are displayed during operation of the Cytation3 with the
stacker, refer to the BioStack3 Operator’s Manual.

Error Codes

This table lists the most common and easily resolved error codes that you may
encounter. If an error code appears in Gen5, look for it here. If you find the code,
follow the suggestions provided for solving the problem. If you cannot find the
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code or if you are unable to solve the problem, please contact BioTek’s Technical
Assistance Center. The Genb Help system also provides troubleshooting tips.

Code Description and Possible Remedy
Filter block not found on filter/mirror slide

2353 Verify that the filter block is correctly installed and that it matches the
Gen5 optics library.
Dispenser syringe 1 or 2 (respectively) did not home
x=1-3

2B0x . - . .
Generally, this error indicates the syringe was not properly installed.
Make sure the syringe’s thumbscrews are properly threaded. (Refer to
the Installation chapter for instructions.) Restart the reader.
Priming plate not detected

2B0A
Place priming plate on the carrier.
Dispenser syringe 1 or 2 (respectively) failed position verify

2B04 Generally, this error indicates the syringe was not properly installed.
Make sure the syringe’s thumbscrews are properly threaded. Restart
the reader. (Refer to the Installation chapter for instructions.)
Noise Test Errors
Offset Test Errors
Dark Range Errors

37x0/47x0 | x=0, 1; y=0-6

38x0/48x0

/ This series of System Test errors may indicate too much light inside the

39xy/49xy . .
chamber. Make sure the plate carrier door and the front hinged door
are properly closed. For models with the dispense module, if the dis-
pense tubes are not connected to the reader, re-install the light shield
that shipped with the instrument (or cover the hole with black tape).
Restart the reader.
Fluorescence signal out of range.
x=0, 1; y=0-6

4Fxy L . )
Too low of a reading indicates a light signal problem. Ensure that Gen5
Fluor/Lum wavelengths table matches the actual filter installed in the
filter cube.
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Code Description and Possible Remedy
PMT overload well error at <well #xxx>
This error typically means that the fluid in a well has oversaturated the
PMT (i.e., the well is too bright). Try lowering the sensitivity value in
the read step.
To identify the well:
Wells are counted starting at A1, moving left-to-right, row-by-row. The
row and column of the well can be extracted from the well number code
by applying the following formula (example uses 8 x 12 geometry, 96-
well plate):

4XXX
1. Convert the ASCII hex string to a decimal equivalent. Ex: “057” indi-
cates 57 hex, yielding a well code of 87 decimal.
2. Row = (well code) / (columns in plate), rounded up to a whole
number. Ex: 87/12 = 7.25, indicating row 8 (or H).
3. Column = (well code) - ((row-1) * (columns in plate)). Ex: 87 - ((8 -
1) * 12) = column 3.
NOTE: If this code is returned during an area scan, it indicates the scan
point corresponding to the row/column equivalent in the currently
defined scan map, not the actual well where the error occurred.
Detector saturated (too much light). Relative Fluorescing
Units (RFU) reached (99999).
x=0, 1; y=0-6
This error can indicate one of several scenarios. It is possibly due to
incorrect chemistry, e.g., the fluorescence standards dispensed to the
plate exceed expectations.

4Exy
Try lowering the gain in your Read step(s).
For models with the dispense module, the internal chamber may
require cleaning (contact BioTek TAC).
If a 4E18 error is detected during monochromator-based fluorescence,
the luminescence probe may be picking up stray light. Try installing a
plug in the filter cube. Restart the reader.
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Code Description and Possible Remedy

Fluorescence signal out of range
x=0,1; y=0-6

Verify that the Gen5 Fluor/Lum wavelengths table matches the actual
filter installed in the filter cube. Verify that there is no filter wavelength

overlap between the emission/excitation positions.
4Fxy
Verify that the microplate door is fully closing and the instrument cover

is properly installed and sealed.
Try lowing the gain in your Read step(s).

The reading chamber may be contaminated by a spill that is flu-
orescing; see the Preventive Maintenance chapter.

Filter cube did not home

5003
Generally, this error indicates the filter cube is not seated properly in

5103 the reader. Remove it, ensure each filter or plug is properly positioned,
and reinstall it securely. Restart the reader.

Filter cube failed positional verify

5403 Generally, this error indicates the filter cube is not seated properly in
the reader. Remove it, ensure each filter or plug is properly positioned,
and reinstall it securely. Restart the reader.

<Motor> not homed successfully
Xy=axis

55xy This error indicates that an axis failed a previous verify function and
now needs to be homed. Verify that the shipping brackets have been
removed. Check for any obstructions that may prevent the carrier,
syringes, or filter cube from moving normally. Restart the reader.
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Code

Description and Possible Remedy

570x

Axis obstruction error

This error indicates that a moving part is being obstructed. Verify that:

o the tip priming trough, microplate, plate lid, or other object
has not become dislodged in the reading chamber.

« the Plate Type selection in the Gen5 procedure is correct for
the plate in use, and the Plate Height measurement is
correct.

o the filter cube is correctly installed.

« nothing is preventing the dispenser syringes from moving.

For some plate type and read probe combinations, it might not be pos-
sible to define the entire area scan matrix offered by Gen5 for some
perimeter wells due to the physical limitations of carrier travel. Rede-
fine the area scan to include a small matrix, or select wells in a dif-
ferent row or column.

5A0x

Plate carrier hit obstruction and lost steps
x=0, 1

Verify that the microplate is properly and securely seated in the carrier
and nothing is obstructing carrier movement inside the reading
chamber.

Make sure the Plate Type defined in the Gen5 Protocol matches the
plate you are using.

This error can also occur if the plate type is correct but the lid was left
on the plate. If you wish to read the plate with a lid on it, create a new
plate type in Gen5 with the correct Plate Height.

5B00

Plate carrier needs to be ejected from the reading chamber

The carrier is inside the read chamber and the probe needs to move
down for the requested operation. Press the carrier eject button. This
may occur if the read was aborted and "home all axes" was not per-
formed.

This error can also occur if the carrier is inside and the newly defined
plate height is different from the most recently specified plate height.

To resolve the error, eject the carrier prior to running the experiment.
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Code

Description and Possible Remedy

110C

Side door interlock signal deactivated while LED is on or dur-
ing an attempt to turn on the LED

Verify the side door is closed.

Verify the magnet has not become dislodged from the door.

110D

LED intensity at reference diode measures more than 5%
below the specified target

Run a System Test to see if the error is generated again.

Check to see if the small aperture hole on the top of the imaging filter
cube is blocked.

Ensure the LED cube and imaging filter cube are present, plugged in, or
not defective.

Verify the imaging filters and are clean and match the configuration
defined in Genb.

110E

LED intensity at reference diode measures more than 5%
above the specified target

Run a System Test to see if the error is generated again.
Ensure that the LED cube and imaging filter cube are not defective.

Verify that the imaging filters are not delaminating or do not match the
configuration defined in Genb5.

110F

Current DAC adjusted to more than double the starting value
within the first 20 control cycles

This error can be generated if a System Test is not run after sending
new values to the instrument for imager configuration. Run a System
Test to clear the error.

Verify that the imaging filter cube and fluorescence filter cube con-
figuration is correct.

Ensure that the LED cube and imaging filter cube are not defective.
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Code Description and Possible Remedy
With current DAC adjusted to maximum output, LED intensity
at reference diode measures more than 5% below the spec-
ified target
Run a System Test to see if the error is generated again.
Check to see if the small aperture hole on the top of the imaging filter
1110 .
cube is blocked.
Ensure the LED cubes and imaging filter cubes are present, plugged in,
or not defective.
Verify the imaging filters are clean and match the configuration defined
in Genb.
LED gain calibration signal is out of range
This error occurs only during the System Test.
Ensure the imaging filter cubes and fluorescence filter cube are
present.
1185 Check the cable between the LED cube and the instrument's PCB to
ensure it is not loose or defective.
Verify that the light aperture on the top of the imaging filter cube is not
blocked.
Ensure that the LED cube and imaging filter cube are not defective.
LED control timeout
The LED output setpoint was not reached within 20 msec after turn on.
1186 Verify the LED cube and imaging filter cube settings. The XML file must
match the LED cube and imaging filter cube contents.
Run a System Test to reset LED gain calibrations.
LED-on current feedback is out of range (low)
1187 Ensure the LED cube is present, plugged in, or not defective.
Run a System Test to see if the error is generated again.
LED-on current feedback is out of range (high)
1188
Run a System Test to see if the error is generated again.
User-initiated positional calibration needed
1189
Run imager objective calibration in Gen5 setup.
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Code Description and Possible Remedy
Carrier calibration needed
118A
Run imager objective calibration in Gen5 setup.
500C Imager LED/Filter Slide error
520C Verify that the filter slide shipping bracket is removed and the slide
moves freely when the instrument is powered off. An object may be
550C obstructing the path.
Imager Objective Changer error
Verify that the objective turret shipping bracket is removed and the tur-
500D ret rotates freely when the instrument is powered off. An object may be
520D obstructing the path.
540D Ensure that the installed objective matches the objective configuration.
550D If the objective installed is too tall, it may contact the bottom of the
570D incubator.
Verify that the z-axis motor is moving and that the objective is not bind-
ing on the incubator.
500E
520E
550E Z-Axis error
S40E Verify that the carrier shipping bracket is removed.
550E
570E
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